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Apex	exporter	improvements.	Improve	polyp	simulation.	Changes	to	Spanish	effect	name	translations.	Re-tune	gold,	silver,	and	charcoal	trails.2018.04.23-cc279d16-finale3d-win32-installer	(RELEASE)	Changes	to	spark	rendering	to	make	sparks	appear	brighter.	Added	'Subtype'	as	an	optional	script	table	column,	referencing	the	effect	field.	Changed
the	group	function,	hotkey	=	G,	to	auto-generate	the	group	name	instead	of	asking	user	to	name	the	group,	which	massively	improves	this	feature.	Added	24	shot	slat	and	6	shot	slat	options	for	Mongoose	firing	system.	Added	voice	cues	setting	for	speciying	the	volume	of	music	overlay	on	the	voice	cues	channel.	Added	more	explanatory	error	message
if	user	tries	to	export	a	file	without	addressing	it.	Improved	cue	flag	graphics	on	timeline.	Fixed	custom	breaks	so	that	when	break	orientation	randomness	is	disabled,	the	breaks	are	oriented	like	right-side	up.	Updated	Spanish	UI	translation.	Added	confirmation	dialog	when	'Edit	effect	VDL'	changes	effect	type,	giving	option	to	change	type	or	keep
old	value.	Added	'Scenery	>	Background	images	>	Set	sky	image'.	Fixed	bug	with	module	graphics	re-sorting	in	rack	layout	view.	Fixed	minor	overlap	problem	with	timeline	effect	bars	overlapping	in	sequences	of	Move-To	events	with	flames.	Improved	the	'Address	show'	summary	for	Galaxis	and	Explo	by	not	counting	the	flame	unit	pins	in	the	pin
counts	since	they	are	not	physical	pins.	Added	'Rack	Setup'	report,	which	lists	rack	and	tube	assignments	for	all	script	devices.	Add	DMX	error	checking	dialog	in	front	of	addressing	function.	Added	MAGICFC	DMX	Flamaniac	effects	to	Generic	Effects	list.	Fixed	the	importing	of	HBS	files	with	cakes	of	shells,	removing	the	prefire	specification	from
the	cake	since	in	3D	the	cake	prefire	affects	the	shell's	lift	time.	Support	shorthand	C,	M,	and	T	after	number	of	shots	for	comets,	mines,	and	shells,	as	in	'cake	25	c	red'.	Fix	comet	w/	mine	bug	where	the	mine	would	come	out	ahead	of	the	comet	sometimes.	Fixed	'Rename	positions'	to	allow	overlapping	ranges.	Fixed	'Add	racks'	dialog	user	interface
issue	wherein	selecting	a	rack	part	choice	for	single-shot	row	in	the	dialog	could	result	in	an	unexpected	jumping	around	of	rack	part	choices	in	that	row	and	other	rows	for	single-shots	of	different	sizes	if	some	of	the	choices	were	fixed-any-size	varieties	that	applied	to	multiple	rows.finale3d-installer-2021.08.17-bff8470d4	(BETA	VERSION)
Implement	new	Create	Photo	dialog	and	flow.	Added	:duration500MsTo2500Ms	parameter	to	DMX	Patch	languge	to	support	Explo	G3	flame	units.	Folded	'Display	events	on	timeline	as	blips'	option	into	the	x-ray	button	on	the	timeline,	making	that	button	cycle	through	the	three	options,	bars,	names,	or	blips.	Implement	"ACES"	tonemapping	for
lighting	and	color.	Added	DMX	support	for	Hansol	Sunshine	5	head	flame	system.	Clicking	on	one	of	many	selected	events	in	timeline	now	deselects	the	others,	unless	you	drag.	Added	preliminary	effects	for	the	EasyDancing	DMX	par	light	with	LED	colors	and	strobing	effects.	Shorten	menu	item	names	in	'Add	compatible	DMX	effect'	menu	by
removing	the	fixture	type	since	it	isn't	necessary.	Changed	name	of	'script_rail_pin_report'	default	reports	to	just	'script'.	Improve	UI	sounds	in	rack	layout	window.	Tuned	default	timeline	right	edge	scrolling	and	playback	margins.	Changed	the	part	numbers	of	the	Explo	flame	effects	in	Generic	Effects	to	correspond	to	the	Explo	flame	program
numbers,	GFX9001	for	program	1,	GFX9002	for	program	2,	etc.,	as	a	convenience	to	the	user;	previously	the	part	numbers	were	off-by-one,	which	was	confusing.	In	the	new	paradigm,	you	configure	positions	to	represent	DMX	fixtures	like	lights	and	flame	projectors,	from	the	'Configure	as	DMX	fixture...'	context	menu	item,	which	opens	a	DMX
fixture	configuration	dialog.	Updated	Russian	and	Ukrainian	UI	translation.	Automatically	determine	color	and	subtype	field	on	import	if	not	explicit	in	imported	file.	Added	'Type'	to	all	the	default	effect	table	layout	blueprint	filters.	Added	Bulgarian	UI	translation.	Added	Polish	Zloty	currency	symbol	option	in	user	settings.	Added	'Reverse	order'
checkbox	to	'Make	into	sequence'	dialog.	Added	automatic	scrolling	of	the	script	and	highlighting	of	the	row	that	is	shot	when	playing	simulation.	Added	default	color/size/subtype	selectors	to	parts	window.	Second	pass	of	Italian	effect	name	translations.	Previously	'Chains	First'	was	actually	doing	a	comparison	based	on	chain	reference	as	opposed	to
treating	all	non-blank	chain	references	as	being	equal	each	other	for	sorting	purposes,	so	now	that	same	sorting	option	value	is	called	'Chain	Reference'	and	the	new	'Chains	First'	option	treats	ties	correctly.)NOTE(Added	'IsChain'	column	in	script.)NOTE(The	new	chain-related	columns	in	the	script	in	this	this	update	and	the	last	update	will	appear	on
all	existing	blueprints	for	reports	and	table	layouts	until	you	hide	them	with	the	'Hide	or	unhide	column'	option	from	the	blue	gear	menu	or	copy	the	blueprints	from	a	new	blank	show	to	replace	the	blueprints	in	a	saved	show.	German	and	Russian	effect	language	improvements.	Improved	'Addressing	>	Address	show...'	to	write	'dmx'	in	the	pin
number	field	for	dmx	effects,	since	dmx	effects	don't	have	meaningful	pin	numbers.	Added	'Racks	>	Renumber	all	racks	consecutively'	Improved	rack	layout	context	menu	item	'Renumber	racks	left	to	right'	by	making	it	resolve	conflicts	in	a	more	intuitive	way.	Added	back	the	EasyDancing	fixture	type.finale3d-installer-2021.03.23-94236a606	(BETA
VERSION)	Improved	error	message	when	exporting	a	DMX	script	using	Cobra	V5	to	explain	you	need	to	switch	to	Cobra	V6.	Dragging	selection	rect	in	design	view	upward	first	over	positions	then	also	covering	trajectory	tip	donuts	now	works	the	same	as	dragging	rect	in	the	other	direction.	Enhanced	copying	rows	in	the	positions	window	to	include
any	referenced	models	in	the	copy	buffer,	as	copying	does	if	you	copy	from	the	design	view	window,	making	it	easier	to	copy/paste	positions	with	attached	models	from	one	show	to	another.	Updated	Brazilian	Portuguese	and	Italian	UI	translations.	Tune	Popcorn	Crackle.	Added	hot	keys	for	customize	simulation	commands.	Fixed	long-lasting	DMX
events	in	Pyromac	exporter,	longer	than	99sec.	Added	a	'multiple	definitions'	warning	to	fixture	types	that	have	multiple	definitions.	Improved	cake	shot	timing	accuracy	for	combine-as-cake	and	importing	Finale	Business	cakes.	Fixed	a	possible	bug	in	which	rack	length	constraint	could	have	been	miscalculated	in	the	'Add	racks'	dialog.	Improved
scrollwheel	zoom	on	timeline,	making	it	preserve	the	playhead	even	when	zooming	out	near	the	edges.	Improved	blip	circles	on	timeline.	Fixed	minor	parsing	errors	with	French	and	Spanish	cake	and	shot	related	terms.	Made	import	show	summary	dialog	report	number	of	devices	imported,	to	make	it	easier	to	verify	when	show	contains	chains.
Added	DMX	support	for	SpecialFx.it	Cold	Sparks	Machine,	Standard	Fixture	ID	061.	Fix	rising	crossette	stars	drooping	too	low.	Fixed	easy	racks	user	settings	menu	item	dialog,	which	had	disabled	number-of-tubes	fields.	Improved	VDL	parsing	for	cakes,	requiring	parentheses	around	effect	labels	to	avoid	confusion	with	single	letter	abbreviations	and
non-English	words.	Changed	ground	image	import	dialog	text.	Fix	a	bug:	we	weren't	properly	writing	the	WAV	file	header	when	exporting	a	sound	track.	Exclude	positions	with	no	racks	in	the	rack	layout	diagrams	printouts,	to	save	paper.	Added	'skyRotationDegrees'	per-show	setting	to	enable	rotating	the	sky	image.	Added	10	output	and	5	output
modules	for	Galaxis,	and	re-organized	list	of	module	types;	removed	split	matrix	options	other	than	5x10	and	10x10.2019.01.06-ac57011a-finale3d-win32-installer	(RELEASE)	Implement	letterbox	render	setting.	Added	import	show	option	to	ignore	PAN	angle	in	imported	file	and	made	the	'guess'	option	ignore	PAN	angles	by	default,	to	make	importing
angles	more	reliable	for	SCX	files.	Added	new	list	of	generic/basic	effects,	replacing	old	list.	Updated	the	COBRA	v6.0	script	file	format	with	the	new	position	information	section	and	version	number.	Added	'File	>	User	settings'	menu,	though	not	yet	connected	to	network.	Added	dialog	that	explains	per-show	parts	when	creating	an	effect.	FOr
importingHBS	files,	changed	threshold	for	inferring	'very	big'	break	from	sim	parameters.	Fixed	recently	added	roman	candles	in	Generic	Effects,	which	had	the	incorrect	type	of	single_shot	instead	of	candle.	Fixed	SEM	exporting	for	FireOne.	If	user	does	'Change	DMX	Fixture	Type	and	convert	effects'	with	master	fixtures	selected	and	matching	but
unselected	slaves,	then	pop	up	dialog	to	ask	if	user	wants	to	convert	the	slave	fixtures	also.finale3d-installer-2021.03.26-560e22832	(BETA	VERSION)	Updated	Brazilian	Portuguese	UI.	Added	function	to	download	script	to	PD	FC-A	and	FC-3	field	controllers.	Fixed	'Break	apart	cake'	for	some	effect	descriptions	that	changed	from	comets	inside	cakes
to	shells	outside	of	cakes.	Reduced	vertical	padding	of	rows	to	show	more	rows	in	the	same	space.	Added	ability	to	export	any	window	as	xlsx	or	csv,	from	File	menu	or	right-click	context	menu.	Added	copy	script	formats	for	the	two	'step'	based	semi-automatic	firing	methods,	stepping	by	tracks	and	stepping	by	events.	Fixed	a	bug	causing	certain
importer/exporters	to	not	be	able	to	use	file	paths	with	spaces	in	them.2018.11.14-7a053e8a-finale3d-win32-installer	(RELEASE)	Added	additional	validation	for	assortments,	requiring	them	to	have	at	least	two	sequential	children	beginning	with	0	or	1,	e.g.,	ASSTA-01	and	ASSTA-02.	Added	help	option	in	right-click	context	menus	in	rack	layout.	Added
support	for	Norwegian	translation.	Made	the	'Used'	and	'Available'	fields	in	the	effecs	window	display	the	number	zero	if	the	contents	are	zero,	instead	of	blank.	Made	collection	selector	for	'Create	effect/rack/chain/cake	from	xxx'	remember	and	default	to	previous	choice'.	Changed	the	:customPartField100	field	in	DMX	patches	to
:customPartFieldExploX2.	In	rack	layout	window,	selecting	a	rack	or	dragging	a	pin	now	automatically	selects	the	associated	events	in	the	script	window,	so	you	know	what	you	are	dealing	with.	Fixed	the	rack	icons	in	generic	effects.	Added	'Positions	locked/unlocked'	tool	tip	notification	when	clicking	on	padlock	button.	Added	variable	height	generic
DMX	flame	projector	fixture	option.	Progress	on	Spanish,	French,	and	Russian	translations	--	nearly	done.	Improved	Russian	and	Ukrainian	localizations.2019.06.10-a8ac196a-finale3d-win32-installer	(RELEASE)	Fix	bug	in	network	sync-ing	with	Finale	Inventory.	First	pass	of	French	effect	name	translation	to	VDL.	Naming	change	'Parts'	-->	'Effects'
pervasively.	Added	settings	in	'Scenery	>	Sky	image	adjustments'	to	rotate	the	direction	the	image	is	facing	and	to	stretch	the	image	horizontally	to	create	a	wider	viewing	area.	Fixed	minor	rack	layout	bug	wherein	pins	error	checking	that	would	make	the	pins	red	was	disabled	when	the	corresponding	events	were	filtered	in	the	script	window.	Tune
down	report	flashes	a	bit.	More	improvements	and	bug	fixes	to	the	new	inventory	sync	process.	Now	set	properties	on	10k	events	is	about	a	second	instead	of	several	minutes.	Improved	addressing	summary	dialog	to	include	position	names	of	any	positions	with	addressing	errors.	Activate	effects	window	whenever	user	adds	racks.	After	you	sync	the
first	time,	the	change	notice	should	go	away.	Added	right-click	context	menu	on	racks	in	rack	layout.	The	prefire	of	zero	doesn't	imply	a	lift	time;	the	default	lift	time	is	used	for	sims	with	prefire	of	zero.	Changed	timeline	algorithm	for	cascading	efffect	bars	for	effects	on	fixtures,	to	give	each	fixture	its	own	row	on	the	timeline	when	possible.	Added
timeline	division	markings	for	non-decimal	fps	frames,	so	snapping	on	timeline	aligns	with	markings	exactly	when	zoomed	in.	Updated	Italian	UI	translation.	By	popular	demand,	change	the	timeline	hiding	during	playback	feature	to	hide	the	timeline	during	playback	only	when	cursor	is	in	the	lower	right	hand	corner	of	the	3D	view,	not	whenever	the
cursor	is	outside	of	the	design	window	entirely.	Change	'songs'	to	'music'	menu.	Added	a	checkbox	'Auto-assign	DMX	channel	ranges'	to	the	'Configure	as	DMX	fixture'	properties	dialog,	as	a	convenience.	Fixed	rack	layout	view	of	16-pin	fireTEK	slats,	previously	showing	12	pins.	Removed	the	snapping	to	action	time	feature	for	dragging	playhead
since	clicking	cue	flag	is	easy	alternative;	snapping	while	dragging	selection	can	optionally	be	turned	off	in	show	menu.	Preserve	table	layout	in	effects	and	script	window	when	switching	between	shows	or	effects	collections.finale3d-installer-2020.03.19-8404b5532	(RELEASE)	Added	Universe,	Section,	Module	Type,	Rack	Type,	and	Custom	Script
Field	to	'Edit	Properties'	dialog	for	events,	which	among	other	things	is	useful	if	you	want	to	use	Custom	Script	Field	values	of	1-10	to	control	cue	flag	colors.	For	importing	HBS	files,	detect	and	fix	corrupted	cake/chain	effects	and	import	a	placeholder	so	it	at	least	shows	up.	Added	'Next'	column	to	script	table	that	indicates	time	delta	to	next
cue.)NOTE(Added	'Cue	Count'	column	to	script	table	that	counts	up	with	each	different	effect	time,	ignoring	chain	follower	shells.)NOTE(Changed	cue	flag	numbers	to	be	the	cue	count,	which	is	unaffected	by	hiding	events.)NOTE(Added	'Next'	to	the	default	scripting	table	blueprint.finale3d-installer-2020.06.14-866ea1910	(RELEASE)	Handle	empty
caliber	strings	syncing	to	Finale	Inventory	Added	'Chain	Summary'	report	that	lists	chains	as	single	rows	with	individual	delays	in	a	list	like	0*2*2*2*2	for	5-shell	chain	with	2sec	delays.	Added	'Show	groups	as	one	row'	option	in	script	gear	menu.	as	a	hot	key	for	closing	the	active	window	or	dialog,	working	even	when	the	search	box	has	focus	to	make
it	easy	to	dismiss	the	effect	window	after	invoking	if	you	change	you	mind,	without	taking	hands	off	the	keyboard.	Fixed	the	'wavy	stars'	bug.	Fix	bug	preventing	users	from	un-subscribing	from	supplier	catalogs	via	the	finale3d.com	website.	Added	box	around	the	rail	field	when	it	changes	from	previous	row	to	indicate	to	alert	the	operator	of	the
pinboard.	Removed	effect	bar.	Fix	bug	in	syncing	My	Effects	Qoh	and	Available	columns.	Added	duration	column	to	chooser.	Automatically	clear	the	search	box	when	switching	to/from	window	arrangements	that	include	the	rack	window,	since	filter	text	for	effects	don't	generally	apply	to	racks	and	vice	versa.	Improved	Show	Director	CSV	export,
fixing	a	problem	with	pins	for	non-PD	firing	systems,	and	handling	single	digit	hex	module	numbers	for	PD	firing	systems.2019.07.17-f9cc1459-finale3d-win32-installer	(RELEASE)	Fixed	PyroSure	slat	count	limit,	F	not	D.	Tune	air	bursts.	Made	'Devices'	field	value	in	Effects	window	optional,	so	chains	in	Finale	Inventory	work	even	if
chainNumberOfDevices	is	unspecified.	Fix	bug	with	groups	not	working	properly	(filling	in	'error'	in	the	group	column	of	the	script	instead	of	the	group	name).	Improved	support	for	Explo	X2	Wave	Flamers	by	making	the	'address	show'	function	automatically	copy	flame	program,	1-66,	from	the	effect's	Custom	Part	Field	to	the	Pin	field	of	the
addressed	script;	previously	the	flame	program	was	copied	by	the	'Export	show'	function	but	not	by	the	'Address	show'	function	so	the	pin	numbers	in	the	addressed	script	appeared	wrong.	Added	'Alternating	row	tube	loading	order'	checkbox	on	create/edit	rack	definition	dialog,	to	provide	a	snaking	option	for	multi-row	racks.finale3d-installer-
2020.06.27-b7f17887b	(RELEASE)	Make	'Reverse	tube	loading	order'	on	rack's	right	click	context	menu	dynamically	re-allocate	the	tubes	on	the	spot,	in	addition	to	changing	the	rack's	setting	that	applies	when	addressing.	Added	new	'Assorted	DMX	Effects'	supplier	catalog	and	made	various	enhancements	to	DMX	UI	and	workflow.	Added	mp3
pathname	to	exported	Pyrosure	WYH	script	files	on	fully	automatic	shows.	Fix	crackling	sounds.	Fix	the	extra	break	sounds	coming	from	pistils.	Tune	wind/trail	'waviness'.	Improved	UI	for	dragging	pins	between	rails.	Added	'Rack	Description'	field	option	to	labels,	supporting	the	new	rack	labels.	Added	red	highlighting	in	rail	graphics	in	rack	layout
window	for	pins	wired	to	devices	that	are	not	in	rack	tubes.	Added	5',	5m,	5yd	grid	for	positions.	Masked	off	the	lock	and	hide	icons	on	rows	in	printed	reports.	Fixed	'Chain	Gap'	column	in	the	script	and	the	'Chain	Specifications	Report'	to	calculate	the	correct	chain	delays	for	chains	with	devices	that	have	different	prefires.	Made	show	import	guess
durations	better	when	user	selects	'guess	duration'	in	import	configuration.	Fix	movie/image	over-exposure	bug.	Fix	the	couple	of	missing	properties	from	the	sort-by	selectors	and	other	selectors	in	the	report	config	dialogs.	Made	Pyromac	exporter	ignore	the	end-event	in	DMX	patches	so	it	can	use	the	same	standard	DMX	effects	as	other	firing
systems	that	require	begin/end	events.2019.07.04-20526d86-finale3d-win32-installer	(RELEASE)	Progress	on	Portuguese	translation.	Made	'Combine	as	cake'	include	the	VDL	terms	HTM	and	DUR	for	individual	component	effect	duration	and	height	if	necessary	to	keep	user	adjustments.	Tune	crossettes	to	make	their	duration	longer.	Fixed:	Effect
editor	selects	need	dropdown	icons.	Added	'Re-address'	button	to	rack	layout	view	for	re-addressing	just	the	position	being	viewed.	Added	DMX	support	for	the	Hansol	Volcano	flame	system.	Also	make	it	report	error	if	user	tries	to	replace	effect	with	a	chain,	which	we	will	be	able	to	support	eventually	but	too	much	for	now.	Added	drag-and-drop	to
events	and	cue	flags	on	timeline.	Fix	farfalle	double	rings.	Implement	'airburst'	vdl	effect.	Added	1-second	option	for	Show	>	Set	snap-to	timeline	resolution.	Fixed	addressing	limitation	that	racking	errors	could	prevent	pins	from	being	shared	up	to	max-ematches-per-pin	even	if	the	racking	errors	appear	unrelated.	Make	simulator	use	the	effect's
prefire	and	duration	fields	from	the	parts	table.	Improvements	to	Mongoose	exporter.	Added	"Degree"	as	synonym	for	Degrees	for	VDL	for	cake	fan	angles.	See	Finale	Generic	CSV	documentation	and	Scenery	position	coordinates	documentation	for	details.	Fixed	the	'Replace	effect'	functions	to	make	them	work	for	inventory	items	that	are	missing
VDL	and/or	other	fields	that	would	be	filled	in	automatically	if	the	effect	were	inserted	directly.	Simplified	the	right-click	context	menus	by	removing	the	'Filter	to	>=,	Added	'Why	is	this	tube	red?'	function	on	right-click	context	menu	when	you	click	on	a	rack	in	the	rack	layout	view,	to	explain	what	the	error	is.finale3d-installer-2020.08.24-696f0d8ba
(BETA	VERSION)	Added	settings	in	'Scenery	>	Sky	image	adjustments'	to	rotate	the	direction	the	image	is	facing	and	to	stretch	the	image	horizontally	to	create	a	wider	viewing	area.	Fix	problem	with	very	large	MyParts	files	causing	a	causing	a	crash.	In	'Add	racks'	dialog,	do	not	clear	the	part	number	for	rack	rows	with	zero	racks	to	add,	which
makes	it	easier	to	understand	what's	going	on	when	fits-any-size	racks	are	shared	among	multiple	rows.	Made	control-drag	on	the	timeline	background	drag	a	selection	rect,	same	as	shift-drag.	Made	inserting	items	directly	on	top	of	a	blank	cue	replace/remove	the	blank	cue	even	if	it	was	not	selected	at	the	time	of	inserting.	Added	'Show	>	Options	>
Draw	effects	on	timeline	as	dots'.	Improved	module	type	menus	for	Cobra	addressing.	Fix	sync	bug	when	changing	more	than	1000	effects	at	a	time	in	My	Effects.	Added	'Effects	>	Effect	macros	>	Find	and	replace	inside	macros'	to	facilitate	making	global	substitutions	of	effects	or	positions	in	a	batch	of	selected	macros	in	one	fell	swoop.	Made
submenus	adjust	position	vertically	to	fit	in	screen	with	minimum	scrolling	requirement.	Also,	do	'Effects	>	Update	per-show	effects...'	for	any	existing	DMX	shows	when	you	upgrade	to	this	release,	in	addition	to	changing	your	DMX	Channel	Base	values	to	NOT	subtract	1.	Fixed	the	10	channel	Pyromac	module	bug.	Fix	star	phase	trail	density	bug.
Made	shift-drag	of	selection	rect	not	be	in	'add'	mode.	Disabled	loading	last	window	arrangement	for	demo/Lite	version.	Lots	of	effect	tuning.	Added	'Add	to	My	Effects'	main	menu	item	and	right	click	context	menu	item	for	Effects	Window.	Added	menu	options	to	'Make	into	sequence'	dialog	that	give	user	explicit	control	over	whether	items	are	sorted
and/or	grouped	by	position	or	angle.	Improved	ruler	appearance.	Make	the	'Import	show'	function	include	the	Notes	2,	Notes	3,	Custom	Numeric	Field,	and	Alternate	columns.	Added	Cobra	v3.0,	v4.0,	v5.0,	and	v6.0	script	formats.	Changed	'Select	all	events	using	this	effect'	to	'Select	this	item	in	layout	or	script',	making	it	work	for	racks	as	well	as
effects.	Removed	control-C	as	a	method	of	exiting	multi-key	hotkey	sequence	so	can	be	used	for	position	groups,	etc.	Various	improvement	to	French	and	Spanish	effect	import.	Made	'Import	show'	read	the	device	table	and	hazard	zone	and	position	coordinates	out	of	V2.6	GS2	scripts.	Implement	polyp	effect.	Change	module	name	from	'Cobra	18	pin
module'	to	'Cobra	18M,	36M	or	72M'.	Updated	Russian	and	Uktranian	UI	translations.	Fixed	rack	assignment	problem	in	addressing	algorithm	for	racks	with	fanned	shells.	Added	'Hide	all	position	rulers'	option	in	Show	menu.	Fixed	addressing	bug	in	which	DMX	effects	were	given	pyro	addresses	if	pyro	events	were	at	exactly	the	same	times	and	if
modules	were	not	constrained	to	positions.	Change	gear	menu	item	'Reset	column	widths'	to	'Reset	table	layout'.	Backfilling	is	the	re-use	of	compatible	rails	and	pins	from	earlier	in	the	sequence,	such	as	for	two	events	at	the	same	time	and	position	that	are	not	sequential	rows	in	the	script	window	as	it	is	sorted	by	the	user.	Fix	a	crash	affecting	some
Nvidia	GPUs.	Change	login	dialog	links	to	point	to	the	correct	locations	on	the	new	website.	Fixed	reports	conditional	formatting	for	special	table	cells	like	locked	address	cells.	Change	parsing	of	'red	&	blue	peony	cake',	which	will	now	make	a	cake	with	'red	&	blue'	peonies	rather	than	red	peonies	and	blue	peonies.	Updated	Bulgarian	UI	translation.
Made	it	possible	to	re-address	an	individual	position	without	affecting	the	rest	of	the	show,	using	the	'Re-address'	link	in	the	rack	layout	view	--	even	if	your	position	does	not	have	a	Start	Module	or	Pre-Assigned	Rails;	the	link	always	works	now.	Improved	the	standard	VDL	syntax	generated	by	the	combine-as-cake	function	to	return	fewer	row
descriptions	by	combining	the	first	row	with	other	rows	that	are	equivalent	except	for	the	delay	in	front	of	the	row,	exploiting	the	fact	that	the	delay	of	the	first	row	in	VDL	is	not	used.	Make	break	flashes	illuminate	the	ground	and	models	a	little	bit,	instead	of	just	the	smoke.	Fix	bugs	in	Finale	Inventory	sync.	Updated	Italian,	Brazilian	Portuguese,	and



Polish	translations.	Updated	the	Polish	UI	translation.	Support	Russian	characters	in	reports	if	you	select	'File	>	Language	>	Russian'	before	printing.	Re-arranged	and	simplified	link	buttons	on	rack	layout	view.	Added	support	for	Galaxis	GS2	version	2.7	and	2.8.	Minor	improvement	to	Cobra	export	dialog	relating	to	audiobox	filename.	Fixed	bugs
relating	to	changing	the	language	setting.	Made	show	import	overwrite	the	script	row	quantity	value	with	the	number	of	numerical	angles	in	the	tilt/angle	column	if	that	number	is	more	than	one,	e.g.,	80-90-10	-->	quantity	=	3.	Added	a	'rack'	subtype	so	it	easier	to	filter	to	racks.2018.07.27-46ef0303-finale3d-win32-installer	(RELEASE)	Finished	V1
labels	features,	pending	further	feedback.	Added	'Show	>	Options	>	Disable	UI	sound	effects'	option.	Disabled	the	auto-zoom-out	for	inserting	DMX	effects,	since	auto-zoom-out	is	a	nicety	for	large	pyro	effects	that	can	be	annoying	for	close-prox	effects	particularly	if	using	a	backdrop	image.finale3d-installer-2021.05.28-966250e57	(BETA	VERSION)
Added	effect	library	for	Explo	GX2	and	GX3	flame	units.	Fix	bug	causing	'missing	effects'	on	some	GPUs.2018.04.04-ed99d1d8-finale3d-win32-installer	(RELEASE)	Handle	missing	data	links	in	Finale	Inventory	catalogs.	Added	XZ	rulers	when	moving	positions	to	show	their	distances.	Made	the	'Pan	180	/	Mirror'	option	for	fixtures	appear	as	a	column
on	the	Reports	>	Special	reports	>	DMX	Fixture	setup'	report	and	also	added	the	fixture	type	as	a	column	to	the	report	and	gussied	up	the	formatting	a	little.	No	UI.	Implementing	downscale	resolution	selector	render	setting.	Made	the	default	'Rail/Pin'	script	table	layout	sort	by	Rail	>	Pin	>	Event	Time.	Minor	fixes	to	the	'Pinboard	Cue	Sheet'	report.
Added	2-channel	fogger	DMX	patch.	Made	deleting	racks	NOT	unlock	the	addresses	of	items	in	the	racks.	Updated	the	'Rack	List'	report	template	to	include	angle	in	the	sorting	conditions	and	to	list	racks	of	different	angles	on	different	lines.	Update	to	Russian	and	Ukrainian	translations.	Fixed	main	menu	item	'Effects	>	Edit	effect	VDL	>	From	item
in	show'	to	make	it	work	even	if	the	effects	window	has	a	filter	applied	that	hides	the	effect	being	edited.	(Currently	it	just	disables	fancy	motions	like	serpents	and	bees).2018.10.30-b6769884-finale3d-win32-installer	(RELEASE)	Add/fix	strobing,	flashing,	twinkling,	and	shimmering.	Added	support	for	new	Pyrodigy	script	file	format	that	has	full	DMX
capabilities.	Added	buttons	on	rack	layout	page	to	show/hide	the	racks	palette	and	to	show/hide	generic	racks.	Tune	popcorn	crackle	Fix	and	tune	popcorn	crackle	sound.	Added	duration	and	coordinates	column	to	Finale	Generic	CSV	export.	Made	'Add	time	variance...'	and	'Renumber	chains'	remember	their	previous	parameters.	Fixed	minor
addressing	bug	occuring	when	user	addresses	pre-wired	racks	without	viewing	the	rack	layout	view.	Fixed	an	issue	causing	Finale	3D	to	hang	when	running	on	some	multi-monitor	configurations.	Added	support	for	user-defined	DMX	fixtures.	Made	cue	numbersin	Mongoose	exported	scripts	increment	sequentially.	Change
chainNumberOfDevices/numDevices	to	default	to	1	when	empty.2018.02.04-6a29ab9f-finale3d-win32-installer	(RELEASE)	Fixed	rare	crash	bug	reported	when	editing	groups.	Added	helpful	instructions	dialog	regarding	puzzle	pieces	if	user	does	the	'Reset	table	layout'	menu	item.	Added	'Excel'	label	to	the	correct	text	encoding	option	in	export.
Added	two	new	sort	terms,	Fan	Chains	First	and	Fan	Chains	Last,	giving	user	control	over	addressing	chains	with	multiple	angles	separately	from	chains	with	all	shells	at	the	same	angle.finale3d-installer-2021.09.12-24ed42f31	(RELEASE)Release	Highlights	Video	FINALE	INVENTORY	USERS:	Moved	'Finale	Inventory'	submenu	from	the	'Effects'
menu	to	the	'File'	menu.	Added	'About	Finale3D'	menu	item.	Yes,	somebody	asked	for	this	change.	Added	'File	>	User	settings	>	Disable	automatic	part	number	rack	annotations'	in	case	you	don't	want	them.	Made	'Filter	effects	window	to	compatible	DMX	effects'	detect	if	you	need	to	download	a	supplier	catalog,	and	tell	you	if	so.	Updated	French	UI
translation.	Improvements	to	MagicFX	Flamaniac	effects	to	improve	effect	conversions	when	user	switches	between	Mode1	and	Mode2.	Changed	default	position	names	from	Pos-01,	Pos-02,	etc.,	to	P-01,	P-02,	...finale3d-installer-2022.02.02-6848d434c	(BETA	VERSION)	Fixed	'clicky'	sound	bug	for	when	cursor	hovers	over	position	nametags,
particularly	evident	on	some	computers	with	new	2D	lock	mode.	Improved	brightness	and	glowiness	of	effet	bars	on	timeline.	Added	'File	>	User	settings	>	Set	timeline	playback	scrolling	margin.	Reset	maximization	status	of	hidden	windows	when	invoking	predefined	window	arrangement	presents,	to	avoid	previously	maximized	and	hidden	windows
reappearing	as	maximized.	Cursor	over	bottom	right	corner	text	in	design	view	hides	trajectories.	Added	check	when	opening	show	for	out	of	date	blueprints,	and	put	up	a	dialog	asking	if	user	wants	to	update	them	if	there	are	any.	Added	fermata	and	stutata	to	VDL	terms,	no	sims	yet.	Fix	an	issue	causing	some	SketchUp	models	to	look	strange.
Added	a	selector	to	the	'Create	new	effect'	dialog	to	choose	which	collection	the	new	parts	goes	into.	Made	all	position	functions	respect	the	locked	flag.	Made	camera	preset	icons	update	dynamically	so	the	white	selection	indication	is	always	valid.	Draw	trajectory	tooltip	in	full	size,	bottom	justified,	not	foreshortened.	Added	Starfire	exporter.	Fix	bug
causing	minor	effect	editor	changes	to	change	the	randomness	of	shell	breaks.	Changed	labels	format	name	from	'Fancy	count	colors'	to	'Fancy	address	colors'.	Made	label's	fancy	e-match	based	color	count	only	the	e-matches	on	the	pin,	not	the	chain	devices.	Make	Intel	graphics	default	to	low	quality	rendering.	Ignore	0.0s	duration	in	single-shot
effects.	Add	a	separate	way	to	run	Finale3D	for	debugging	purposes.2018.03.01-4c10ba43-finale3d-win32-installer	(RELEASE)	Tune	down	brocade	trails	a	bit.	Added	Parente	Firemaster5	exporter.	Make	3d	nav	buttons	'one	time'	instead	of	'sticky';	they	revert	back	to	pointer	mode	after	the	nav	operation.	Added	new	option	'Show	>	Options	>	Draw
chains	as	multiple	rows'	turned	OFF	by	default,	making	the	new	default	behavior	that	chains	are	now	single	bars	on	the	timeline.	If	user	does	'Change	DMX	Fixture	Type	and	convert	effects'	with	master	fixtures	selected	and	matching	but	unselected	slaves,	then	pop	up	dialog	to	ask	if	user	wants	to	convert	the	slave	fixtures	also.	Changed	SHA1
checksum	in	Pyrodigit	export	format	to	32	bit	uint.	Added	ability	to	import	QOH	and	AVAILABLE	quantities	in	parts	files.	Added	control-.	Fix	bug	with	rising	effects	that	weren't	comets	(e.g.	pearls,	"blue	crackling	tail",	etc).	Add	audio	volume	controls	to	render	settings	menu.	Added	'File	>	Export	>	Export	effects	for	importing	into	Finale	Inventory...'
which	translates	column	headers	and	effect	type	for	easy	importing	into	Finale	Inventory	through	the	web	interface.finale3d-installer-2020.02.29-00ff3d65b	(RELEASE)	Fixed	rare	bug	in	VDL	parser	for	input	ending	in	terms	like	DUR	and	HTM.	Removed	10	colors	from	the	VDL	language,	relegating	them	and	their	language	translations	to	being
synonyms	for	equivalent	colors.	Update	to	Ukrainian	and	Russian	UI	translations.	Added	work-in-progress	on	setup-by-module	report,	available	by	selecting	the	script	blueprint	by	that	name	and	then	exporting	table	to	Excel.	Added	right-click	option	on	racks	in	rack	layoug	view,	'Change	all	effect	angles	to	match	rack'.	Added	show	import	options	to
import	into	active	show/scene	or	into	a	new	show.	Added	more	colors	and	style	options	for	content	of	labels.	Improved	the	error	messages	for	the	'Re-address'	link	in	the	rack	layout	view,	adding	an	error	dialog	if	there	are	wiring	errors.	Added	'File	>	User	settings	>	Hide	cue	flag	numbers	unless	selected	or	hovered	over'	as	a	new	option	for	keeping
the	cue	flag	vertical	lines	but	ditching	the	flags/numbers.	Added	more	choices	for	sorting	reports	and	labels.2018.08.07-ba5a3520-finale3d-win32-installer	(RELEASE)	Fixed	crash	that	could	happen	when	showing	the	'effect	preview'	hover.	Made	effect	chooser	window	remember	its	position,	size,	and	magnification	level,	for	next	time	it	is
invoked.2018.02.28-c986d536-finale3d-win32-installer	(RELEASE)	Added	effects	collection	selector	to	the	effects	chooser	dialog,	to	select	Generic,	My	effects,	Per-show	effects,	etc.	Made	DMX	Safety	Channel	effect	show	a	duration	bar	in	the	timeline.	Fixed	the	problem	that	when	right	clicking	a	grouped	row	in	the	script	table	window	to	edit	or
customize	simulation,	the	full	group	would	become	selected	and	then	a	dialog	would	ask	you	to	select	a	single	item,	unhelpfully.	Fixed	addressing	functions	such	that	racking	errors	do	not	prevent	successful	addressing	for	the	firing	system,	since	racking	errors	can	be	fixed	manually	in	rack	layout.	Fixed	'Print	table...'	function	on	right-click	context
menu	of	table	windows.	Added	capability	to	adjust	Explo	X2	Wave	Flamer	angles	by	dragging	trajectories	in	the	3D	view.	Add	'license	valid	through'	date	to	account	dialog.	e.g.	'brocade	to	multicolor'.	For	importing	HBS	files,	detect	and	fix	bad	firing	patterns	from	HBO43.	Draw	tubes	in	rack	layout	as	red	if	their	shells	use	a	rail	that	doesn't	match	the
rack's	pre-wired	rails.	Improved	error	handling	for	'Add	racks	for	show'.	Added	ability	to	adjust	the	brightness	of	the	racks	in	the	rack	layout	screen,	the	rackBrightness	per-show	setting.	Improved	copy/paste	of	models	and	positions	from	the	design	view,	fixing	a	bug	wherein	copying	a	model	from	one	show	to	another	show	that	already	contained	a
different	model	wouldn't	have	the	correct	result	of	both	models	in	the	pasted-into	show.finale3d-installer-2021.08.26-344e416ae	(BETA	VERSION)	Change	the	UI	flow	for	the	Create	Photo	dialog.	Added	a	new	addressing	constrain	option	called	'Tube	Index	--	Chain'	that	can	be	added	as	a	pin	constraint	to	force	chains	to	cross-load	across	racks.
Updated	all	DMX	related	documentation	and	example	files	to	reflect	the	change	that	DMX	Channel	Base	should	now	be	set	to	match	the	DMX	fixtures	Start	Channel	in	the	real	world	--	no	longer	subtract	one.	Added	rollover	effect	on	the	control-points	for	rotating	racks	in	the	rack	layout	window.	Made	'Script	>	Sequences	>	Spread	out	according	to
effect	durations'	keep	effects	together	that	ar	e	originally	at	the	same	effect	time,	i.e.,	same	cue.	Prevent	hit	detection	of	positions	and	trajectoies	below	the	ribbon	in	new	2D	lock	mode.	Fixed	crasher	bug	when	printing	table	to	PDF	and	moving	mouse	over	table	while	PDF	window	being	displayed.	Tune	titanium	salute.	Fix	break	smoke	and	break
flash	for	non-primary	flowers.	Fix	a	crash	bug	in	fountain/ground	flare	VDL	processing.	WARNING:	requires	re-learning	the	1-6	hotkeys.	Tune	fountains	to	taper	off	rather	than	cut	off.	Effect	editor:	allow	out-of-range	slider	values	to	be	typed	in.	We	know	this	is	inconvenient,	and	we	apologize	for	that.	Added	'File	>	Tools	>	Fill	missing	effect	fields
based	on	description...'	to	fill	in	all	the	missing	fields	in	an	effects	collection.	Minor	improvements	to	some	fixture	type	names.	Added	right-click	context	menu	on	rails	in	rack	layout	view,	with	functions	to	select	all	events	on	rail,	clear	pin	or	all	pins,	delete	rack,	and	get	explanations.	Fixed	a	memory	leak	on	the	GPU	which	should	reduce	random
crashes.2018.02.18-dc4282dc-finale3d-win32-installer	(RELEASE)	Made	show	import	expand	out	script	rows	containing	multiple	angles	in	the	angle	or	tilt	column,	as	in	VSD	convension	80-90-100	meaning	three	angles.	Added	support	for	creating	sims	and	effect	names	dscribed	in	Spanish,	and	importing	shows	and	inventories	in	Spanish.	Added	EX
Number,	UN	Number,	and	CE	Number	script	columns,	refering	effects	table,	making	them	available	to	reports	and	labels.	Removed	unnecessary	+XX	ms	remainder	in	clock	display	when	timeline	snapping	mode	matches	display	mode.	Transitions	to	multicolor	work	now.	Added	DMX	Universe	as	a	field	on	positions,	which	is	now	required	for	DMX
scripts.	Tune	the	'droopy'	adjective	to	work	better	on	gerbs.	Added	language	option	for	Brazilian	Portuguese,	work	in	progress.	Video	files	rendered	in	Finale	3D	will	now	work	natively	in	Chrome,	Firefox,	and	on	more	phones	than	previously.	Added	VDL	angle	terms	L110,	L115,	...	For	importing	HBS	files,	reverse	engineer	HBO40	for	old-style	mines
and	HBO39	for	old-style	comets.	Change	'Edit	pins'	link	to	'Drag	&	drop	pins'.	Add	strobing	effects	to	EasyDancing	par	light	fixture	effects	list.	Moved	'Effects	files'	submenu	from	effect	window	collections	selector	menu	to	the	main	'File'	menu.	The	end	result	is	that	fewer	effects	will	have	empty	black	icons.	Fix	inventory	sync	bug	preventing	edits	of
products	with	an	empty	price	field.2019.01.17-f23c5a68-finale3d-win32-installer	(RELEASE)	Fixed	a	bug	in	Galaxis	GS2	V2.6	exporter.	Added	TRIGGER_TYPE	options	of	MAN,	AUTO,	and	SLAVE	for	Pyroleda	F3	exporter	using	Custom	Script	Field.	Fixed	end-of-file	checksum	problem	that	affected	a	small	number	(0.4%)	of	exported	Pyrodigital	PDM
files.finale3d-installer-2021.11.03-d0febe8fb	(BETA	VERSION)	Updated	Russian	and	Ukrainian	UI	translations.	Added	Cakes	Last	sort	term.	Support	importing	old-style	HBS	effects	based	on	HBO47	or	HBO40	or	HBO43	or	HBO48.	Added	indicator	above	drawn	rack	to	show	that	its	tube	loading	order	is	reversed.	Add	play	time	warnings	for	dmx	effect
in	pyro	position,	and	vice	versa,	and	incopmatible	dmx	effect	with	fixture.	Made	application	select	Finale	Inventory	or	My	effects	automatically	upon	launch	if	they	have	any	effects	in	them.	Fixed	the	'STR'	firing	pattern	in	cake	descriptions.	Support	interpreting	NxM	in	effect	names,	as	in	'5x5	gerb	cake'.	Widened	effects	files	menu.	Fix	flash	tray
simulation.	Added	warning	dialog	if	inserting	effect	from	effect	bar	with	no	selected	positions.	Made	report	formatting	clear	redundant	leading	cells,	indenting.	Previously	the	function	didn't	support	creating	cakes	from	other	cakes.finale3d-installer-2019.12.13-bb7e6f9eb	(RELEASE)	Fixed	file	system	bug,	making	it	possible	now	to	save/load	from
network	drives.	Fix	horsetails	and	waterfalls	to	not	look	so	artificial.	Made	effect	chooser	window	remember	its	position,	size,	and	magnification	level,	for	next	time	it	is	invoked.	Added	text	wrapping	option	for	labels	and	reports;	and	updated	all	standard	reports	to	use	text	wrapping	on	the	Description	field.	Changes	to	report	templates	are	not
automaticaly	incorporated	into	existing	shows,	so	see	to	copy	the	new	templates	to	existing	shows	if	you	need	to.	Added	clickable	links	for	collection,	size,	and	quantity	filters	to	base	of	effect	palette.	Improve	ematch/chain	hint	in	labels,	making	it	show	show	delays	for	full	chain,	e.g.,	'Chain	of	5	x	2.0s'	Full	Polish	UI	translation.	Fixed	tooltips	and
effect	basket	groupings	on	the	rack	windows	to	take	into	account	sleeves.	Changed	SCX	default	angle	convention	on	import	to	left	=	0,	up	=	90.	Fix	non-ascii	filename	handling	in	sound	files.finale3d-installer-2020.01.08-bf55d5892	(RELEASE)	Make	'Combine-as-cake'	function	and	cake	importing	from	HBS	files	more	tolerant	of	asymmetric	angles	and
small	errors	in	the	input	angles,	which	previously	could	prevent	interpretations	of	various	firing	patterns	in	angles.	Added	show	menu.2017.09.11-dd38d166-finale3d-win32-installer	(RELEASE)	Fixed	crash	bug	PBL-0019	that	occurred	when	clicking	on	a	selector	after	typing	text	into	the	search	bar	of	a	table.	Added	'storage	location'	to	Show	Director
CSV	export	as	the	CUSTOM3	column.)	Fix	bug	causing	'qoh'	and	'available'	columns	to	cause	spurious	change	notifications	when	syncing	to	Finale	Inventory.	Added	'Rack	counts'	link	at	bottom	of	rack	layout	view,	to	give	dialog	with	summary	of	rack	usage	in	the	position.	Fixed	the	bug	that	saving	files	to	DropBox	or	to	drives	with	security	encryption
could	sometimes	have	an	error	when	those	processes	touched	the	file	while	finale3d	was	saving	it.	Made	effect	chooser	support	multiple	monitors	for	remembering	its	position.	Make	'flare'	on	its	own	recognized	as	a	ground	flare.	Major	re-design	of	the	UI	for	adding	racks	to	the	show,	including	merging	the	user	interface	for	EasyRacks	and	regular
racks	by	creating	an	'Add	racks'	dialog	that	includes	all	available	rack	options.	Added	'edit	effect...'	menu	item	to	context	menu	in	script	and	on	timeline.	Made	copy	in	design	view	or	script	also	copy	the	referenced	part	definitions,	and	paste	automatically	paste	any	missing	referenced	part	definitions	from	the	copy	buffer	first,	and	from	the	active
parts	windows	second,	facilitating	copy/paste	between	shows	that	do	not	use	a	common	inventory/parts	list.	Automatically	filter	to	type	=	rack	when	switching	to	rack	layout	view,	shift-3.	Moving	lights	will	come	later	this	year.	Added	Pyrosure	DMX	script	exporter.	Re-enabled	support	for	shift-dragging	selection	rect	to	add	items	to	existing	selection
set	in	sim	view,	and	on	timeline	selection	strip	at	the	bottom	of	timeline.	Improved	download	and	rotate	cursor	images.	Added	error	message	if	user	sets	Pre-Wired	Rails	of	racks	without	also	listing	the	pre-wired	rails	as	Pre-Assigned	Rails	in	the	position	properties.	Improved	and	fixed	some	minor	bugs	in	the	automatic	effect	window	filtering
triggered	by	clicking	on	fixture	positions.)Fixed	clang	detected	bugs	Added	new	looping	feature	with	'Show	>	Looping	>	Add	loop	start/end	marker'	function	to	loop	a	section	of	the	show	while	you	are	working	on	it	and	optionally	use	the	'while-playing'	effect	macros	to	add	effects	to	the	section	you	are	working	on,	layering	them	in	while	the
simulation	is	playing.	Added	support	for	the	tiltable	rows	type	of	rack	in	the	new	addressing	function,	'Re-arrange	tubes	in	adjustable	angle	racks	to	avoid	collisions.'	Updated	Polish	UI	translation.	Added	PyroSoft	firing	system	exporter.	Fix	issue	with	Finale	Inventory	network	sync,	causing	F3D	rows	with	an	empty	part	type	to	be	synced	as
choreography	tab	'Non-Choreographed',	which	meant	that	they	didn't	show	up	in	Finale	3D,	so	it	looked	like	they	were	being	deleted.	Added	fireTEK	v3.0	script	format	with	11	columns.	Fixed	bug	in	multi-DMX-universe	export	for	fireTEK	and	PyroSure.	Changed	the	wording	in	the	fan	and	sequence	dialog	options	to	make	them	more	understandable.
Changed	the	Delay	column	to	show	the	delays	from	first	item	for	chains,	e.g.,	0*1*2*3*4,	so	users	can	customize	the	Chain	Specifications	report	to	use	Delay	intead	of	Chain	Gap,	which	shows	the	relative	delays	like	0*1*1*1*1,	if	that's	what	the	users	want.	Previously	users	could	define	DMX	effects	but	would	need	to	select	''	for	the	fixture	type	of	the
position	instead	of	being	able	to	select	the	fixture	by	name;	also	the	'Assign	DMX	channel	ranges...'	function	previously	only	applied	to	pre-defined	fixture	types	in	Finale,	and	it	now	applies	to	user-defined	fixtures	also.	Fixed	checkbox	problem	on	create	rack	dialog.2018.09.18-2cf0f548-finale3d-win32-installer	(RELEASE)	Added	drag-and-drop	from
module	pin	to	module	pin	in	rack	layout,	to	support	moving	effects	from	pin	to	pin	visually.	Made	subtype	and	color	fields	of	effects	optional.	Tune	gold	trails.	No	longer	change	window	arrangement	automatically	to	make	the	script	window	visible	as	a	side-effect	of	addressing	the	show.finale3d-installer-2020.04.21-a1e3ec668	(RELEASE)	Fixed	bug
causing	initial	inventory	sync	to	not	happen.	If	user	creates	a	bouncing	sequence	in	the	'Make	into	sequence'	dialog	and	has	the	same	number	of	effects	at	every	position,	present	a	dialog	to	the	user	offering	to	remove	the	doubled	up	turnarounds	automatically.	Fix	'mine	pancake	always	points	straight	up'	bug.2018.07.12-5642000c-finale3d-win32-
installer	(RELEASE)	Added	cue_list	report.	Added	new	reports:Basic	rail	pin	report,	Basic	pull	sheet,	Basic	rack	list,	Basic	rack	totals,	Basic	Product	list,	Basic	product	totals,	Basic	size	totals.	Made	the	Type	field	of	the	new	'Create	Effect'	dialogs	show	the	user's	initial	value	from	the	Type	column	even	if	different	from	the	type	implied	by	the
description.	The	'Make	into	sequence'	dialog	now	calculates	the	initial	default	duration	to	be	the	initial	time	range	of	the	selected	effects.)NOTE(The	'Make	into	sequence'	and	'Spread	out	evenly/accelerating/etc.'	dialogs	now	save	the	state	of	the	grouping	checkbox	so	you	don't	need	to	check	it	every	time,	and	also	automatically	check	it	if	any	groups
from	the	combine-as-group	action,	g-key,	exist	in	the	selected	effects,	since	you	generally	always	want	to	keep	them	together.	Fixed	bug	in	Finale	Inventory	integration	that	merged	instead	of	replaced	the	downloaded	inventory	locations,	which	was	only	noticeable	if	you	can	from	one	account	to	another.	Fixed	bug	wherein	the	control-G	create	effect
function	provided	a	default	part	number	of	10000	instead	of	avoiding	existing	part	numbers.	Added	'Firing	Point	Type'	to	RFRemotech	exporter	and	changed	name	to	Pyroremotec-RFMemotech.	Make	movie,	image,	and	icon	renders	use	the	'new'	progressive	render	framework	that	has	been	in	use	for	edit	mode	for	awhile	now.	Added	'Set	chain	delays'
function	that	lets	you	enter	a	list	of	numbers	and	applies	them	to	all	selected	chains.	Added	'Create	rack...'	and	'Edit	rack...'	functions	--	but	racks	are	still	not	ready	to	be	used.	PD	and	FireOne	terminology	change	in	menus.	Added	position	movement	rulers	for	positions	in	a	line	that	is	not	axis-aligned.	Added	'Show	>	Set	time	format'	to	display	time	in
various	frame-based	formats	or	decimal.	Added	'Select	racks	containing	this	item'	to	effects	context	menu.	Now	if	you	leave	that	field	blank	then	the	default	Module	Or	Slat	Type	applies,	which	is	just	what	you	would	expect.	Fix	bug	with	Create	Photo	dialog	causing	main	app	window	to	become	unresponsive.	Fix	bug	causing	Finale3D	to	use	a	lot	of
unnecessary	CPU	time	(even	when	minimized).	Added	positions	locked/unlocked	button.	Got	rid	of	position	tooltips	on	timeline.	Added	selector	options	in	'Flights	>	Make	flights	into	sequences'	for	different	orders,	like	center	to	outside	and	alternating.	Fixed	DEL	key	behavior	in	models	and	positions	table	window,	which	previously	didn't	detach
children	positions	or	events.	Added	'Effects	>	Subtract	used	quantities	from	available'	for	simple	inventory	management.	Added	'Choose	catalogs	of	effects	to	download'	menu	item.	Present	'Firing	system	script	options'	dialog	when	user	exports	firing	system	scripts,	the	dialog	containing	options	specific	to	the	firing	systems	involved,	such	as
standard/semi-auto,	time	resolution,	script	format	version,	trigger	button,	alternate	button,	etc.	Removed	old	"set	background	image"	menu	items	that	didn't	work.	Changed	table	cell	editing	focus	to	not	require	double	clicking	a	cell	to	edit	it.	Improved	menu	items	for	adding	racks	to	the	show.	Fixed	positions	window	invalidation	problem	wherein
rows	didn't	highlight	reliably	when	selected	in	the	design	view.	EX:	'red	cake'	=	comets;	'aerial	red	cake'	=	shells;	'red	peony	cake'	=	shells.	Automatically	save	and	retain	a	backup	file	of	any	file	that	you	overwrite	while	saving,	and	provide	access	to	the	backup	files	with	a	new	menu	item,	'File	>	Admin	>	Open	backup	files	directory'	Added	'Rack
Type'	to	the	sort	criteria	options	for	addressing	and	reports.	Fixed	divider	lines	in	context	menus.	Added	Polish	UI	translation.	Fixed	the	problem	that	single	shot	shells	would	have	zero	duration.	Fixed	crash	bug	that	occurred	if	you	hid	all	windows	and	then	closed	the	script	window	from	task	bar	while	windows	hidden.	Very	fun.	Made	the	straight	up
ss	racks	in	Craig	Co.	racks	and	Pyrolamas	racks	collections	be	non-rotatable	so	the	other	angle	racks	would	be	added	automatically	instead	of	tilted	straight	up	racks.2019.09.23-f6093646-finale3d-win32-installer	(RELEASE)	Reorganized	effect	menu	items,	movingall	import	functions	to	file	menu.	Improved	cursor	image	reactiveness	when	using	fill
handle	in	table	cells.	Added	'Lights	blueprint'	table	layout	preset	puzzle	piece	to	the	script	window.	Improved	'Effects	>	Update	per-show	effects'	to	work	correctly	when	updating	chain	effects	in	all	circumstances,	including	when	effect	definition	changed	from	being	a	chain	to	not	a	chain	or	vice	versa	or	changed	number	of	shells	in	the	chain;	the
rows	in	the	script	now	automatically	adjust	accordingly.	Disable	position	and	event	hit	testing	while	in	rotate	or	translate	or	rise	navigation	modes.	Added	'File	>	User	settings	>	Use	A4	page	size	for	all	reports	and	settings'	which	overrides	the	page	size	in	all	standard	and	custom	blueprints.	Changed	VDL	term	thick_trail	and	thin_trail	to	just	thick
and	thin,	but	still	support	thick_trail	and	thin_trail	also.	Changed	Pyrodigital	'Manual	script'	mode	exporter	to	collapse	prefires	of	individual	cue	markers	as	described	in	Table2	of	Documentation	>	Software	documentation	>	Pyrodigital.	Fixed	CSV	show	import	to	ignore	invalid	module	types	in	the	CSV	file	so	that	exporting	works	if	you	simply	set	the
'Addressing	>	Addressing	settings	>	Set	default	firing	system'	option.	Removed	fractional	second	sparks	effects	and	added	two-sec	duration	sparks	effects	for	Sparkular	and	Sparkular	Cycle,	part	numebrs	SHV3019,	SHV3020,	SHV3021,	SHV3119,	SHV2120,	SHV2121;	and	for	MAGICFX	Sparxtar,	part	numbers	MAFX3019,	MAFX3020,	MAFX3021,
and	for	Auvi	Spark,	part	numbers	AUV1019,	AUV1020,	AUV1021.	Fix	one	bug	that	was	causing	Finale3D	to	use	too	much	cpu	(but	another	remains).	Added	pre-export	checks	for	events	having	errors,	events	having	no	addresses,	and	other	circumstances	and	display	context	sensitive	instructional	dialog.	Added	rack_list	report,	which	lists	racks	used	in
rack	layout,	grouped	by	cluster,	including	angles	and	modules;	this	report	is	meant	to	be	used	in	combination	with	a	rack	layout	diagram.	Updated	Brazilian	Portuguese	translation,	now	complete.2019.07.27-84335621-finale3d-win32-installer	(RELEASE)	This	release	is	the	first	release	with	a	new	renderer	implementation	that	should	be	much	faster
and	more	stable	than	the	previous	renderer.	Previously,	gold-tipped	comets	would	look	much	larger	than	red	comets,	for	example.	Added	position	movement	guidelines	for	'middle-of-neighbors'	and	'same	coordinate	as	other	positions'	and	'extending	sequence'.	Added	options	to	the	'Add	backdrop	image...'	function	for	importing	images	with	alpha
transparency	for	creating	scenes	in	which	some	fireworks	are	in	front	of	the	image	and	others	are	in	back	of	the	image.	Added	Pyrodigital	manual	script	mode,	supporting	macros	and	zipper	fire	--	select	from	module	type	selector.	Removed	table	context	menu	items	for	filters	because	they	didn't	justify	their	pixels.	Added	previewer	window	features	to
the	effect	chooser	dialog.	Please	report	if	it	is	slower	for	you.2019.05.15-e7e0dd3d-finale3d-win32-installer	(RELEASE)	Improved	German,	Spanish,	French,	Italian,	and	Russian	translations.	Added	hot	keys	for	'Align	at	earliest	event	time'	and	'Align	at	latest	effect	time'.	Added	'Exact	match	only'	and	'Near	match'	options	for	the	'Change	fixture	and
convert	effects'	option	for	switching	between	fixtures	with	different	capabilities,	like	flame	systems	with	and	without	angles.	Add	'silent'	as	a	VDL	adjective.	Performance	should	be	improved,	but	some	icons	might	not	be	pictured	as	well	as	they	previously	were.	Changed	'signup'	button	into	'create	account'.	Added	'Show	>	Zoom	to	selected	effects	on
timeline'	menu	item	and	hotkey;	same	as	button	on	timeline	Changed	the	'X'	hotkey	to	be	selection	box.	Fixed	script	row	highlight	jumping	around	when	playing	overlapping	chains	while	showing	chains	as	single	row	in	script.	Added	'Pre-Assigned	Rails'	field	on	position	properties,	enabling	user	to	pre-assign	specific	rails	per-position	instead	of
counting	up	from	'Start	Module'.	Fix	bug	with	pistils	appearing	disconnected	from	certain	effects.2018.05.31-a2a8e83b-finale3d-win32-installer	(RELEASE)	Fix	a	bug	on	syncing	with	network.	Flash	position	padlock	button	and	tooltip	when	user	attempts	to	drag	positions	while	locked.	Sorted	rack	buttons	in	rack	layout	palette	first	by	maximum
caliber,	then	rack	width,	then	height.	Fixed	UI	bug	wherein	dragging	positions	floating	in	air	from	top	view	would	sometimes	drag	them	in	weird	directions.	Minor	optimization	to	Cobra	exporter,	removing	duration	field	when	value	will	be	set	by	next	event	with	no	gap.	Improved	some	language	translation	terms.	Fixed	right	click	hit	detection	on
position	group	flower	icon	labels	and	camera	preset	labels.	Updated	French	and	Hungarian	UI	translations.	Made	cake	VDL	parser	more	robust	in	reading	firing	row	descriptions	by	allowing	a	slash	before	the	asterisk	that	indicates	two	rows	are	fired	together.	Enlarged	report	header	field	widths	for	Russian	and	other	localizations.	Added	a	new
option	on	the	addressing	dialog,	'Treat	blank	values	for	script	custom	fields	as	wildcards'	which	makes	it	possible	to	implement	more	custom	addressing	schemes	using	Custom	Script	Field	and	blank	values	as	wildcards.	Improved	'Script	>	Randomize'	to	keep	effects	together	that	are	originally	at	the	same	effect	time,	i.e.,	same	cue.	Added	a	'Zoom'
link	button	to	the	rack	layout	view.	Added	drag	and	drop	wiring	from	rack	tubes	to	other	rack	tubes	in	rack	layout.	Updated	Polish	UI	translation.	Fix	'shell	w/	mine'	and	'comet	w/	mine'	effects	such	that	the	mine	doesn't	shoot	out	of	the	tube	faster	than	the	shell/comet.	Changed	effect	field	name	'Fuse	Delay'	to	'Delay	Default'	in	preparation	for	further
changes	to	prefire.	Made	combine-as-cake	support	fans	with	double	straight-up	shots,	as	wouldbe	produced	by	pairs	of	bookend	slices	shot	in	parallel	to	make	the	fan.	Extended	Unicode	case	conversion	to	French	accent	characters.)WIP	on	French	effect	names.2018.03.16-72020124-finale3d-win32-installer	(RELEASE)	Finally	located	and	fixed	the
bug	that	was	the	#1	source	of	crashes.	Changed	theway	racks	are	sorted	for	addressing	purposes,	now	sorting	racks	by	their	'Rack'	field,	which	is	visible	as	a	coliumn	in	the	table	below	the	rack	diagram,	instead	of	the	internal	creation	date,	which	wasn't	visible	or	changeable	by	the	user.	Fix	bug	with	compound	colors	not	working	properly	in	cakes.
Fixed	minor	bug	in	'Update	Per-show	effects'	for	chains.	Made	play	time	highlight	in	script	window	update	while	dragging	timeline	background,	as	it	does	while	dragging	playhead	itself.	Round	prefire,	duration	to	hundredths,	height	to	tenths.2018.02.05-b0d39960-finale3d-win32-installer	(RELEASE)	Bugfixes	for	Finale	Inventory	integration.	Added
ability	to	shift-select	multiple	Finale	Inventory	locations	to	see	combined	available/qoh	quantities,	in	the	Effects	>	Finale	Inventory	menu.2018.05.25-d9e88992-finale3d-win32-installer	(RELEASE)	Made	undoing	'Break	apart	chain'	restore	the	durations	of	the	constituent	shells.	Fixed	a	bug	in	the	rack	layout	pin	editing	for	the	CSV	firing	system.
Change	the	way	icons	are	rendered.	Expanded	'SequenceFire'	page	numbers	for	StarFire	exporter	by	supporting	4-digit	and	5-digit	Track	numbers.	'Export	Show'	now	gives	a	warning	for	missing	module	types	/	empty	events.	Fixed	type	of	DMX	Safety	Channel	so	it	receives	firing	system	/	DMX	address.	Make	the	function	'Assign	DMX	channel	ranges'
assign	new,	blank	fixtures	to	available	channels	in	existing	used	universes,	similar	to	filling	available	pyro	module	pins,	instead	of	starting	a	new	universe	for	them.	Added	firemasterMinSeparation	and	firemasterSequenceNumberOffset	per-show	settings	variables.	Added	label	configuration	checkbox	for	'Sort	by	rows'	versus	sort	by	columns.	Added
'Spray	the	fire'	flame	projector	to	DMX	fixture	options.	Fixed	crash	when	user	manually	types	in	an	invalid	module	type	into	the	positions	window	and	then	addresses.	Save	and	restore	current	window	arrangement	when	quitting	and	restarting	the	app;	and	use	default	arrangement	if	monitor	configuration	is	different	from	when	arrangement	was
saved.finale3d-installer-2021.06.18-41eec0592	(BETA	VERSION)	Made	minor	optimization	to	Pyromac	exporter	for	overlapping	DMX	events.	Added	first	full	Chinese	UI	translation.	Remove	the	XX	from	partially	finished	UI	translations.	Added	pyromac	15	channel	module	type.	Fixed	bug	that	we	introduced	in	Explo	X2	Wave	Flamer	effects	in	the	last
beta	release	when	changing	DMX	Patch	terminology	from	'prefire'	to	'setup'.	Removed	'Background	images	>	Ground	tile	images'	since	it	wasn't	used	that	much.	Added	hint	dialogs	when	adding	model	or	editing	terrain	that	point	user	to	render	settings	to	adjust	brightness.	Added	render	option	to	disable	smoke	entirely.	Added	ability	to	rotate
MAGICFX	Flamaniac	flames	interactively	by	dragging	trajectory.	Added	rack	functions	to	'Clear	all	tube	assignments'	and	'Select	all	events	missing	tube	assignments'	and	'Clear	tube	assignments	of	selected	events'.	Added	'File	>	Import	>	Import	effects	and	break	apart	cakes	from	HBS	file...'	to	help	users	debug	cakes	before	converting	them	to	VDL.
Automatically	consolidate	label	interior	margins	to	move	labels	out	of	unprintable	area	if	necessary.	Updated	German	and	Polish	UI	translations.finale3d-installer-2020.03.12-06a0a5dba	(RELEASE)	Added	'Script	>	Insert	effect	>	Insert	selected	effect	from	effect	window'	with	bound	hotkey	of	'W'.	Fix	a	bug	causing	'My	Effects'	network	sync	to	fail.
Wire	up	sound	nodes.	Added	back	the	filter	commands	in	the	table	context	menus,	by	popular	demand.	Simplified	the	filter	for	DMX	effects,	removing	DmxPatch	!=	''.	Removed	the	Pyrotronix	DMX-specific	module	types	and	made	the	general	Pyrotronix	module	types	support	both	pyro	and	DMX,	based	on	whether	the	positions	are	configured	as	DMX
fixtures.	Fix	bug	where	cakes	were	not	being	rotated	when	positions	were	rotated.2018.05.07-58320c2d-finale3d-win32-installer	(RELEASE)	Removed	empty	color	change	transitions	from	translated	effect	names.	Added	customizable	effects	window	presets	in	the	effects	menus	to	make	it	easy	to	switch	between	effects	collections	and	table	layouts
with	hot	keys.	Improved	Pyromate	module	options	in	menus.	Changed	chain	importing	and	inserting	to	insert	as	many	devices	as	specified	in	the	'Devices'	column	even	if	that	number	is	1,	rather	than	treating	1	as	a	special	value	that	means	'guess	based	on	description'.	Added	Hungarian	Forint	currency	symbol	option.	Disable	the	'gpu	has	crashed	but
Finale3D	can	continue'	dialog,	which	was	just	confusing	people.	Fixed	minor	graphics	bug	wherein	rack	tube	circles	were	not	drawn	in	some	circumstances	that	involved	red	warnings	on	tubes.	Redefined	crackle_flowers	to	be	terminal	pop	at	end	of	star	life,	in	contrast	to	dragon_eggs	which	is	a	non-terminal	star	stage	description	and	time_rain	which
is	also	non-terminal.	Added	support	for	DMX	slave	fixtures.	Try	it	with	100	slaves!	Added	warning	dialogs	when	adding	pyro	to	DMX	fixture	position	or	vice	versa,	or	adding	incompatible	DMX	effects	based	on	the	DMX	Fixture	Type,	e.g.,	trying	to	add	a	G-Flame	effect	to	an	Explo	flame	projector.	Fixed	timeline	scrolling	UI	and	scrollbar	behavior	in
over-extended	circumstances.	Combine	nearly	equal	durations	and	delays	in	'Combine	as	cake'	to	avoid	rounding	error	in	shown	VDL	output.	Fixed	minor	problem	with	ptx2	extension	being	added	twice.)NTOE(Added	error	checking	for	ptx2	DMX	effects	that	are	missing	the	information	in	the	Category	and	Custom	Part	Field	information	that	is
required	for	Pyrotronix	scripts.	Updated	Norwegian	UI	translation.	(Try	using	an	Explo	flamer	from	the	Generic	Effects	list).2018.03.26-e3b4bb01-finale3d-win32-installer	(RELEASE)	Tune	scene	lighting	a	bit	more.	Fixed	bug	that	site	layout	view	shows	the	position	names	in	the	upper	left	corner	instead	of	attached	to	each	position.	Added	real-time
pin	usage	warning	dots	on	the	positions,	available	from	the	'Show'	menu.	Fix	crash	bug	in	long	exposure	rendering.	Added	support	for	Maltese	effect	names	with	automatic	translation	to	VDL.	Implement	user-specified	ground	images.	Improved	the	'Add	racks'	functions	to	handle	cases	in	which	chosen	racks	have	fixed	angles	that	cannot	be	tilted	to
match	the	effects	being	racked.	Added	'File	>	User	settings	>	Set	timeline	response	for	clicking	row	in	script'	with	options	to	center	selected	event	on	timeline,	etc.	Enlarged	limit	of	number	of	tubes	per	rack	from	100	to	400,	for	big-ass	single-shot	racks.	Finished	'File	>	User	settings	>	Set	currency	symbol'	function.	Start	out	with	positions	locked	by
default.	Made	show	import	prefer	using	a	tilt	column	over	an	angle	column	if	it	exists	and	is	non-empty.	Made	all	script	operations	snap	to	the	timeline	snap-to	resolution.	Work-in-progress	Preserve	table	layout	when	switching	between	different	collections	in	effects	view;	works	except	for	opening	a	new	show.finale3d-installer-2020.03.18-49a6bd2ce
(RELEASE)	Updated	Hungarian	UI	translation.	Added	basic	rack	functionality	for	Hobbyist	version	to	define	racks,	add	racks	for	show,	and	print	reports	of	rack	lists,	leaving	visual	editing	and	rack-based	addressing	as	pro	features.	Updated	all	default	label	templates	to	a	new	layout	that	uses	the	new	fields	to	display	show	date	and	name,	e-
match/chain	message,	and	a	duplicate	of	the	address	in	the	lower	right.	Fixed	error	dialog	bug	in	Show	>	Set	show	duration.2017.11.05-57cb671d-finale3d-win32-installer	(RELEASE)	Added	slight	automatic	rise	when	zooming	out,	to	make	it	easier	to	get	things	in	view.	Added	horizontal	sliders	for	most	number	fields.	Made	opening	a	show	file	or
changing	show	duration	automatically	resize	the	timeline	width	to	full	duration	of	show.	After	user	changes	an	effect	row	in	the	effects	window	by	deleting	the	value,	the	'update	show?'	dialog	will	appear,	just	as	if	the	user	had	changed	the	value	to	a	number.	Send	'Instructions	for	your	Finale3D	account'	email	to	users	who	create	their	account	via	the
app	rather	than	the	website.	Changed	Cobra,	Mongoose,	and	Fire	Control	G2	exporters	to	assume	DMX	channel	values	are	0	start	of	all	tracks,	and	to	make	optimizations	based	on	that	assumption.	Made	editing	effects	in	their	original	collections	write-through	the	effect	to	the	per-show	effects,	with	confirmation	diallog	if	user	did	not	initiate	the	edit
in	the	script,	timeline,	or	3d	view.	Implement	new	access	level	code,	supporting	trial	users	who	can't	save/render/etc.	Created	new	supplier	catalog	called	'Assorted	DMX	Effects'	to	hold	effects	for	fixtures	that	don't	have	supplier	catalogs	but	that	don't	belong	in	Generic	Effects;	and	moved	Chauvet	and	Auvi	effects	into	that	catalog.	Supported	effect
icons	and	previews	for	effects	missing	VDL,	instead	of	showing	yellow	warning	triangle.	Added	the	DMX	fixture	configuration	dialog,	which	makes	it	easy	to	configure	a	position	as	a	DMX	fixture	and	to	set	the	DMX	Universe,	DMX	Channel	Base,	Position	Type,	DMX	Fixture	Type,	and	DMX	Effect	Filter.	Made	'Combine	as	cake'	support	up	to	50	rows,
15	unique	effects,	999	shots,	and	made	it	substitute	if	more	than	15	unique	effects	are	required.	Added	Brazilian	Portuguese	translation.	Added	a	check	in	the	'Break	apart	chain'	function	to	test	if	chain	was	created	by	a	means	other	than	'Combine	as	chain'	and	to	give	a	warning	message	if	so.	Added	cursor	image	change	when	cursor	over	timeline
selection	strip	on	bottom.	Added	'DMX	>	Create	DMX	effect'	dialog	for	defining	your	own	effects	for	your	own	fixtures	or	for	the	pre-defined	fixtures.	Improved	the	'Script	>	Make	into	sequence'	function	to	preserve	internal	timing	of	groups	when	the	'Grouping'	checkbox	is	checked,	making	it	possible	to	put	sequences	into	sequences	without
flattening	them.	Changed	importer	to	read	VendorNumber	as	Manufacturer	instead	of	Manufacturer	Part	Number.	Tune	bees.	Added	'Show	>	Temporary	settings	>	Expand	all	groups	on	timeline'.	Added	a	new	addressing	sort	criterion	'Rack	Number'	that	sorts	address	assignments	such	so	as	to	fill	the	racks	in	order	as	user	has	laid	them	out	and
renumbered	them,	satisfying	a	common	user	request	to	assign	addresses	based	on	the	racks	as	laid	out	instead	of	by	size	or	angle	or	other	criterion.	Added	snap-to	rotations	of	1,	5,	and	22.5	degrees	for	rotating	positions.	Fixed	bug	with	wildcard	custom	fields	in	addressing.	Added	three	new	Generic	Effects	for	flames	with	variable	duration,	GFX1005,
GFX1006,	and	GFX1007.	Streamline	installer	to	automatically	install	to	AppData/Roaming.	Previously	combine-as-cake	would	not	provide	a	good	result	if	the	physical	construction	of	the	cake	would	have	required	parallel	firing	slices.	Changed	table	editing	to	require	double	click	to	edit	cell;	cell	no	longer	accepts	text	input	when	yellow.2017.12.27-
cdc4e50a-finale3d-win32-installer	(RELEASE)	Added	drag-and-drop	sound	effects.	Make	'popcorn	crackle'	sparks	count	as	trail	sparks	(and	all	other	'grandchildren	sparks'	as	well).	Added	full	French	translations	of	VDL	terms,	except	for	a	few	terms.	Improved	SmartShow	importer	to	allow	double	quote	characters	in	the	imported	file.	Fixed	minor
update	problem	wherein	module	pins	on	the	rack	layout	screen	didn't	turn	red	when	referencing	deleted	racks.	Made	the	new	height,	duration,	size,	and	prefire	fields	in	the	'Create	Effect'	dialog	affect	derived	values,	so	changing	the	height	will	change	the	duration	or	prefire	accordingly,	etc.	Fixed	effect	bar	search	button	background.	Started	Polish
UI	translations	on	top	level	menus.finale3d-installer-2020.02.07-b69dcbaac	(RELEASE)	Update	Hungarian,	Brazilian	Portuguese	UI	translations.	Fixed	bug	that	caused	effect	editor	to	pause	for	long	periods	of	time.	Don't	compress	audio	data	and	model	data	being	stored	in	FIN	files,	so	that	saving	is	faster.	Improved	Russian	and	Hungarian
translations.	Fixed	'Script	>	Time	adjustments	>	Add	time	variance'	bug,	making	it	automatically	keep	same-time	effects	together.	Added	option	to	ignore	type	field	when	importing	shows	and	inventory	files,	to	make	importing	more	reliably	for	user	data	with	types	different	from	Finale's	convention.	Make	serpents	not	spread	so	wide.	Fixed	minor	bug
in	'Make	into	sequence'	and	'Spread	out	evenly'	functions	for	sequences	containing	both	groups	and	chains.'	Made	'Spread	out	evenly'	functions	preserve	internal	timing	of	groups/patterns	when	'Grouping'	checkbox	is	on,	instead	of	flattening	the	timing	patterns	within	groupes.	Make	the	sync	dialog	error	messages	more	user-friendly.finale3d-
installer-2020.07.08-c5ac316ea	(RELEASE)	This	build	has	a	new	implementation	of	the	vdl_parser.	Changed	location	of	saved	user	settings	to	the	new	backups	directory	so	they	don't	get	blown	away	when	you	install	new	versions	of	the	software.	Made	the	'Used'	and	'Available'	columns	in	the	effect	window	show	the	red	and	green	highlights	when
their	values	are	zero	and	the	highlighting	conditions	are	met,	but	not	if	their	values	are	undefined/blank.	Extended	'Effects	>	Create	cake	from	selected	items'	to	support	building	slices	and	then	combining	them	into	bigger	cakes.	Change	menu	item	'File	>	User	settings	>	Chains	count	as	1	unit	in	'used'	column'	to	make	language	consistent	with
website.	Make	the	'Create	new	account'	link	go	to	the	right	place.	Slow	renders	"fill	in"	over	time,	so	that	the	app	can	remain	responsive	when	rendering	many	effects.	Implemented	'File	>	Admin	>	Reset	user	settings'	and	'...Reset	do-not-show	dialog	flags	in	user	settings'	Made	clicking	on	empty	square	in	rail	switch	between	'Edit	racks'	mode	and
'Edit	pins'	mode.	Added	last	few	French	translation	effect	terms.2018.04.06-ebbbb653-finale3d-win32-installer	(RELEASE)	Improved	Explo	SHW	script	file	importer	to	import	x-flamer	shows	and	automatically	to	create	flame	simulations.	Made	'Filter	effects	window	to	compatible	DMX	effects'	detect	if	you	need	to	switch	collections,	and	do	it	for	you
automatically	after	a	confirmation	dialog.	Changed	part	numbers	of	some	Explo	X2	Wave	Flamer,	Showven	Circle	Flamer,	and	Spark	Fabrica	Moving	Head	fixture	effects	to	make	the	'Program'	effects	sort	last	in	the	effects	window.	The	new	format	shows	the	range	of	combined	addresses.	Changed	name	of	basic_rail_pin_report	to
basic_script_rail_pin_report.	Improved	'Effects	>	Finale	Inventory	>	Settings'	dialog	with	buttons	to	connect	or	adjust	settings.	Changed	font	in	render	settings	dialog	to	make	it	fit	in	window	in	non-English	languages.	Improved	menu	item	names	in	Effects	menu.	Added	capability	to	open	a	Pyrodigital	PDM	file	as	a	generic	table	so	you	can	see	its
contents	before	downloading.	Tune	spark	rendering	to	be	better-performing.2018.09.27-b459eee9-finale3d-win32-installer	(RELEASE)	Added	more	fields	to	the	Finale	Inventory	sync:	DMX	Patch,	Color,	Subtype,	Hazard	Default,	Rack	Type	Default,	Tubes,	and	Custom	Part	Field.	Improved	DMX	strobe	time	values	for	Rockville	Battery	Par	50	Par	Light
fixture.	Fix	bug	where	inventory	sync	did	not	work	when	the	main	window	was	minimized.	Added	'Select	all	positions	attached	to	model'	function.	Fixed	bug	reading	comma	radix	mark	calibers	like	2,5inch.	Added	'Easy	racks'	button	to	rack	layout	view	for	adding	as	many	additional	easy	racks	are	required	for	the	position	being	viewed,	keeping	the
existing	racks.	Added	Dance	Of	Fire	firing	system.	Fixed	minor	bug	with	the	automatic	application	or	clearing	of	the	Type=Rack	filter	when	switching	to/from	window	arrangements	that	include	the	racks	window.	Fixed	StarFire	track	validation	to	allow	the	full	range	1..932	instead	of	100..9999.	Improved	email	verification	flow	when	trying	to	log	in
with	an	unverified	email	address.	Allow	staying	in	full	screen	design	window	mode	when	creating	effects.	Added	gradient	to	effect	cells	in	table.2017.10.10-65298f0f-finale3d-win32-installer	(RELEASE)	Improve	startup	time	a	bit.	Fixed	minor	bug	in	which	the	'Used'	count	for	racks	in	the	effects	window	wouldn't	update	after	making	changes	to	the
rack	view.	Updated	Hungarian,	Brazilian	Portuguese,	and	Norwegian.	Updated	Bulgarian,	Polish,	and	Brazilian	Portuguese	UI	translations.	Added	rack	constraints	field	on	addressing	dialogs	to	support	restrictions	on	racks	similar	to	restrictions	on	modules,	slats,	and	pins.2018.09.29-695f5b95-finale3d-win32-installer	(RELEASE)	Fix	some	bugs	in	the
Finale	Inventory	sync	process.	Improved	speed	of	combine-as-cake	for	search	efficiency	related	to	CTO	and	OTC	firing	patterns.	Fixed	the	layout	view	to	show	positions	as	circles,	squares,	or	diamonds	depending	on	whether	they	are	pyro,	DMX	master	fixtures,	or	DMX	slave	fixtures.	Fixed	duration	bug	in	right-to-left	slice	cake	simulations.	Effect
Parsing:	Improve	mortar	flare	and	smoke.finale3d-installer-2022.05.24-b38acc782	(BETA	VERSION)	Fixes	and	improvements	to	Pyromac	V2	script	export.	Vertical	letters	have	option	to	adjust	timing	acceleration	between	rows.	Fixed	fill-down	addressing	bug	wherein	with	backfilling	allowed	and	initial	pin	offset	the	initial	rail	would	not	be	used	for
backfilling.	Added	'Set	track...'	to	context	menu	for	events	on	timeline	and	in	script	window.	Terrain	editing	changes	are	now	saved	in	show	files.	Added	ActionBase	firing	system	support.	Fixed	memory	leak	when	user	changes	language	setting.	Improved	Russian	and	Ukrainian	translations.	Made	default	cue	sheet	report	templates	split	different	pins
onto	different	rows	instead	of	combining	all	firing	at	the	same	time	into	a	single	row.	Highlight	racks	in	red	in	rack	layout	view	if	they	are	directly	on	top	of	other	racks,	to	avoid	confusion.	Add	'Override	Prefire	Column'	to	effect	editor.	Added	FireOne	8-pin	and	4-pin	module	types.	Added	RfRemotech	firing	system	support.	Fix	the	mine	pancake	being
squished	front-to-back	instead	of	top-to-bottom.	Extended	max	show	duration	to	24	hours,	for	SMPTE	users.	Made	'File	>	Import	>	Effects'	support	importing	an	effect	file	into	network	inventories	directly.	Made	position	groups	begin	with	@	character	to	be	more	recognizable	and	differentiable	from	individual	position	names.	Made	'Move-To'	effects
ignore	modifier	effects	like	'With	Gobo'	or	'Safety	Channel'	when	reaching	back	to	connect	to	the	'from'	event;	added	'Modifier'	as	a	new	VDL	term	for	effects	that	are	modifiers	like	'With	Gobo'	and	'Safety	Channel'.	Fixed	but	wherein	resize	pad	was	displayed	in	printed	table.	Adjust	charcoal	trail	tuning.	Added	a	'Leftover	effects'	line	in	the	'Add	racks'
dialog	to	tell	you	if	any	effects	cannot	be	racked	withyour	chosen	racks	on	account	of	their	angles.	Updated	the	PyroDigiT	script	format	and	exporter,	adding	an	'AFC32	Address'	column	whose	value	comes	from	the	Section	field	in	the	script,	and	updating	the	Angle	field	and	Rail	Address	field.	Added	'Addressing	>	Fill	down	addresses	in	script...'
function	for	ShowDirector	style	addressing.	Fixed	'Angle	HPR'	sort	field	option	for	rack	reports,	which	previously	got	stripped	out	when	you	re-edited	a	rack	report	template.	Added	vertical	bar	on	playhead	while	playing.	Fixed	minor	bug	with	control	points	on	racks	in	rack	layout	view	flickering	when	user	drags	selection	box.	Added	support	for	MARQ
Gesture	Spot	100	Moving	Head	DMX	fixture.	Made	DMX	effects	dialog	tell	user	the	name	of	the	catalog	to	subscribe	to	for	the	selected	fixture.	Made	rack	layout	window	automatically	scroll	to	bring	into	view	the	table	row	corresponding	to	the	most	recently	selected	rack.	Added	new	'Angles'	submenu	of	the	'Positions'	menu,	with	options	for	rotating
positions	around	different	axes;	also	added	such	menu	options	to	RMB	context	menu	on	positions.2019.02.12-50df94f9-finale3d-win32-installer	(RELEASE)	Added	ability	for	user	to	make	user-defined	stepper	sequences	for	Galaxis	by	putting	a	track	identifier	in	the	track	column	of	the	script	table.	More	performance	and	stability	improvements	for	new
rendering	method.2018.08.10-f2f3b22d-finale3d-win32-installer	(RELEASE)	Added	32,	64,	128,	and	256	channel	module	versions	of	the	AKM-10	slats	for	the	Pirotex	firing	system.	Added	another	formatting	option	for	durations	in	import	show,	SSFF	for	ShowDirector	imports.	Rearranged	time	tooltips	on	timeline	to	reduce	overlap	of	cue	flags.
Reverted	change	to	ASCII	art	angle	format	in	reports	and	labels	to	the	prior	format	that	showed	all	angles,	like	'\||	-10	-10	0	0'.	Removed	VDL	from	safety	channel	effects	to	make	them	show	up	as	dotted	lines	on	timeline.	Added	new	'Script	>	Tracks'	menu	with	functions	'Set	track...'	and	'Set	track	to	next	available	number...'	and	'Set	track	based	on
groups	sequentially...'	and	'Clear	track'.	Tune	brightness	of	reports	and	salutes	down	a	bit.	Added	position	movement	grid	option.	Fix	charcoal	trail	brightness.2018.10.20-9d7b1adb-finale3d-win32-installer	(RELEASE)	Lots	of	effect	tuning	improvements.	Added	rollover	effect	when	editing	pins	in	rack	layout	view.	Added	support	for	making	the	Korean
UI	translation.	Made	effect	bar	a	solid	gradient	color	(instead	of	black	Fixed	bug	in	Finale	Generic	CSV	export	wherein	'Animation	Description'	column	contained	the	effect	description	instead	of	the	VDL.	Added	Script	>	Set	time...	Added	'Print	>	Diagrams	>	Site	layout'	and	'Print	>	Diagrams	>	Rack	layout'.	Added	new	RJ	Equipamentos	exporter	for
its	new	timecode	based	system.2019.08.26-29350baa-finale3d-win32-installer	(RELEASE)	Added	"File->Admin->Flush	render	caches"	menu	item.	Changed	rack	row	max	tubes	from	32	to	40.	Fixed	random	number	seeds	in	imported	show	files;	fix	is	retroactive,	fixing	existing	shows	that	have	been	imported	from	SCX,	for	example.	Add	effect-
incompatible-with-fixture	error	checking	in	the	addressing	algorithm	to	avoid	possibility	of	bad	addressing.	Made	all	the	clear	address	functions	respect	the	address	'locked'	flag.	Fix	long	exposure	bug.2019.04.16-9ec7557b-finale3d-win32-installer	(RELEASE)	Fix	emitter	randomness	to	be	more	random.	Fixed	bug	that	move-to	DMX	events	near	the
beginning	of	a	track	could	cause	track	to	start	with	an	offset	if	semi-auto	firing.	These	sort	terms	enable	user	to	sort	flights/chains	that	have	multiple	angle	shots	as	first	or	last	to	be	assigned	addresses,	which	is	useful	if	you	want	to	cross-load	fan	chains	across	racks	while	still	straight-loading	single-angle	chains	along	single	racks	length-wise.	Fixed
vertical	alignment	problem	with	Russian	character	set.	Added	labels	templates	for	sorting	by	size,	part	number,	or	position,	in	all	labels	sizes,	39	new	options.	Prevent	loading	duplicate	FDB	effects	files.	Added	'Subtype'	as	an	optional	script	table	column,	referencing	the	effect	field.finale3d-installer-2022.01.22-dbe1d48cf	(BETA	VERSION)	Added
ability	to	make	'Notes'	column	a	filter/selector	in	the	table	windows.	Implement	first	version	of	new	flame	simulation.	Added	'Scenery	>	Background	images	>	Set	ground	tile	image'	to	replace	grass	with	custom	texture.	Fixed	minor	bug	in	sequence	dialog	info	message.	Changed	header	for	Megafire	exporter.	NOTE:	This	SketchUp	model	change	will
cause	models	in	saved	.fin	files	to	appear	at	a	different	position	in	the	scene.2017.10.12-4bd67fd0-finale3d-win32-installer	(RELEASE)	Decrease	wind	'microcurrents'	when	wind	speed	is	low.	As	a	workaround	you	could	also	change	the	effect's	type	to	'sfx'	bug	the	workaround	is	no	longer	necessary	with	this	release.finale3d-installer-2021.07.08-
dc3dcf182	(BETA	VERSION)	Updated	Russian	UI	translation.	Fix	bug	that	copy/paste	effects	from	a	single	position	should	paste	into	whatever	positions	are	selected,	not	always	to	the	copied-from	position.	Fix	titanium	salutes.	Supported	cross-loading	chains	with	fanned	shells	across	racks	in	the	same	cluster	using	the	'pin-constrained-to-same-rack-
cluster'	constraint.	Added	'Script	>	Align	>	Align	at	earliest	event	time'.	Updated	German	and	French	UI	translations.	Reduced	number	of	window	arrangement	presets	to	three	and	added	three	slots	for	custom	window	arrangement	presets	that	are	saved	in	user	settings.	Minor	UI	fix	that	if	you	right	click	on	a	position	for	context	menu,	it	becomes
selected.	Make	alpha	blurb	not	overlap	effect	tree.	Added	'Move	on	axis...'	command	and	widget	for	moving	positions.	Fix	bug	with	updating	a	Finale	Inventory	product	when	the	Finale	Inventory	distance	unit-of-measure	is	not	meters.	Added	XZ	ruler	to	origin	when	moving	a	single	position.	Fixed	'Update	durations'	dialog	bug	wherein	dialog
appeared	even	if	no	editable	duration	effects	were	selected.	Removed	the	'Select	similar'	options	since	the	yellow	position	flowers	serve	the	need	for	positions.	Effect	editor:	Fix	broken	spark	intensity	slider.	Fix	some	other	inventory	sync	issues	related	to	specific	columns	not	updating	correctly.	Implement	'Available	Column	Does	Not	Include
Unreceived	Purchase	Orders'.	Added	right-click	context	menu	option,	'Measure	to	this	point.'	Added	'Adjust	heights	when	dragging	multiple	positions'	option,	defaulting	to	on,	which	is	the	current	behavior,	but	giving	you	the	ability	to	turn	it	off	for	some	complicated	position	layout	scenarios	involving	trusses.2019.06.13-60e00c14-finale3d-win32-
installer	(RELEASE)	Added	1-second	options	for	Script	>	Align	functions.	Added	support	for	Thomann	Fun	generation	LED	Pot	12X1W	RGBW	fixture.	Change	playback	mode	target	framerate	from	10.0	to	0.0.	Added	FirePioneer	firing	system.	Added	option	in	'Show	>	Per-user	settings...'	to	use	flat	colors	for	timeline	waveforms	instead	of	the	new
gradients.	Scale	video	bitrate	with	the	size	of	the	movie	being	rendered,	and	increase	the	bitrate	defaults.	This	encoder	produces	better	quality	output	files	that	are	smaller,	but	it	is	a	little	bit	slower	than	the	old	encoder.	Changed	timeline	effect	bar	extension	colors	from	blue/green	to	red/blue	based	on	trajectory	angle,	red	=	right.	Fix	bug	causing
uninitialized	data	(apple	banana	etc)	to	appear	in	the	render	resolution	selector	when	rendering	a	movie.	Added	'Scrit	>	Time	adjustments	>	Re-align	cues	on	event	time'	to	convert	cues	of	multiple	effects	alignted	by	their	effect	time	to	having	the	same	event	time,	for	pin	board	shows.	Updated	Ukrainian	and	Russian	UI	translations.	Added	glowy
green	box	around	reference	position	for	rulers,	chosen	from	the	position	context	menu.	On	timeline,	make	shift-dragging	a	selection	rect	begin	by	deselecting	all,	instead	of	adding	to	selection	set.	Made	effect	chooser	sort	by	part	number	as	secondary	sort	criterion,	after	most-recently	used.	Added	'Images'	menu	and	functions	to	manage	images	as
assets	used	by	the	show.	Removed	the	feature	that	automatically	changed	the	selected	effects	collection	to	one	having	racks	or	effects.	Improved	addressing	summary	messages	for	DMX	scripts,	better	pin	counts.	Improve	hit	detection	for	clicking	position	names	by	sorting	them	back	to	front.	Fixed	the	Italian	and	Portuguese	'e'	in	effect	name	parsing.
Fixed	bugs	and	added	support	in	the	'Add	Racks'	dialog	for	handling	racks	from	different	collections	that	have	conflicting/same	part	numbers.	Added	gear	button	for	customizing	tables.	Make	pasting	breakpetals	and	launches	allocate	new	random	group	ids.	Added	Pirotex	1ms	10	Pin	Module	module	type.	Improved	rack	assignment	algorithm	for
chains	to	support	constraints	that	prevent	chains	from	spilling	over	to	another	rack	or	rack	cluster.	Added	'File	>	User	settings	>	Reverse	tube	loading	order	on	alternating	racks'	which	applies	when	you	add	racks	with	'Racks	>	Add	racks	for	show'.	Fixed	'Addressing	>	Clear	all	addresses'	which	previously	just	cleared	slected	events'	addresses.
Added	support	for	DMX	fixture	High	End	Uno	Moving	Head	Spotlight.	Improved	position	lock	icon	tooltip	appearance.	Added	addressing	constraint	options	for	FLIGHT-COUNT,	FLIGHT-OR-NOT,	PAIR-OR-NOT,	ANGLE-OR-NOT.	Fixed	the	bug/limitation	that	the	addressing	functions	were	previously	unable	to	assign	multiple	chains	to	the	same	pin.
Changed	the	two-part	hotkeys	that	began	with	control-letter	to	begin	with	control-digit;	most	had	already	been	changed	a	long	time	ago	but	there	were	some	in	the	scenery	drawing	submenu	among	other	places.	Added	Galaxis	20	channel	split	box	module	types.	Made	labels	print	angle	graphics	for	up	also,	instead	of	leaving	up	as	blank.	Include	items
with	blank	'Type'	fields	in	the	'Other	effects'	division	of	the	effect	palette.	Implemented	ghost	shells.	Fixed/improved	handling	of	minimized	windows.	The	vdl	parser	is	not	yet	making	effects	that	use	this	feature,	but	it	will	soon	for	transition	stars.	Added	drag-and-drop	to	event	trajectories	in	design	view.	Changed	a	few	hot	keys	so	common	functions
would	have	convenient	hot	keys.	Added	'Effects	>	Edit	effect',	to	re-edit	the	VDL	of	an	existing	effect.2018.01.23-0398fc48-finale3d-win32-installer	(RELEASE)	Allow	imported	prefire	and	duration	times	to	include	trailing	characters	like	's'	as	in	3.2s;	previously	that	wouldn't	parse	because	of	the	's'.	Added	degrees	symbol	to	angle	graphics	on	labels.
Fix	Brazilian	Portuguese	language	detection.	Improved	'Rename	positions'	dialog;	pre-populate	text	entry	field	with	existing	name	or	name	stem	from	collection.	Please	email	the	staff	at	Finale	if	you	have	(non-moving)	DMX	stage	lights	that	you	would	like	Finale	to	include	as	standard	effects.	Fixed	some	minor	specs	of	some	of	the	cakes	in	the	generic
effects	collection.	Fix	crash	bug	in	the	effect	preview	popup	when	you	hover	over	an	icon.	Finale3D	becomes	responsive	earlier,	and	shows	'Initializing	3D	graphics'	rather	than	pausing	for	as	long	as	it	used	to.	Added	warning	--	'Added	dummy	cue	for	zipper	fire	at	beginning	of	macro'	when	fix	is	applied,	to	avoid	confusion	about	where	the	dummy	cue
came	from.	Fix	prefire	and	duration	bugs	of	several	effect	types.2017.11.08-262388c5-finale3d-win32-installer	(RELEASE)	Added	'Backfilling	allowed'	checkbox	to	'Fill	down	addresses'	dialog	to	allow	user	to	turn	off	backfilling	and	force	a	strictly	monotonic	sequence	of	addresses.	Collection	of	changes	to	the	PyroMaster	exporter.	Fix	bug	parsing
begin/end	time	for	movie	rendering.	Added	Avery	5163	labels	template.	Added	Pyroleda	F3	firing	system	option	for	2	x	16	pin	slats,	and	added	technical	documentationfor	Pyroleda	in	the	documentation	section.	Added	annotations	to	the	rack	properties	window.	Reversed	timeline	zoom	in/out	icons.2018.04.30-a28b8d6e-finale3d-win32-installer
(RELEASE)	Made	Finale	Inventory	integration	work	more	like	Business	--	when	inserting	effect,	automatically	derive	vdl,	size,	duration,	prefire,	height,	subtype,	color,	type,	numDevices	if	they	are	missing	fields.	Tweak	cake	timing	randomness	so	that	it	won't	re-order	shots.	Added	'File	>	User	settings	>	Click	action	for	rows	on	other	windows'	in
addition	to	the	option	for	click	action	on	the	effects	window,	allowing	you	to	change	the	user	interface	so	single	click	selects	the	row	instead	of	the	cell.	Simply	set	the	Position	Type	in	the	DMX	fixture	configuration	dialog	to	'DMX	Fixture	(Slave)'	instead	of	'DMX	Fixture	(Master)'	and	set	the	DMX	Universe	and	DMX	Channel	Base	to	match	a	master
DMX	fixture	position.	Save	current	view	point	along	with	show,	and	restore	it	when	loading	show.	Added	hot	keys	for	rack	functions	in	context	menus.	Added	option	in	'Show	>	Per-user	settings...'	to	turn	off	timeline	cue	flags.	Added	capability	to	export	Parente	Firemaster	beep	tracks,	using	the	export	voice	cues	feature	and	selecting	the	Firemaster
beep	and	proper	lead	time.	Fix	bug	causing	the	Finale	Inventory	'selected	locations'	filter	to	not	work.	Added	16-pin	slat	option	for	fireTEK.finale3d-installer-2021.02.19-5bd16c23c	(BETA	VERSION)	Updated	all	DMX	related	documentation	and	example	files	to	reflect	the	change	that	DMX	Channel	Base	should	now	be	set	to	match	the	DMX	fixtures
Start	Channel	in	the	real	world	--	no	longer	subtract	one.	Added	fixture	definition	for	U	'King	RGBW	moving	head	fixture	light'.	Added	type	variations	of	Reverse	Size	addressing	sort.	Added	rotation	widget	for	rotating	positions.	Added	snap-suppression	for	dragging	effects	on	the	timeline	when	user	holds	shift	while	dragging;	items	dragged	while
holding	shift	will	not	snap	to	nearby	other	items.	Added	'Script	>	Replace	>	Replace	with	selected	effect	from	effects	window'	and	hot	key	'Y',	which	is	a	really	fast	UI	for	replacing	effects.	Made	chains	import	more	reliably	when	importing/hopening	HBS	show	files,	less	chance	of	simulation	being	invisible.	Implement	'Count	chains	as	1	unit'	in	Finale
Inventory	integration	Fix	crossette	timing.2018.02.07-3b29ae9e-finale3d-win32-installer	(RELEASE)	Made	effect	duration	a	reference	to	the	effect	definition,	instead	of	a	copied	value	that	can	be	updated	in	the	script,	because	the	latter	caused	too	much	confusion.	Simplified	racks	and	addressing	menus	for	Hobbyist	and	Pro.	Fix	'http	code	said	error'
bug	when	Finale	Inventory	credentials	are	invalid.	Improved	importing	HBS	cakes	by	converting	0.05s	duration	fan	rows	to	all-at-once	rows,	correcting	a	limitation	in	Finale	Business	firing	patterns.	Moved	playhead	time	indicator	to	bottom	of	timeline	to	avoid	overwriting	cue	flags.finale3d-installer-2020.03.07-2d5a032c8	(RELEASE)	Changed	CSV
firing	system	format	slightly	to	make	it	import	easier,	changing	column	name	Delay	to	Prefore.	Changed	playhead	indicator	in	script	table	window	to	be	a	red	line	between	last	and	next	row	to	play.)Fixed	bug	in	dom	renderer	relating	to	inner	borders.	Improved	stability	on	slow	GPUs.	Added	a	'Setup	By	Position	Finale	Business	Format'	report,	which
is	the	same	as	the	site	layout	tables	report	in	Finale	Business.	Changed	menu	item	'Sort	racks	left	to	right'	to	'Renumber	racks	left	to	right'	and	changed	'Move	racks	to	last'	to	'Renumber	racks	as	last,	after	all	others'.	Changed	scrollbars	to	page	up/down	when	clicked	in	track	area	above	and	below	thumb	instead	of	moving	to	clicked	position,	unless
shift	key	held,	which	produced	previous	behavior.	Improved	'Combine	as	cake'	row	length	interpretation	of	cakes	with	irregular	gap	before	last	row.	fixed	hit	testing	area	in	timeline	below	the	circle	buttons	of	the	3D	view.	Fix	bug	where	fountains	always	shot	straight	up.	Simplified	the	right-click	context	menus	by	removing	the	'Filter	to	>=,	Added
'Why	is	this	tube	red?'	function	on	right-click	context	menu	when	you	click	on	a	rack	in	the	rack	layout	view,	to	explain	what	the	error	is.finale3d-installer-2020.08.06-c32e047a3	(RELEASE)	On	startup,	set	the	Finale3D	language	setting	to	be	the	same	as	the	user's	system	UI	language.	Changed	addressing	summary	dialog	to	report	'wiring	errors'	and
'racking	errors'	separately.	Add	to	the	rack	selector	menus	in	the	racks	dialog	all	the	racks	that	would	be	compatible	were	it	not	for	a	mismatching	Rack	Type.	Added	'2D	Lock'	mode	option	in	design	view,	which	moves	all	position	names	down	into	a	ribbon	at	the	base	of	the	view,	changes	click-drag	above	ribbon	to	be	selection	rect	without	requiring
the	shift	key,	and	changes	click-drag	in	the	ribbon	to	be	scroll	horizontally.	Made	'Create	effect/rack/chain/cake	VDL'	not	overwrite	Description	field	if	updating	VDL	of	an	existing	effect.	Added	'Distance	unit'	to	CSV/XLS	exported	from	'File	>	Export	>	Export	effects	for	importing	into	Finale	Inventory...'	Added	warning	when	exporting	a	script	with	a
firing	system	script	export	offset,	to	prevent	the	possible	accident	of	forgetting	about	an	offset	previously	setup	in	the	'Show	>	Show	information...'	dialog.	Added	'Auvi	Spark'	fixture.	Added	hot	area	at	bottom	edge	of	timeline	for	dragging	selection	rects	without	holding	shift.	Added	single-shot	rack	type	for	tubes	that	have	adjustable	pitch	angle	but
not	tilt	angle	within	the	row.	Fix	a	bug	where	certain	star	transitions	would	cause	the	stars	to	'jump'	in	space.	Fixed	several	related	crashes	in	building	some	customized	effect	parameters.	Added	'Edit	rack	properties'	in	right	click	context	menu	on	rack	table	in	rack	layout	window.	Added	new	function	for	positions,	'Project	positions	on	local	down	axis
to	nearest	surface'	to	make	it	easier	to	place	positions	on	towers.	Change	'Render	quality'	to	'Render	Settings'.	Enhanced	copy/paste	to	support	the	following	use	case:	copy	events	from	multiple	positions	A,	B,	C,	and	paste	into	a	different	set	of	selected	positions	X,	Y,	Z.	Fix	bug	causing	expired	licenses	to	work	when	they	should	not.	Improved
exporting	summary	messages	for	DMX	exports,	better	pin	and	module	counts.	Added	automatic	rack	annotations	for	each	rack	part	number	group	added	by	the	'Racks	>	Add	racks	for	show'	function.	Added	DMX	support	for	Froggy's	Fog	Hyperion	D6	fog	jet,	and	U	King	Two-Bar	Spider	light,	and	Tengchang	Party	Fog	Jet.	Fix	shot	simulator	hanging
bug	in	handling	of	'invalid'	life	times	coming	from	parts	table.	Re-enable	fancy	motion	paths	(rising	whirls,	etc)	for	high	quality	and	ultra	quality	modes.2018.05.30-70e39ed7-finale3d-win32-installer	(RELEASE)	Added	'Fuse	Delay'	field	to	effects	window,	to	hold	the	visco	fuse	delay	for	cakes;	when	an	effect	is	added	to	the	show,	its	fuseDelay	gets
copied	to	its	'Delay'	column	in	the	script.	Auto-close	sync	dialog	when	the	initial	login	sync	completes	successfully.	Added	'Change	this	effect	angle	to	match	rack'	on	the	rack's	context	menu	in	rack	layout	view,	for	fixing	effect	angles	to	match	the	racks.finale3d-installer-2020.06.25-77609bc71	(RELEASE)	In	rack	layout	view,	the	tooltip	for	the	effects
now	shows	both	the	tilt	and	pan	angles	if	the	pan	is	not	the	default	value,	to	help	make	it	understandable	if	the	angle	of	the	rack	appears	to	match	the	tilt	of	the	effect	yet	the	effect	is	still	red	because	of	pan	mismatch.	Updated	standard	report	templates	that	filter	out	items	without	firing	system	addresses	to	filter	based	on	pin	field	instead	of	type
field,	so	they	don't	get	confused	by	dummy	cues.	Added	option	in	reports	configuratin	to	turn	off	'Clear	redundant	cells'	and	made	this	option	the	default	for	all	reports	except	chain_specifications	report;	without	this	option,	the	left-most	cells	in	report	rows	are	cleared	if	they	are	the	same	as	the	row	above,	which	some	people	think	makes	the	reports
easier	to	read	but	others	hate.	Added	user	setting	for	to	make	rack	layout	default	to	smallest	racks	first,	instead	of	largest	first.	Made	clicking	the	rail/module	number	below	the	rail	in	the	rack	layout	view	not	report	a	conflict	if	setting	it	to	its	existing	value,	which	has	the	sometimes	useful	side-effect	of	selecting	all	events	addressed	to	that	rail.	Added
a	test	for	module	overflow	conflicts	in	the	'Re-address'	link	on	the	rack	layout	view	to	catch	the	scenario	of	accidentally	re-addressing	a	position	and	spilling	over	to	use	modules	that	conflict	with	other	position's	addresses.	Added	ability	to	set	the	'Limit'	for	the	number	of	each	type	of	rack	you	are	adding	to	the	show,	in	the	'Add	racks'	dialog.	Fixed
fancy	size	based	colors	with	outline	on	labels.	Fixed	Cobra	exporter	for	long	DMX	durations,	changing	format	to	include	minutes	instead	of	just	seconds.	Changed	meaning	of	W-shape	to	mean	TRS	instead	of	TRI,	i.e.,	a	sequence	instead	of	all	together.	Updated	German,	Hungarian,	Norwegian,	and	Brazilian	Portuguese	translations.	Made	the	new
copy/paste	enhancement	work	for	copying	between	shows	also.	Improved	rack	layout	tooltiops.	Improved	colors	and	readability	of	effect	palette	text.	Improved	'Randomize'	to	take	into	account	the	number	of	undoable	operations	in	the	session	as	part	of	its	random	number	seed,	so	repeatedly	randomizing	will	no	longer	get	stuck	in	cycles	yet	will	still
be	deterministic,	i.e.,	if	you	undo	and	repeat	the	operation	you	will	get	the	same	result.	This	is	because	all	of	the	data	really	has	changed	and	needs	to	be	synced	to	the	server.	Effects	edited	with	older	versions	should	work	fine	in	this	release,	but	you	may	have	trouble	editing	them	with	this	release.	Added	option	in	rack	layout	report	configuration,
'Show	rack	numbers'.	Made	it	possible	to	drag-and-drop	patterns	of	effects	in	design	view	from	multiple	positions	to	multiple	possitions,	without	collapsing	the	pattern	onto	a	single	position.	Tune	scattering	effects.	Added	'Crackling	Chrys'	shells	to	generic	effects.	Improved	copy/paste	for	positions	in	a	few	edge	cases.	Improved	the	'Add	racks'	dialog
UI	in	cases	that	user	selects	the	same	fits-any-size	rack	for	multiple	SS	sizes/rows	in	the	dialog,	now	allocating	all	effects	top	down	in	the	dialog	to	make	it	more	understandable	in	tricky	situations.	Updated	the	standard	catalog	file	for	the	new	fields,	and	added	more	color	variety.	Added	explanation	dialog	to	prevent	user	from	trying	to	edit	VDL	of
chain	after	it	has	been	inserted	into	the	show.	Added	checkbox	for	'Use	values	from	default	addressing	blueprint'	on	'Readdress'	dialog	for	re-addressing	a	single	position	from	the	rack	layout	view.	Fix	bug	with	accessing	Finale	Inventory	inventories	that	were	created	for	Finale	Business	master	inventory	accounts.	Fixed	bug	that	caused	effect	editor
to	pause	for	long	periods	of	time.finale3d-installer-2021.07.14-11fe7c57b	(BETA	VERSION)	FINALE	INVENTORY	USERS:	Moved	'Finale	Inventory'	submenu	from	the	'Effects'	menu	to	the	'File'	menu.	Updated	Russian	UI	translation	Updated	Brazilian	Portuguese	UI	translation.	Fix	for	SLV	in	Pyroleda	exported	scripts.	Implement	'double-checking'
inventory	change	confirmation	on	>=50	rows.	Fixed	fill-down	sorting	when	addressing	constrainted	by	positions	and	sorted	first	by	something	other	than	position.	Fixed	Pan180/Mirror	bug	for	slave	fixtures	for	animated	moving	head	effects.	Tune	'thick'	and	'very	thick'	to	be	bigger.	Sorted	items	alphabetically	in	gear	menu	>	'Hide	or	unhide	column'
and	gear	menu	>	'Add	or	remove	filter'.	Added	'Edit	rails'	and	'Add	rail'	links	to	the	rack	layout	screen	to	add	or	manage	the	position's	'Pre-Assigned	Rails'.	Added	additional	'Script	>	Align	times	to	frame	rate'	options.	Added	drag-and-drop	from	parts	window	to	rows	of	script,	for	replacing	effect.	Fixed	minor	UI	bug	when	cloning	racks	in	rack	layout
window	with	control-click-drag,	previously	the	drag	point	would	be	offset.	When	duration	bars	on	the	timeline	are	turned	off,	showing	only	the	blips,	the	hit	test	area	now	shrinks	to	the	blip.	Fixed	the	redundant	printing	of	the	word	'single	shot'	and	'1	shot'	in	the	VDL.2018.05.11-e20f8fbd-finale3d-win32-installer	(RELEASE)	Fix	bug	with	Finale
Inventory	integration	not	correctly	handling	case	packing	quantities.	Improve	download	effect	icons.	Fixed	the	'Create	position	groups	manually'	setting,	which	was	preventing	the	green	plus	button	from	creating	position	groups	also.	Now	possible	to	edit	effects	in	any	collection	(generic,	My	Effects,	etc.)	and	changes	will	write	through	to	My	Effects
and	open	shows,	after	confirmation	dialog.2018.05.03-6b2d46db-finale3d-win32-installer	(RELEASE)	Fixed	but	when	dragging	selection	or	playhead	off	right	edge	of	timeline	when	timeline	overextended.	In	addition	to	preserving	table	layouts	of	script	and	effects	when	switching	between	shows	or	openingor	creating	a	show,	also	preserve	table
layouts	of	positions	window,	keyframes	window,	and	racks	window.	Added	rounded	corners	to	tooltips.	Make	par	light	and	spotlight	show	effect	type	of	'light'	instead	of	'ground'.	Added	optional	columns	to	effect	window	for	remaining_quota,	remaining_available,	and	remaining_on_hand.	Added	VSS	firing	pattern	to	VDL,	meaning	a	sequence	of	nested
Vs.	Added	TRS	firing	pattern	to	VDL,	meaning	a	sequence	of	nested	Ws.	Changed	meaning	of	V-Shape	to	mean	VSS	instead	of	VST,	i.e.	a	sequence	instead	of	all	together.	Fixed	import	of	Finale	Generic	CSV	of	effects	with	placeholder	VDL	that	showed	up	importing	as	variegated	peonies.	Added	consolidation	field	in	blueprints,	which	enables	arbitrary
combining	of	rows	based	on	matching	fields	like	module/pin,	for	reports.	Re-purposed	the	first	blue	nav	button	as	the	new	selection	rect	mode	nav	button,	and	made	the	default	pointer	mode	be	represented	by	none	of	the	blue	nav	buttons	being	pressed.	Made	'Add	racks'	dialog	show	rows	for	all	calibers	in	any	section	with	any	racks,	rather	than
filtering	to	just	the	calibers	with	required	racks,	to	make	it	easier	to	understand	what	is	going	on	in	complex	situations	involving	fits-any-size	racks.	Allow	Intel	HD	4000	to	try	to	run,	to	see	if	it	works	on	some	machines.2018.08.30-d433f8d1-finale3d-win32-installer	(RELEASE)	Make	spinners	only	emit	trail	sparks	after	they	enter	the	'crazy	spin'
phase.	Made	timeline	bars	that	have	no	VDL	such	as	'With	Gobo'	and	'With	Strobing'	and	'Safety	Channel'	appear	as	dotted	lines	instead	of	solid	lines	so	they	don't	obscure	the	timeline	bars	of	effects	on	the	same	fixture	that	they	apply	to.	Improved	'Update	translation	file	for	missing	phrases...'	by	making	it	ignore	errors	in	NON-MATCHING	lines.
Fixed	bug	saving	the	new	addressing	sort	terms	in	blueprints.	Make	login	retry	when	there	is	a	failure,	rather	than	just	exiting	the	program.	Fixed	addressing	constraint	bug	wherein	the	'Group'	constraint	didn't	work	well	with	chains	unless	you	put	individual	chains	into	their	own	groups.	Changed	terminology	'Background	image'	-->	'Backdrop



image'.	Improved	label	formatting	for	addresses.	Added	reports	for	product_list_by_position,	product_list_by_storage_location,	product_list_by_storage_location_with_addresses,	product_list_by_storage_location_with_positions.	Fixed	minor	bug	wherein	if	you	close	all	shows,	leaving	windows	blank,	and	then	open	a	show,	its	script	window	table	layout
would	appear	with	all	columns	unhidden	instead	of	the	default	table	layout.	Made	effect	simulations	start	after	the	'Delay'	field	in	the	script	row,	to	implement	visco	fuse	delays	correctly.	Improved	timeline	UI	for	grouped	effects	involving	Move-To	effects)*	Fixed	some	of	the	cake	assembler	tests	Added	option	in	effect	macro	dialog	to	make	macro
always	apply	to	recorded	positions	no	matter	what	positions	are	selected.	Fixed	bug	in	'Script	>	Align	>	Align	event	times	to	resolution	wherein	the	alignment	wouldn't	preserve	the	spacing	in	a	chain.	Added	additional	fields/columns	to	rack	layout	table	to	support	rack	layout	based	reports.	Fixed	undo	bug	wherein	undoing	after	'Combine	as	chain'
left	a	residual	chain	delay	in	the	unchained	items.	Update	Chinese	UI	translation,	now	complete.	Please	no	longer	subtract	1	when	setting	'DMX	Channel	Base'.	Added	'Scenery	>	Set	window	to	standard	aspect	ratio...'	as	an	alternative	to	render	settings	because	it	is	such	an	important	feature	for	using	background	images.	Made	cake	combiner
function	automatically	replace	plus	signs	with	ampersands	in	the	effect	descriptions	being	combined	since	extraneous	plus	signs	mess	up	cake	syntax.	Extend	VDL	language	to	include	an	'exact	simulation	syntax	row	description'	for	cakes	that	is	able	to	represent	arbitrary	timing	and	angles	of	shot	to	a	resolution	of	1ms	and	1	degree,	and	make	cake-
combiner	function	fall	back	to	using	this	exact	simulation	syntax	automatically	when	the	standard	syntax	doesn't	work	well.finale3d-installer-2021.10.22-5485fc340	(BETA	VERSION)	Added	'Load	into	racks'	button/function	to	the	rack	layout	window,	enabling	user	to	load	items	into	racks	after	then	have	firing	system	addresses.	Fixed	a	bug	with	the
'Rack	Number'	sort	field	option	in	the	assignment	order	paragraph	of	the	addressing	dialogs.	Revamped	the	'Make	into	sequence'	dialog	and	added	more	patterns	--	progression	in	pairs,	and	center	to	outside	alternating.	Improved	performance	of	movie	rendering.2017.11.16-4d2c1e35-finale3d-win32-installer	(RELEASE)	Improved	performance	and
visuals	on	icon	rendering.	Added	FireByWire	exporter.	Also	added	the	option	to	apply	multiple	effects	toward	multiple	cycles	of	the	sequence,	and	a	similar	option	to	make	multiple	cycles	of	the	sequence	bouncing	back	and	forth.	This	should	reduce	encoding	artifacts	in	the	output	videos.2018.11.27-e2a28c57-finale3d-win32-installer	(RELEASE)
Added	Portuguese	effect	name	translations.	Fix	effect	editor	panels	text	input	layout	issue	Updated	Hungarian,	Polish,	Brazilian	Portuguese	translations.	Added	DMX	script	optimizers	for	fireTEK,	Piroshow,	Pyromac,	and	PyroSure.	Slightly	improved	format	of	'Combine	as	cake'	output	by	removing	excess	timing	information.	Added	support	for
Romanian	character	set,	ISO88259-2.	Support	'h'	as	shorthand	for	'hours'	when	entering	a	duration	such	as	show	duration,	e.g.,	typing	'20m'	=	20	minutes;	typing	'20h'	=	20	hours;	typing	1.5h	=	90	minutes.	Improved	positions	menu	structure	and	options.	Added	Merlin	exporter.	Fix	an	access	level	bug	where	people	who	had	an	extra	machine	license
but	no	initial	product	license	would	get	into	a	bad	state.	Fixed	a	bug	in	the	'Add	racks	for	show'	dialog	that	caused	the	effect	count	fields	to	be	zero,	even	though	the	correct	number	of	racks	was	counted	and	added.	Fix	colorized	material	loading	in	SketchUp.finale3d-installer-2020.08.16-a1a595bb0	(BETA	VERSION)	Further	adjustment	to	the	printed
format	of	'Angles*',	now	printing	multiple	SAME-angles	with	the	standard	angle	ASCII	character,	and	only	printing	the	asterisk	ASCII	character	if	multiple	angles	that	are	DIFFERENT.	Import	weight	and	NEQ	properties	when	importing	effects	file.	Fixed	copy/paste	bug	wherein	copying	events	from	one	position	and	pasting	to	other	selected	positions
didn't	work.	Fixed	show	import	bug	wherein	tilted	roman	candles	and	cakes	came	in	with	the	wrong	angles.	Added	'Pre-Wired	Rails'	field	on	racks	as	a	column	in	the	table	below	the	rack	layout	view,	enabling	user	to	constraint	individual	racks	to	any	of	the	positions	'Pre-Assigned	Rails'.	Improved	column	resizing	user	interface	on	tables.	Made
parentheses	equivalent	to	space	in	effect	names.	Removed	the	UI	links	and	palette	from	printed	rack	layout	diagrams.2018.09.10-41fed11a-finale3d-win32-installer	(RELEASE)	Added	functionality	for	Supplier	Catalogs	to	show	up	in	parts	list.	Enhanced	Galaxis	exporter	to	adjust	G-Flame	times	to	provide	the	minimum	0.3sec	time	separation	between
successive	shots	on	the	same	device,	and	to	provide	a	warning	dialog	if	necessary	at	time	of	export.	Round	times	in	FireOne	FIR	exporter	to	hundredths	to	remove	warnings	when	opening	in	FireOne	software.	Added	Pyrodigit	racks	supplier	catalog.	Fixed	recently	introduced	bug	parsing	effects	with	heights,	misinterpreting	that	as	count	of	mines,
e.g.,	'Cake	10	m'.	Made	'Combine	as	cake'	interpret	13	shot	cakes	as	single	slice	by	default.	Tighten	up	shot	randomness	for	everything.	Added	'Display	addresses	with	dash	between	rail	and	pin'	option	for	ShowDirector/PD	users	to	uncheck	to	see	addresses	as	a	simple	three	digits.	Changed	'C-shape'	cakes	from	FNT	rows	to	CTO	rows.	Made	the
position	rulers	only	appear	when	positions	are	unlocked.	Fix	broken	installer	shortcuts	on	the	Desktop	and	Start	Menu.	Added	additional	French	misspellings	of	pot-au-feu	to	VDL	parser.	Added	'Positions	>	Adjust	>	Straighten	positions	in	line'	function	that	does	just	that.	Added	'Edit	this	rack	VDL'	contxt	menu	item.	Previously	these	consolidation
options	would	default	to	off	and	the	user	would	need	to	switch	them	on	from	the	blue	gear	menu	on	the	script.	Added	conditional	formatting	based	on	ematch	count,	angle	direction,	and	effect	size.	Synchronize	clicking	sound	effect	for	angling	trajectories	with	graphics	updates.	Fixed	Generic	effects	cake	GCK1034.	Changed	default	settings	for
importing	background	images	to	show	the	image	under	the	ground,	making	the	grass	invisible.	Made	report	configuration	dialog	include	sort	criteria.	Improved	the	'Fixture	Type'	field	of	the	position	properties	and	'Configure	position	as	DMX	fixture'	dialogs	to	include	user-defined	fixtures	from	all	supplier	catalogs	and	other	effect	collections.
Changed	drag-and-drop	to	timeline	and	to	cue	on	timeline	to	insert	effects	at	selected	positions	at	the	indicated	time;	formerly	drag-and-drop	only	replaced	an	event	or	cue.	Fixed	numDevices=0	bug,	where	exported	Finale	Generic	CSV	files	would	have	numDevices=0	if	the	effect	in	the	effect	window	/	inventory	had	a	numDevices	=	blank	value.	Fixed
minor	table	update	bug	when	undoing	a	change	to	the	show	setting	for	effect	time	format.	'FireOne	32	Pin	Module	(FIR)',	the	options	have	now	been	removed	from	the	module	types	since	they	are	now	specified	in	the	export	options	dialog	instead.	Made	the	default	part	number	for	a	new	effect	created	with	control-G	avoid	collisions	with	part	numbers
in	any	open	show.	Added	support	for	Le	Maitre	Salamander	flame	fixture,	and	added	standard	effects	for	it	in	the	Assorted	DMX	Effects	downloadable	catalog.	Fixed	filtering	problem	with	position	names	that	contained	slash	characters.2019.08.12-d4db8335-finale3d-win32-installer	(RELEASE)	Fix	crash	error	with	certain	pattern	breaks.	Added	Fire
Control	G2	exporter	including	pd,	f1,	and	fm	modules	and	dmx.	Support	Cobra	pulseTime	field.	Improved	'Delete	songs'	function	to	work	even	if	no	songs	are	selected.	Added	'Camera	>	Display	camera	coordinates'	as	a	Pro	feature	that	pops	up	current	camera	coordinates	in	a	dialog.finale3d-installer-2022.03.04-17f392d5c	(BETA	VERSION)	Fix	effect
editor	window	closing	bug.	Automatically	switch	to	the	collection	that	contains	racks	used	in	the	show	when	switching	to	rack	layout	view,	shift-3.	Added	'on	hand'	and	'available'	columns	to	the	parts	windows	for	inventory	quantity.2018.01.17-70979f55-finale3d-win32-installer	(RELEASE)	Fixed	addressing	bug	with	empty	cues.	Add	whistles,	Made
the	rack	length	constraint	apply	to	the	calculation	in	'add	racks	for	show'	just	as	it	does	for	addressing	and	red	warnings	in	rack	layout	screen.	Reduce	GPU	memory	usage	by	about	40%.2019.08.19-24d5567e-finale3d-win32-installer	(RELEASE)	Clear	the	temp	attribute	after	writing	zip-based	file	formats	so	that	some	backup	programs	(e.g.	Carbonite)
don't	skip	files	written	by	Finale3D.	Improved	UI	for	moving	positions;	made	shift	key	constraint	position	movement	to	axes.	Added	large	playback	clock;	added	option	to	turn	it	off	in	show	>	options	menu.	Added	'File	>	User	settings	>	Set	timeline	right	edge	editing	margin.	Added	text	wrapping	option	for	label	fields.	Naming	change	'Basic	parts'	-->
'Generic	effects'.	First	end-to-end	working	customizable	reports.	Minor	improvements	to	blips-only	mode	on	timeline	when	used	in	combination	with	the	xray	mode.	Updated	Russian	user	interface	translation.	Changed	paste	in	design	view	to	be	symmetric	with	cut:	cutting	positions	includes	subtree	of	events;	pasting	pastes	back	the	cut	or	copied
events	and	positions.	Made	position	rotate	functions	in	menus	automatically	unlock	positions	and	show	tooltip	indicating	the	change	if	they	had	been	locked	previously.	Added	'Beginning	with	module	number	[]'	option	on	addressing	dialog,	making	it	easy	to	begin	addressing	for	the	show	at	any	module	number.	Added	Pyrodigy	exporter.finale3d-
installer-2021.07.26-4e2c55a2b	(BETA	VERSION)	FINALE	INVENTORY	USERS:	Moved	'Finale	Inventory'	submenu	from	the	'Effects'	menu	to	the	'File'	menu.	Add	'pixie	dust'	as	a	reformulation	of	'glitterig'.	Improve	the	'do	not	show	again'	checkbox	on	dialogs	by	making	it	not	create	an	undo	record	if	user	doesn't	change	it.	Added	'Images	window'
hot	key	in	'Window'	menu;	added	'Window	>	Set	main	window	to	>	Images	window'	option	also,	which	was	missing.	Option	to	delete	custom	camera	presets	by	right	clicking	them,	or	click	just	clicking	the	name	to	rename	or	delete.	Fixed	duration	calculation	for	importing	HBS	with	HBO43.	Fixed	a	bug	with	the	'Rack	Number'	sort	field	option	in	the
assignment	order	paragraph	of	the	addressing	dialogs.finale3d-installer-2021.10.11-6c08148dd	(RELEASE)	Updated	Russian	and	Ukrainian	UI	translations.	Improved	the	'Why	am	I	in	demo	mode?'	dialog	and	'Request	free	trial	license'	button.	Added	verbose	and	concise	options	for	'Chain/e-match	message'	as	a	field	accessible	in	labels,	which	print	e-
match	count,	shell	count	within	chain,	external	delay	before	e-match,	and	delay	before	shell	in	chain,	and/or	total	number	of	shells	in	chain.	Tuned/reduced	the	time	hysteresis	value	for	dragging	effects	small	distances	on	the	timeline	from	200ms	to	100ms,	making	it	easier	to	drag	events	small	distances	at	the	expense	of	reducing	the	protection
against	accidentally	nudging	an	effect	when	clicking	on	it	to	select	it.	Changed	definition	of	'next	firing	row'	to	be	rows	with	effect	time	at	or	immediately	after	the	playhead.	Fixed	bug	that	was	causing	Finale3D	to	use	very	high	cpu	in	some	cases	(like	showing	the	login	dialog).	Updated	Brazilian	Portuguese	translation.	Added	a	new	function	'Re-
address	selected	positions'	with	hot	key	'M'	which	is	handy	for	addressing	in	the	design	view.	Added	option	to	turn	off	zebra	striping	on	reports.	Fix	promo	page	layout	bug.finale3d-installer-2020.04.10-263c81ea7	(RELEASE)	Updated	Polish	and	Italian	UI	translations.	Improved	PyroSure	exporter,	automatically	filling	module	number	sequence	gaps,
changing	DMX	modulo	from	100	to	300,	fixing	some	header	bugs.	Added	a	new	rack	layout	diagram	report,	'Rack	Layout	(With	Rack	Numbers)'.	Added	'Racks	help'	button	to	the	rack	layout	view.	Fixed	Ukrainian	Hyvernia	and	Russian	Ruble	currency	symbols	in	printed	reports,	replacing	with	space	character	since	code	page	1251	encoder	used	for
printed	reports	cannot	represent	those	characters.	Changed	text	file	reader	to	preserve	isolated	newlines	even	if	file	contains	carriage	return	/	newline	pairs.	Fix	simulation	bug	causing	particles	to	pop	in	and	out	of	existence.	Added	hidden	column	count	indicator/button	to	ULHC	of	tables.	Move	'duration'	and	'wind	friction'	from	the	BreakPetal	into
the	Star	(visible	in	the	effect	editor).	Changed	default	view	to	full	screen	design	view.	Further	simplified	the	racks	menu	'Show	advanced	rack	functions'	is	unchecked.	Double-click	on	word	in	text	entry	followed	by	shift-click	now	always	extends	selection	from	the	far	end	of	word.	Fixed	module	count	in	Piroshow	exporter	and	added	DMX	universe
count,	0	or	1,	if	show	contains	DMX	events.	Added	'With	Default	Angle'	effect	for	setting	the	rest	angle	for	Explo	X2	Wave	flamer	macros.	Changed	part	buttons	to	actually	look	like	buttons.	This	means	it	is	no	longer	possible	to	change	the	duration	of	a	specific	instance	of	a	cake	by	editing	the	script;	you	have	to	make	a	new	cake	effect	with	a	different
duration	and	use	that.	Sorted	the	columns	correctly	in	the	setup_by_module_blueprint.	Fixed	'Add	racks'	dialog	user	interface	issue	wherein	selecting	a	rack	part	choice	for	single-shot	row	in	the	dialog	could	result	in	an	unexpected	jumping	around	of	rack	part	choices	in	that	row	and	other	rows	for	single-shots	of	different	sizes	if	some	of	the	choices
were	fixed-any-size	varieties	that	applied	to	multiple	rows.	Fixed	pin	count	summary	in	exporters	that	supported	multi-hit	pins,	which	were	counting	hits	instead	of	pins.2018.09.26-b4e18958-finale3d-win32-installer	(RELEASE)	Fixed	all	known	UI	bugs	with	'Create	rack'	and	'Edit	rack'	dialogs.	Changed	column	names	in	filter	bar	expressions	to	use
internal	names	instead	of	localized	names	so	that	blueprints	are	independent	of	language	translations.	Added	Cobra	DMX	support.	Expanded	max	rendered	cake	shots	from	500	to	1000.	Fixed	crashing	bug	introduced	8/11	occurring	on	shows	that	have	any	event	without	an	associated	valid	launch	position.2018.08.11-993ea21b-finale3d-win32-installer
(RELEASE)	Added	'Custom	Position	Field'	to	positions,	which	is	available	in	the	script	rows	for	addressing	and	sorting.	column.	Added	fourth	data	row	to	labels.	Changed	Explo	X2	Wave	Flamer,	Showven	Circle	Flamer	and	Spark	Fabrica	Moving	Head	fixture	hardware	defined	macro	effects	to	be	called	'Programs'	instead	of	'Macros'	to	clear	the	way
for	the	upcoming	Finale	3D	feature	of	effect	macros,	seeking	to	avoid	naming	confusion.	Automatically	determine	language	when	importing	effects	and	convert	inferred	fields	to	native	language,	e.g.,	French,	Spanish.	Made	home/end	and	page	up/down	work	on	tables.	Added	camera	key	frame	and	preset	add/delete	menu	items	to	camera	menu.
Added	drag-and-drop	from	parts	window	to	design	window.2017.11.30-7a4d0503-finale3d-win32-installer	(RELEASE)	Simplified	controls	on	effect	bar.	Fixed	the	long	standing	deficiency	that	if	you	lock	addresses	with	racks	already	assigned	and	then	add	additional	items	to	the	show	and	then	address	the	new	effects	while	leaving	the	locked	addresses
as	is,	the	software	used	to	create	rack	assignment	conflicts	with	the	new	effects	colliding	with	racks	of	locked	assignments.	Added	SHT	as	synonym	for	SHOT	to	VDL.	Automatically	save	import	settings	in	per-user	settings,	so	the	values	you	set	are	'sticky'.	Improved	the	'Why	am	I	in	demo	mode?'	dialog	and	'Request	free	trial	license'	button.finale3d-
installer-2022.02.04-faada21fc	(BETA	VERSION)	Made	shift-click-drag	in	the	position	ribbon	in	2D	Lock	mode	drag	a	selection	rect	that	applies	exclusively	to	position	nametags	in	the	ribbon.	Made	position	rotation	widget	only	appear	when	user	selects	rotate	function	from	top	menu	or	position	context	menu.	Made	CSV	show	importer	recognize
LAUNCH	POSITION	and	POST	as	synonyms	for	POSTION.	Made	Explo	GX2	and	GX3	flamer	effects	always	use	pin	1	in	SHW	files	exported	for	the	Explo	Ignition	System.	For	example,	if	you	had	set	pieces	for	the	digits	of	2	0	2	1,	you	could	copy	the	set	piece	model	of	'2'	and	its	positions,	and	then	paste	it	twice	into	a	show	for	the	two	occurrences	of
that	digit	in	2	0	2	1.	Added	Safety	Distance	column	to	positions	window	and	added	'Position	Safety	Distance'	to	the	script	window	by	reference	to	make	it	available	in	reports,	especially	for	the	safety	distance	report	that	compares	effect	safety	distances	with	position	safety	distance.	Added	'Show	>	Zoom	to	selected	effects	on	timeline'	menu	item	and
hotkey;	same	as	button	on	timeline.	Fixed	text	overlapping	close	box	in	full	text	filter	of	table	windows.	Added	a	'Use	exact	simulation	syntax'	checkbox	on	the	combine-as-cake	dialog	so	user	can	choose	to	generate	the	exact	simulation	syntax	even	if	the	standard	syntax	is	substantially	accurate,	having	timing	within	2ms	and	angles	within	5	degrees.
Fix	bug	introduced	in	previous	build,	with	explicitly-specified	prefires	and	durations	not	working	correctly.	Importing	a	script	with	position	group	names	into	show	with	matching	group	names	expands	the	script	rows	into	all	the	positions	of	the	group.)Fixed	issues	with	spaces	and	special	characters	in	position	group	names.	Fixed	chain	duration	when
importing	shows.	Added	hot	key	for	'Renumber	chains'.	Removed	the	unnecessary	'Some	events	are	missing	module	type'	warning	message	when	triggered	by	empty	cues	that	can	be	ignored	without	concern.	Fixed	problem	with	chain	effects	made	from	effects	customized	with	the	effect	editor.finale3d-installer-2020.05.31-3af3899ad	(RELEASE)	Fix	a
crash	that	occured	when	turning	on	'Draw	trajectory	dots	instead	of	effect	simulations.'	Fix	timeline	duration	calculation	for	multi-break	shells	from	the	effect	editor.	Made	durations	adjustable	for	cakes	in	script	rows,	not	just	parts	window.2018.01.03-59230979-finale3d-win32-installer	(RELEASE)	We	now	show	a	movie	preview	for	effects	when	you
hover	the	mouse	over	an	effect	icon.	Made	importing	TXT	files	smartly	determine	whether	delimiter	is	tab	or	comma	or	semicolon;	same	as	CSV.	Added	File	>	User	settings	>	Test	sound	system,	to	help	debug	the	spurious	crash	in	the	sound	system.2018.03.02-9c8b8b20-finale3d-win32-installer	(RELEASE)	Tune	down	brocade	trails	a	bit.	Added
landscape	option	for	all	basic	reports.	Made	it	possible	to	drag	effects	from	effect	basket	to	tubes	even	if	you	don't	have	pre-assigned	rails	or	a	start	module	for	the	position.	Fixed	the	initial	focus	of	several	addressing/racking	related	dialogs	so	the	user	can	easily	press	the	'Enter'	key	to	dismiss	the	dialog.	Made	the	default	part	number	in	the	'Create
cake	from	selecte	items'	dialog	default	to	the	part	number	of	the	broken	apart	cake	if	coming	from	a	'Results	of	break	apart	cake'	show.	Support	move-in-black	and	move-to	light	fixture	effects.	Added	new	default	labels	templates	for	'Chain	labels'	which	print	one	label	per	shell,	and	include	the	delay	immediately	before	the	shell;	this	label	template
can	be	used	if	you	want	labels	per	shell	of	chains,	and	also	you	can	print	it	on	paper	and	just	use	it	as	chain	building	instructions,	if	you	prefer	this	format	to	the	chain_specifications	report.	Added	troubleshooting	menu	item	for	finding	missing	DMX	patches.	Added	Parente	FireMaster	exporter.	Added	'File	>	New	>	New	show	from	start-up	template'
and	bound	to	Control+Shift+N	as	keyboard	shortcut;	Made	the	'Edit	properties'	keyboard	shortcut,	previously	Control+Shift+N,	changed	to	Control-R,	which	was	unused.	Further	improvements	to	the	fan	and	sequence	dialogs.	Added	two	new	notes	columns	to	the	script	table,	Notes	2	and	Notes	3.	Synchronize	clicking	sound	effect	for	angling
trajectories	with	graphics	updates.finale3d-installer-2022.02.01-09456ee53	(BETA	VERSION)	Change	module	name	from	'Cobra	18	pin	module'	to	'Cobra	18M,	36M	or	72M'.	Added	new	function	'Racks	>	Re-load	selected	effects	from	script	into	racks...'	which	assigns	or	re-assigns	racks/tubes	to	the	selected	effects	in	the	script.finale3d-installer-
2021.10.05-9ed68447e	(BETA	VERSION)	Updated	French	and	Hungarian	UI	translations.	Updated	Turkish	UI	translation.	Limited	DMX	comment	on	Pyromac	exporter	to	25	characters.	Added	ability	to	import	the	fuse	delay	column.	Added	option	in	create-rack	dialog	for	pre-wired	pins,	for	parente	ishot	and	evolved	single-shot	bases.	Fix	icon
rendering	of	cakes,	so	that	it	always	renders	at	least	one	shot	of	the	cake	rather	than	catching	'silence'	in	between	shots.	Improved	formatting	of	the	Add	Racks	dialog,	changing	the	'ignore'	checkbox	to	be	a	'do	not	ignore'	checkbox	at	the	beginning	of	the	rows;	and	other	formatting	changes.	Tune	gold	mine	and	horsetail	to	be	brighter	and	have	more
particles.	Added	scrollable	text	in	all	text	input	areas.2017.12.15-ea48048c-finale3d-win32-installer	(RELEASE)	Make	flash	pots	silent.	Tune	shells	so	that	they	don't	break	early	when	overriding	the	height.	Simplified	DMX	patches	for	Explo	X2	Wave	Flame	macro/programs,	removing	unnecessary	channel	commands	and	optimizing	the	program
channel	and	speed	channel.	Improved	the	effect	insert	buttons	on	the	effect	window	to	avoid	accidental	triggering	of	previews	getting	in	the	way;	now	preview	hotspot	is	the	white	hover	indicator	bar	on	the	button.	Changed	the	heights	of	light	fixture	effects.	Fixed	'Script	>	Align	>	At	Earliest	EFFECT	time'	which	previously	aligned	to	EVENT	time.
Added	left/right/center	text	justification	options	for	labels	fields.	Simplified	the	rule	for	importing	HBS	cake	and	shell	prefires:	round	to	zero	if	<	1sec;	else	import	AS	IS.	Added	download	progress	bar	for	downloading	scripts	to	Pyrodigital.	Updated	Ukrainian	and	Russian	translations.	Updated	the	VDL	of	light	fixture	effects.	Improved	Galaxis	module
names.	Made	dialog	windows	scrollable	vertically,	using	scrollwheel,	up/down	arrows	or	page	up/down	keys.	Made	ESC	exit	out	of	multi-key	hotkey	sequence.	Improve	rendering	performance	when	there	is	no	water	in	the	scene.	Made	'Tools	>	Open	firing	system	script	as	generic	table'	work	for	GS2	version	2.6	in	addition	to	showing	the	device	table.
Fixed	VDL	cake	number	of	shots	parsing	bug	introduced	when	implementing	flame.	Added	an	'annotation'	field	to	racks,	enabling	user	to	add	annotation	text	on	the	rack	layout	diagram.	Fixed	'Racks	>	Add	racks	for	show...'	involving	flames	and	other_effect	effects	that	don't	need	racks.	Added	'Scenery	>	Background	images	>	Add	background
image...'	as	a	simple	way	to	import	background	images,	similar	to	how	Finale	Business	worked.	Changed	behavior	of	clicking	on	selected	item	on	timeline	--	no	longer	teleport	playhead	to	item's	blip	unless	user	double-clicks.	Add	'straight'	and	'droopy'	VDL	adjectives	for	fountains.	Added	four	additional	slots	for	sort	fields	to	the	addressing	dialog	and
blueprints.	Change	the	Control-H	'Script	>	Chains	>	Combine	as	chain'	function	to	combine	as	chain	AND	pop	up	the	dialog	to	set	or	update	the	chain	delays,	which	makes	it	obvious	if	the	current	deltas	between	effects	are	incorrect	by	virtue	of	prefire	differences	and	gives	user	a	way	to	fix	it	by	simply	typing	a	single	number	as	the	delta	between
shells	and	then	press	enter.	Added	Safety	Distance	report	that	compares	positions'	declared	safety	distance	against	the	safety	distance	of	effects	launched	from	the	position,	and	highlights	any	rows	with	insufficient	position	safety	distances.	Fixed	undo	for	'Flights	>	Make	flights	into	chains',	which	previously	left	residual	delays	on	the	effects.	Add
global	coordinates	and	global	angles	for	positions	and	effects	to	Finale	Generic	CSV	export	file	format	in	'Coordinates'	column.	Fixed	'Delete	unreferenced	per-show	effects'	bug	wherein	racks	were	deleted	without	considering	their	references	from	the	layout	window.	Dragging	unselected	effect	on	timeline	to	empty	cue	now	removes	empty	cue.
Decrease	the	intensity	of	the	'gold'	color.	Added	DMX	support	for	SpecialFx.it	18x12W	IP65	RGBWAU	Par	Light,	Standard	Fixture	ID	060.	Fix	a	'sound	lagginess'	bug	that	was	manifesting	for	some	computers.2018.01.03-c1581237-finale3d-win32-installer	(RELEASE)	We	now	show	a	movie	preview	for	effects	when	you	hover	the	mouse	over	an	effect
icon.	Added	'Edit	>	Paste	special	>	Paste	models	and	positions	as	new	instances'	to	enable	you	to	copy/paste	multiple	instances	of	a	model	and	its	attached	positions	into	a	show.	Fix	'render	settings	getting	stuck	on	low'	bug.	In	rack	layout	window,	make	shift-draging	a	selection	rect	begin	by	deselecting	all,	instead	of	adding	to	selection	set.	Made
quantity	filter	status	text	in	effect	palette	localizable.	Erase	underneath	'edit	racks'	and	'hide	rails'	links	in	rack	layout	window	to	make	them	more	readable.	Improved	column	resizing.	Added	a	new	field	on	positions	--	DMX	Fixture	Angle	--	with	an	option	to	rotate	the	fixture	180	degrees	since	you	may	want	to	flip	the	fixture	around	in	the	real	world	or
configure	it	in	a	'mirror'	mode.	Made	it	impossible	to	enter	the	reference	number	0	for	chains,	racks,	songs,	models,	and	images.	Added	Explo	splitter	box	option	to	start	with	a	10	pin	offset.	Improved	translation	of	French	effect	names,	better	handling	of	plurals.	Fix	the	'ctrl-z	blows	away	the	effect	editor'	bug.	Trimmed	whitespace	from	the	part
number	field	in	the	'Create	effect'	dialog	to	avoid	creating	part	numbers	that	end	with	whitespace.	Added	support	for	the	beamZ	BBP60	par	lights	and	added	standard	effects	for	them	in	the	Assorted	DMX	Effects	downloadable	catalog.	Fixed	move-to	bug	applying	when	script	window	is	sorted	backwards.	Fixed	default	selector	values	in	custom
reports	not	based	on	the	script	window.	For	importing	HBS,	reverse	engineer	HBO48	trail	colors,	strobing,	crackling,	horsetail,	ring,	crossette,	color	transitions,	popcorn	crackle,	salute,	and	ti	salute.	Fixed	notes	field	in	Finale	Generic	CSV	export.	Added	'height'	column	to	parts	window.	Added	DMX	error	checking	in	front	of	'Export	firing	system
script'	function.	Added	'Add	racks	for	unracked	events.	Added	consolidation	functions	for	all	fields	of	all	tables,	for	chain/group	show-as-one-row	consolidation	and	in	prep	for	reports.	Disabled	space	bar	/	play	command	when	design	view	is	not	visible.	Changed	the	way	the	'Address'	column	in	the	script	represents	multiple	addresses	when	multiple
rows	are	combined,	as	with	the	default	option	of	combining	chains	and	groups	as	single	rows.	Updated	Polish	and	Brazilian	Portuguese	translations.	Added	ability	to	drag-and-drop	effects	from	the	effect	basket	in	the	rack	layout	view	directly	to	racks,	getting	assigned	the	next	available	firing	system	address	automatically.	Made	'Fill	down	addresses'
start	at	rail/pin	instead	of	just	module	number,	to	support	filling	down	beginning	with	a	pin	offset.	Fixed	color	swatches	in	effect	editor.	Added	significant	new	feature:	'Re-arrange	tubes	in	adjustable	angle	racks	to	avoid	collisions'	option	on	addressing	dialogs,	which	automatically	re-arranges	tubes	in	an	optimized	layout	within	single-shot	racks	such
that	tubes	do	not	angle	at	each	other	and	such	that,	to	the	extent	possible,	sets	of	adjacent	tubes	have	the	same	size	and	part	number	to	make	the	layout	appear	sensible	to	the	crew	setting	up	the	racks;	in	addition	to	other	subtle	optimizations	like	optimizing	for	symmetry	and	a	preference	for	tubes	angling	away	from	the	rack	instead	of	across	it.
Added	major	new	feature	--	effect	macros.	Added	optional	corner	outlines	and	fold	lines	to	labels.finale3d-installer-2020.01.31-b06ce9f35	(RELEASE)	Changed	max	magnification	level	of	rack	layout	diagrams	so	tiny	racks	on	tiny	positions	are	printed	large	enough	to	read.	Effect	Editor:	Fix	a	crash	bug	affecting	some	rising	effects.	Tune	small	caliber
effects.	Fix	a	possible	memory	corruption	bug	with	pattern	breaks	(hearts	and	smiley	faces).	Minor	additions	to	the	DMX	Patch	language	with	shorter	terms	to	make	DMX	Patches	fewer	characters.	Removed	double-height	part	descriptions	from	tables.	Also,	if	you	need	to	export	positions'	world	coordinates	instead	of	model-relative	coordinates,	you
can	now	detach	the	positions,	then	export,	then	undo	to	reattach.	Added	'Racks	>	Add	easy	racks	for	show'	function,	which	is	an	way	to	add	racks	to	the	show,	more	similar	to	Finale	Business.	Fixed	bug	that	positions	in	site	layout	diagram	did	not	take	into	account	rotation.	Add	error	message	if	user	attempts	to	add	DMX	effect	from	right-click	menu
to	multiple	positions	that	do	not	agree	on	fixture	type.	Added	informative	warning	message	if	attempting	to	apply	a	macro	with	references	to	positions	that	are	not	present	in	the	show.	Added	labels	sort	criteria	in	the	comment	line	in	margin	of	page.2018.07.26-7fcab3b6-finale3d-win32-installer	(RELEASE)	Added	label	templates	for	5267,	CL33,	LP33,
DPS-30-100,	L7158,	L4737,	L7160,	5195.	Further	tuning	on	brightness	and	glow	of	effect	bars	on	the	timeline.	Fix	a	crash	bug	in	some	effects.	Added	Cost	column	to	script	window.	Added	vertical	rulers	to	show	height	of	positions	when	moving	them.	Updated	generic	effects	for	the	VDL	color	changes.	Fixed	harmless	bug	wherein	the	'update	effects
in	show'	dialog	would	appear	unnecessarily	when	the	edited	effect	hadn't	actually	been	changed.	In	this	latest	revision,	the	number	is	printed	first,	followed	by	the	ASCII	graphic	character	indicating	the	general	direction,	AND	IF	MORE	THAN	ONE	ANGLE	IS	REPRESENTED	then	only	the	first	number	is	printed,	and	the	ASCII	character	is	asterisk,	to
indicate	the	row	represents	multiple	effects,	examples:	0	|,	and	30	/,	and	0	*,	which	would	be	the	result	of	combining	0	|	and	30	/	into	a	single	row.	usable	length	constraint	option	in	the	create-rack	dialog	for	Ricasa	style	single-shot	racks	with	slides	that	fit	variable	size	tubes,	since	the	number	of	tubes	depends	on	their	size.	Fix	'pink	bug'	that	was
appearing	for	'rainbow'	effects.	Added	'Details'	button	with	detailed	explanations	for	any	devices	left	over	after	'Add	racks	for	show'.	Added	'File	>	Export	>	Export	voice	cues	track'	and	'File	>	Voice	cues	settings...'	and	'File	>	User	settings	>	Turn	voice	cues	ON	for	playback'.	If	user	does	'Assign	DMX	channel	ranges'	for	fixtures	that	include	just	one
master	and	all	the	rest	slaves,	and	if	all	of	them	do	not	yet	have	DMX	universe	and	channel	base,	then	infer	that	the	user	wants	those	slaves	associated	with	that	master	and	do	it	for	him.finale3d-installer-2021.03.31-c5227bea3	(BETA	VERSION)	Fixed	bug	in	top	level	menu	item	'Add	DMX	effect	to	fixture'.	Enlarged	selector	and	menu	width	for	part
number	in	the	'Add	Racks'	dialog.	Made	Angles*	column	in	the	script	window	display	up	angles	as	|	0	or	|	90,	dependening	on	chosen	convention,	instead	of	leaving	up	angles	as	blank.	Added	error	message	if	you	try	to	do	'Fill	Down'	addressing	with	script	window	sorted	by	the	addresses	that	are	the	output	of	the	procedure.	Added	effect	tooltips	to
the	module	pins,	including	multiple	tooltips	for	chains	and	module	devices	ematched	to	the	same	pin.	Hooked	up	Finale	Inventory	sales	order	integrations.2018.01.31-7f4ef568-finale3d-win32-installer	(RELEASE)	Added	EX,	CE,	UN	number	fields,	and	Safety	Distance,	and	Cost	field,	to	parts	window	as	optional	columns.	Fixed	an	obscure	bug	when
aligning	chains	to	groups.	Implement	shot	angle	and	shot	duration	specifiers	on	cake	shots.	When	pasting	or	duplicating	positions,	shift	the	pasted	or	duplicated	positions	to	avoid	stacking	on	top	of	each	other.	Added	option	to	'Import	show'	for	'Ignore	empty	cues'.	Fixed	fan	angle	of	bookend	firing	pattern	in	'Combine	as	cake'	function.2019.10.20-
d8da382a-finale3d-win32-installer	(RELEASE)	Exporter	now	includes	universe	name	in	exported	filenames	if	show	contains	multiple	universes.	Added	new	parameters	to	the	DMX	Patch	language	to	support	rotating	flame	effects	in	the	user	interface	for	DMX	personalities	that	have	different	channel	numbers	for	different	angles.	Also	made	shift-
clicking	work	for	'Hide	or	unhide	column'.	Changed	all	'DMX	patches'	to	be	0-based	instead	of	1-based.	Support	replacing	items	within	chains	in	addition	to	full	chains	as	units.finale3d-installer-2021.03.07-786409afe	(BETA	VERSION)	Improvements	to	Finale	Inventory	sync	speed	and	reliability.	Fix	bug:	rendered	movie	sounds	were	playing	as	though
the	observer/camera	were	at	the	origin.	Improved	the	styling	of	warning	and	info	messages	in	fan/sequence	dialogs.	Make	scroll	wheel	zooming	in	the	backwards	direction	slide	the	focus	point	backward	slightly	while	zooming	out	to	compensate	for	the	forward	slide	when	zooming	maximally	close	Make	gerbs	and	fountains	visible	again	(though	still
not	yet	well-tuned).	Updated	Dutch	and	Hungarian	UI	translations.	Added	'flight'	and	'flt'	a	synonyms	for	'chain'	in	effect	descriptions.	Fixed	repaint/invalidation	bug	in	rack	layout	when	when	user	moves	a	position.	Fixed	minor	warnings	in	FireOne	export	for	flame	events	that	caused	quantity=0	warning.	Fix	a	bug	causing	'chain	number	of	devices'	to
be	0.2018.12.12-6abde26c-finale3d-win32-installer	(RELEASE)	Fix	single_shot	handling	for	Finale	Inventory	sync.	Save	list	of	currently	loaded	FDB	effects	files	and	load	them	automatically	when	launching	app.	Added	'Effects	>	Paste	clipboard	into	effects	window,	add	or	update'	to	make	it	easy	to	copy/paste	between	effects	collections	in	a	way	that
updates/overwrites	existing	effects	instead	of	adding	a	tag	like	'(1)'	to	the	end	of	colliding	part	numbers,	which	is	the	behavior	when	you	press	control-V	to	paste.	Changed	orbit	to	rotate	around	the	pointed-at	location.	Added	Rack	Type	to	the	tooltips	for	effects	in	the	rack	layout	window.	Added	a	new	function	'Clear	addresses	at	selected	positions.
Updated	Chinese	UI	translation.	Added	15	channel	PD	option	so	users	don't	need	to	make	a	custom	module.	Moved	'Easy	Racks	user	settings'	and	'Save	startup	template'	into	'File	>	User	settings'	submenu	and	moved	'Print	again'	into	reports,	labels,	and	diagrams	submenus,	to	simplify	the	main	file	menu.	Added	'Set	to	water	everywhere'	command.
Made	the	Add	Racks	dialog	provide	explanations	for	disabled	rows,	e.g.,	effects	fill	into	existing	racks,	or	effects	fill	into	other	rack	choices,	or	row	is	ignored;	these	explanatins	are	intended	to	make	the	dialog	more	understandable,	particularlly	in	complex	situations	with	single-shot	racks	that	accommodate	multiple	size	tubes.	Make	'bright'	and	'dim'
vdl	terms	affect	trails.	Added	'Filter'	option	in	reports	configuration	and	labels	configuration,	enabling	easy	customization	of	reports	to	filter	by	position,	or	chains/nochains,	universe,	rack	type,	etc.	Fixed	bug	wherein	pressing	delete	key	in	effect	chooser	with	empty	text	in	search	bar	closed	the	window.	Added	very_dim	and	slightly_dim	to	VDL.	Fixed
bug	in	Piroshow	exporter	(scaled	DMX	channel	values	from	255	to	100.	Made	event	IDs	in	Mongoose	exported	scripts	stable	across	reloading	the	show	without	making	changes.	Show	'committed'	orders	in	finale	inventory	sales	order	list.	Added	initial	set	of	Spanish	VDL	terms	to	enable	importing	and	creating	effects	in	Spanish.	Added	tab	and	shift-
tab	as	hotkeys	for	design	window	to	select	next/previous	position.	There	are	many	changes	to	the	way	VDL	effects	are	parsed	and	built.	Preserve	existing	table	layouts	when	open	a	show.	Make	'crackling	trails'	more	differentiated	from	'glittering	trails'.	Improved	importing	old-style	HBS	effects	by	reverse	engineering	the	simulation	parameters.
Improved	copy/paste	between	shows,	enabling	copy/paste	of	events	or	positions	or	models,	and	automatically	including	and	copying	over	any	positions	that	events	depend	on	or	models	that	positions	depend.	Fixed	bug	with	printed	reports	containing	consolidated	rows.	Added	German	'combo-words'	like	silberkomet.	Also,	for	any	shows	started	in
previous	versions,	update	your	'DMX	Channel	Base'	values	(to	NOT	subtract	1)	and	do	'Effects	>	Update	per-show	effects...'	before	exporting	your	script.	Fixed	bug	in	'Addressing	>	Edit	blueprint'	that	was	introduced	in	the	last	release	with	the	prettier	menu	text	formatting	for	labels	and	reports.	Further	adjustment	to	the	printed	format	of	'Angles*',
now	printing	multiple	SAME-angles	with	the	standard	angle	ASCII	character,	and	only	printing	the	asterisk	ASCII	character	if	multiple	angles	that	are	DIFFERENT.	Made	hover-over	highlighting	apply	for	DMX	fixtures	apply	also	to	any	referenced	DMX	slave	fixtures	or	DMX	master	fixture	referenced	from	the	hovered-over	position.	Minor	fix,	not
displaying	padlock	buttons	when	drawing	time	counter	in	3d	view,	which	would	overlay	them.	Added	module	type	column	to	modules_per_position	report.	There	is	still	no	progress	dialog	yet.	Changed	default	model	brightness	to	1.5	Removed	the	'high/low'	quality	rendering	concept.	Improved	importing	HBS	effects	that	do	not	have	VDL	by	reverse
engineering	simulation	parameters	to	derive	effect	type,	size,	tip	colors,	trail.	Improved	palette	graphics.	Improved	copy/paste	of	models	and	positions	from	the	design	view,	fixing	a	bug	wherein	copying	a	model	from	one	show	to	another	show	that	already	contained	a	different	model	wouldn't	have	the	correct	result	of	both	models	in	the	pasted-into
show.	Change	the	orientation	of	ring	break	pattern	so	that	it	correctly	orients	with	respect	to	'top	half'	and	'bottom	half'	to	create	jellyfish	shells.	Added	'Admin	>	Install	language	translation	file...'	for	the	people	who	are	translating	3D	to	other	languages.	Added	'flame	pot'	and	'flamepot'	as	synonyms	for	'ground	flare'.	Added	blue	navigation	button	for
selecting	by	way	of	selection	rect,	so	you	don't	need	to	press	shift.	Focus	the	OK	button	on	the	account	summary	dialog	on	launch.	Changed	Move-To	effects	to	reach	back	and	begin	and	previous	event's	action	time,	rather	then	at	the	end	of	the	previous	effect,	because	that	is	more	intuitive.	Added	support	for	Cobra	36	LED	Par	Light,	which	is
compatible	with	EasyDancing	fixtures.	Added	a	number	of	new	field	options	for	labels	in	order	to	support	rack	labels,	namely,	Rack	Part	Number,	Rack	Part	Number	And	Description,	Rack	Size,	Rack	Size	And	Description,	Rack	Annotation,	Rack	Cluster	Annotation,	Rack	Angle.	Adjusted	page	up/down	amounts	for	all	tables,	timeline,	and	graphics
window	to	leave	a	small	overlap	of	the	previously	visible	range.	Expanded	max	cake	rows	from	50	to	100	when	avg	row	length	>=	2.	Improved	timeline	cue	flags.	Made	the	position	rotation	widget	only	appear	if	you	click	on	a	position.	Updated	durations,	prefires,	and	heights	of	generic	effects.2018.09.25-e267f72c-finale3d-win32-installer	(RELEASE)
Implement	faster	and	more	robust	method	for	syncing	My	Effects	and	Finale	Inventory	connections.	Fixed	minor	bug	with	the	leading	zeros	formatting	of	pins	in	full	address	fields	of	labels.finale3d-installer-2021.09.16-1b08051c4	(BETA	VERSION)	Updated	Russian	and	Ukrainian	UI	translations.	Please	see	documentation	article	on	cross-loading
chains	with	straight-up	shells.	When	adding	N	positions,	Finale3D	now	adds	them	in	a	line,	not	back	and	forth.	Minor	other	improvements	to	the	'Add	racks'	dialog.	For	HBS	importing,	improved	reverse	engineering	differentiation	between	rising	crossette	and	aerial	crossette	for	HBO37.	Added	'Delete	unreferenced	Per-show	effects...'	Added	'Clear
quotas...'	Added	'screamers'	as	English	translation	to	'whistles'	in	VDL.	Changed	the	automatic	1-sec	and	5-sec	timeline	playhead	snapping	UI	from	engaging	whenever	cursor	Y	delta	exceeds	threshold	to	engaging	whenever	cursor	Y	is	dragged	above	timeline,	because	users	didn't	understand	that	the	snapping	was	a	feature	and	thought	it	was	just
broken.	Speed	up	the	'update	remote	inventory'	operation,	for	when	you	bulk-edit	a	Finale	Inventory	catalog.	Add	'Sky	Blue'	as	a	VDL	color.	Fixed	cake/candle	problem	with	Polish	translation	introduced	in	the	last	release.	Added	'Set	sleeve	size'	function	on	right-click	context	menu	for	script	table,	supporting	the	practice	of	putting	single-shots	or
candles	into	mortar	tubes	of	arbitrary	size.	Fixed	bu2Cg	wherein	sorting	addresses	by	'chains	first'	actually	sorted	chains	last.	Re-tuned	the	darkening/blending	on	sky	images.	Effect	editor:	Make	phase	color	swatches	only	use	the	tip	colors,	not	the	trail	colors,	unless	there	are	no	tip	colors.	Added	DMX	implementation	for	Chauvet	Geyser	RGB	Fog
Jet,	and	Chauvet	EZpar	64	par	light.	Show	total	width	dimension	in	addition	to	splits	between	positions	in	position	line	ruler.	Fixed	module	count	in	Cobra	and	Pyromac	export	summary	dialogs,	which	previously	conflated	DMX	universes	with	modules.	Fix	a	crash	bug	when	importing	certain	inventories.2017.10.01-bb84dfab-finale3d-win32-installer
(RELEASE)	Fix	crackling	pistil.	Changed	window	arrangement	hotkeys	by	requiring	shift	to	avoid	confusion	when	trying	to	edit	yellow	table	cells.	Start	the	application	with	a	good	front-on	viewing	angle,	like	in	Finale	Business.	Added	single-shot	rack	type	with	posts	that	hold	two	tube	each;	and	posts	that	hold	four	tubes	each.	Added	a	background
process	that	checks	if	user	ever	creates	mis-matching	position	names	by	editing	the	script	window	or	positions	window,	and	pops	up	a	dialog	offering	to	fix	them	automatically,	the	fix	being	able	to	detect	and	fix	upper/lower	case	sensitivity	problems	and	problems	of	user	manually	changing	position	names	in	position	table	instead	of	using	the	'Rename
position'	function,	which	may	leave	events	with	mis-matching	position	names.	Fix	ground	flash.	Added	new	function	for	positions,	'Raise	position	heights.'	Made	the	rotate-position-pitch	functions	not	keep	positions	being	swung	into	the	air	stuck	to	the	ground.	Re-tune	cremora	fireball.	Added	Hryvnia	currency	symbol	for	Ukrainian.	This	build	has	a
bug	with	X2	Wave	Flamer	effects.	Fixed	crashing	bug	that	could	occur	when	importing	or	combining	some	cakes.	There	should	not	be	large	differences,	if	you	see	some,	please	report	them	to	us.	Added	rack	context	menu	command	'Reverse	tube	loading	order'	which	reverses	the	order	in	which	tubes	in	that	rack	are	allocated	in	the	addressing
functions,	for	purpose	of	snaking	addresses	or	chaines	back	and	forth	in	the	racks.	Changed	position	locked	status	to	be	per-show-per-session	state	instead	of	saving	it	with	show.	Fixed	minor	rounding	rror	in	DMX	exporter	that	could	yield	a	1ms	error	in	some	event	times.	Added	two	new	sort	terms,	Fan	Chains	First	and	Fan	Chains	Last,	giving	user
control	over	addressing	chains	with	multiple	angles	separately	from	chains	with	all	shells	at	the	same	angle.	Improved	effect	palette	tooltips.	Made	the	word	'And'	in	VDL	convert	to	+	or	&	based	on	context.	Fix	issue	with	some	SCX	files	not	importing.2018.10.26-f08346ef-finale3d-win32-installer	(RELEASE)	Improved	rack	menu	items.	Added	new
function,	'Racks	>	Load	effects	with	firing	system	addresses	into	racks...'	to	enable	users	to	make	rack	assignments	AFTER	setting	the	firing	system	addresses,	which	is	necessary	if	a	user	imports	a	pre-addressed	show	into	Finale	and	wants	to	add	racks	without	changing	the	firing	system	addresses.	Reorganized	and	renamed	flame	effects	in	generic
effects	catalog.	Added	three	new	addressing	sort	terms,	'Same	Rack',	'Same	Row	in	Rack',	and	'Next	Tube	In	Rack'	to	support	a	preference	for	filling	out	racks	with	fanned	out	tubes	with	sequential	pin	addresses,	and	other	advanced	sorting	options.	Fixed	combine-as-cake	problem	wherein	3D	reported	'Too	complex'	for	some	shot	timings.	Fixed	the
'Script	>	Sequence'	functions	for	making	sequences	involving	grouped	events	on	the	timeline	with	the	'Grouping'	checkbox	on,	which	previously	didn't	work	for	groups	that	had	effects	in	multiple	positions.	Added	export	warning	to	detect	any	PAN	angle	problems	with	DMX	fixtures.	Fixed	Cobra	step-by-tracks	export	option,	extending	max	tracks	to
999.	Auto-select	and	assign	first	non-hidden	position	when	drag-and-drop	effect	to	empty	cue.	Added	'Set	annotation...'	to	the	rack	context	menus.	Added	Spanish	translations	for	craker_crysantemo,	craker_dragones,	and	craker_colgante,	and	variations,	to	crackle_flowers,	dragon_eggs,	and	time_rain.	Improved	Pyromac	exporter	to	support	DMX
events	that	leave	channels	with	non-zero	values.	Add	progress	dialog	for	network	sync.2018.10.13-e132fb32-finale3d-win32-installer	(RELEASE)	Improved	performance	of	main	UI	loop.	Made	cake	firing	patterns	for	each	row	default	to	STR,	i.e.,	sequence-right,	even	if	some	rows	explicitly	have	different	patterns	such	as	STT,	all-together.	Improved
Spanish	translations.2019.03.27-6830c9af-finale3d-win32-installer	(RELEASE)	French,	Russian,	and	German	UI	translation	progress,	about	50%	done.	For	backward	compatibility,	existing	shows	remain	as	is,	and	new	shows	will	get	the	new	defaults.	Clarified	that	move-to	effects	only	work	on	fixtures,	and	must	have	a	prefire	equal	to	the	max
reachback,	and	must	have	the	term	'Move-To'	in	the	VDL.	Added	summary	dialog	after	importing	show.	Added	'Show	>	Temporary	settings'	submenu	for	the	mode	options	that	are	not	saved.	Fixed	some	crashes	in	effects	with	'strange'	trajectories.	Added	'Address	show	using	single	blueprint'	with	submenu	to	select	from.	Improved	German	effect
translations.	Added	'Window	>	Save	window	arrangement	as	custom	preset'	function.	Fix	a	crash	bug	affecting	some	GPUs	on	complicated	scenes.	Improved	effect	bar	insert	button	icon	and	removed	edit	button.	Added	error	checking	for	conflicts	with	Pre-Assigned	Rails.	Added	limits	to	DMX	speed	parameters	given	to	Explo,	Showven,	and	Spark
Fabrica	wave	flamers	to	avoid	ranges	for	which	the	Explo	hardware	is	unreliable.	Improved	the	rack	error	exclusions	such	that	if	you	have	ignored	racks	for	a	particular	'Rack	Type'	then	you	won't	get	racking	errors	for	that	Rack	Type	when	addressing,	which	enables	you	to	add	racks	for	slice	cakes	with	a	Rack	Type	and	not	add	racks	for	other	cakes
without	a	Rack	Type	and	then	not	get	any	racking	errors	for	the	cakes	for	which	you	didn't	add	racks.	Made	effect	time	in	script	table	use	chosen	time	format,	e.g.,	SMPTE	or	decimal.	Added	magnification	to	saved	table	layout	blueprints,	supporting	saving	the	magnification	changes	you	can	do	to	the	table	windows	by	holding	control	and	using	the
scroll	wheel.	Added	right-click	context	menu	options	for	racks	in	rack	layout	screen	for	'Sort	left	to	right'	and	'Move	to	last'	to	give	the	user	control	over	the	order	in	which	racks	are	considered	when	assigning	addresses.	Added	tiny	indicators	on	effect	palette	to	show	that	it	can	be	resized.	Added	tooltip	for	selected	effect	at	base	of	timeline,	replacing
tooltip	that	used	to	cover	the	hovered-over	light	bar	on	timeline.	Changed	FireOne	exporter	to	export	size	field	in	mm	or	inches,	and	to	include	mm	or	double	quotes	in	exported	string.finale3d-installer-2019.11.26-1b7f10f7e	(RELEASE)	Fixed	bug	in	'Replace	effect',	making	it	overwrite	the	delay	field	and	clear	the	chainDeviceVdl	field	of	the	effects
being	overwritten.	Added	'Nonphysical'	to	VDL	of	all	safety	channel	effects	and	modifier	effects.	Automatically	set	or	clear	the	Type=Rack	selector	in	the	effects	window	when	changing	window	arrangement,	as	a	convenience.	Fix	bug	causing	My	Effects	to	be	blown	away	during	certain	network	communcation	errors.	This	change	improves	the	appears
of	the	Angles*	column	in	most	common	use	cases	for	reports.	Make	simulation	time	and	timeline	bars	coincide.2017.10.20-0112aaca-finale3d-win32-installer	(RELEASE)	Fix	a	model	loading	crash.	Make	'Script	>	Make	into	sequence'	take	groups	into	consideration,	making	it	possible	to	put	explicit	groups	into	sequences	without	flattening	them.
Validated	all	Spark	Fabrica	sims	and	fixed	the	two	that	were	wrong.	Added	'Show	>	Set	angle	format'	menu	that	supports	different	angle	conventions,	like	left=0,up=90,	etc.	Added	four	additional	pre-wired	pin	options	for	racks,	reversing	the	order	of	the	rows,	for	pre-wired	racks	like	PyroDigiT	and	i-shot	and	Evolved.finale3d-installer-2020.03.25-
6d4184c25	(RELEASE)	Fix	some	inventory	sync	bugs.	Added	'Effects	>	Set	quotas	to	available...'	which	sets	the	show's	quotas	column	with	values	from	the	available	column	in	the	effects	collection.	Added	import	show	option	to	interpret	rows	with	>	N	quantity	as	chains.2018.04.14-7832a7ac-finale3d-win32-installer	(RELEASE)	Another	iteration	on
row	highlighting	while	playing	--	now	with	red	line	at	playhead	plus	highlighted	last-effect	rows.	Extended	DMX	Patch	programming	language	in	effect	definitions	to	support	DMX	devices	with	channels	that	depend	on	angles,	durations,	and	customPartField.	Fixed	timeline	scrollbar,	which	was	broken	when	the	effect	bar	was	removed.	Fix	'silver	&
green	peony'.	Try	using	'very	small	green	mine'	for	letter	writing.2019.08.09-4f8bf44c-finale3d-win32-installer	(RELEASE)	Attempt	#2	at	shipping	the	new	renderer.	Moved	'New	show	from	show	template'	function	to	Admin	menu.	Made	the	collections	filter	in	the	'Add	racks'	dialog	include	all	collections	that	contain	racks,	even	if	none	of	the	racks
can	contribute	on	account	of	being	incompatible	or	having	a	part	number	conflict	with	another	collectipn.	Auto-scroll	script	table	when	clicking	on	timeline	event	or	cue	flag	or	trajectory	in	3D	view.	Added	the	collection	name	to	the	warning	dialog	for	mismatching	rack	types,	to	explain	what	collection	the	rack	with	mismatching	rack	type	came	from.
Changed	RFRemotech's	name	in	menu.	Added	control	points	on	the	racks	in	the	rack	layout	windowith	which	to	adjust	the	racks'	tilt	and	pitch	angles.2018.08.17-d70a4047-finale3d-win32-installer	(RELEASE)	Fixed	import	inventory	bug	wherein	quantity	column	was	imported	as	number	of	devices	instead	of	the	available	count.	Fixed	insert	multiple
events	command.	Added	'File	>	Save	show	as	start-up	template'	which	saves	current	show	as	template	that	is	loaded	automatically	when	software	launched.	Implement	'PNG	image	sequence'	video	output	format.2019.01.30-6b922610-finale3d-win32-installer	(RELEASE)	Added	'File	>	User	settings	>	Swap	insert	and	play	keys'	to	swap	the	space	bar
and	'i'	keys.	Sky	is	no	longer	reflected	onto	the	grass	as	if	the	grass	were	water.	Localize	report/label	names	in	menus,	and	also	make	them	prettier	in	English.	Fixed	effect	chooser's	icons	to	update	automatically.2018.03.19-7e950b54-finale3d-win32-installer	(RELEASE)	Increase	default	brightness	of	skydome,	terrain,	model.	Updated	MagicFX
Flamaniac	Mode	1	DMX	Patches	to	enable	rotating	the	flame	effects	in	the	user	interface.	Made	effect	name	interpreter	less	likely	to	get	confused	by	unrecognized	terms	like	'ccc'	that	could	be	interpreted	as	cake	row	tube	specifications.	Added	support	for	interpreting	>	and	TL	as	tail	in	effect	names.	Fixed	combine-as-cake	problem	wherein	aerially
ambiguous	VDL	terms	like	crossette	would	change	from	rising	effect	to	aerial	effect	in	a	combined	cake.	Letter	pattern	wizard	adds	notes	to	events	indicating	letter	and	index.	Add	'DMX	>	Assign	DMX	channel	ranges	to	fixtures'	function	to	allocate	channel	ranges	compactly	for	selected	or	all	fixtures.	Existing	behavior	is	preserved	for	when	all	copied
events	are	from	the	same	position	A,	in	which	case	they	a	clone	will	be	pasted	into	selected	positions	if	more	than	one	position	is	selected.	Items	with	quotas	get	red	and	green	visual	indicators	for	whether	you've	used	too	many	in	the	show,	and	a	remaining	count	visual	indicator	on	the	icons	in	the	effect	palette.	Improved	both	rack_list	reports.
Clicking	on	a	rack	in	the	rack	layout	view	now	scrolls	to	its	events	in	the	script	window	even	rack	was	already	selected	when	you	click	on	it.	Tune	pistils.	Improved	the	rack	collection	filter	on	the	'Add	racks'	dialog.	Fixed	the	Label	Planet	labels	dimensions.finale3d-installer-2021.06.24-266c86e61	(BETA	VERSION)	EXPERIMENTAL	BUILD.	Fix	'black
speckles'	bug	on	some	GPUs.	Fix	crackling	tail	on	shells.finale3d-installer-2019.12.09-b7af85b8d	(RELEASE)	Improved	randomize	feature	to	make	it	remove	runs	for	randomization	of	angles	and	part	numbers,	in	addition	to	positions.	Make	editing	the	prefire	field	not	cause	a	VDL	effect	to	turn	into	a	blob.	Removed	limit	of	30	characters	for
description	names	in	CSV	ex	port.	Improved	crash	reporting.	Added	a	transparent	color	option	for	the	background	images	so	user	can	designate	a	particular	color	as	transparent,	as	an	alternative	to	using	a	PNG	image	with	an	alpha	channel.	The	old	format	was	just	blank	if	multiple	addresses	were	combined.	L180	and	R110,	R115,	...R180	so	you	can
specify	full	360	degrees	for	cake	or	flame	shots	in	VDL.	Added	context	menu	item	for	positions	to	'Add	compatible	DMX	effect'	with	a	list	of	compatible	effects	to	choose	from.	Minor	improvements	to	the	layout	of	the	addressing	dialog	checkboxes.finale3d-installer-2021.09.02-ba22a1635	(BETA	VERSION)	Improve	create	photo	dialog	UI	flow.	Made
editing	effects	in	table	or	by	'Edit	effect	simulation'	context	menu	item	edit	the	effect	in	the	original	collection,	not	the	per-show	effecs	collection	unless	it	is	already	active	or	is	the	only	choice.	Made	'File	>	Import	>	Import	effects	and	break	apart	cakes	from	HBS	file...'	create	results	from	HBS	simulation	parameters	for	all	multi-shot	effects,	rather
than	relying	on	the	VDL.	Fixed	a	bug	wherein	pasting	a	model	with	attached	positions	could	result	in	slightly	wrong	position	coordinates	adjusted	by	1m	if	they	happened	to	collide	with	existing	positions	when	pasted.	Made	all	columns	in	parts	window	resizable	and	hidable.	Removed	leading	zeros	from	pin	numbers	in	full	addresses	on	labels.	Added	a
fan	type	'In	a	circle'	for	the	'Make	into	fan...'	function	which	starts	with	the	up	angle	and	devices	total	angle	by	N	instead	of	N	-	1	since	circles	have	one	more	angle	gap	than	fans.	Updated	Brazilian	Portuguese	UI	translation.	To	the	extent	these	options	had	been	represented	in	module	type	choices	like	'FireOne	32	Pin	Module	(SEM)'	vs.	Combined
'Edit	rails'	and	'Add	rails'	link	buttons	and	made	it	possible	to	specify	a	list	of	rails	in	the	dialog.	Upgrading	to	new	versions	from	this	version	forward	will	not	add	unwanted	visible	columns	to	existing	show	blueprints,	but	if	you	are	saving	blueprints	in	Excel,	you	will	still	need	to	modify	those	blueprints	to	hide	the	new	columns.	Added	options	to
'Update	Per-show	effects...'	to	update	from	all	collections	versus	from	current	collection.	Improved	addressing	summary	dialog	to	have	explanatory	footnote	in	case	of	wiring	or	racking	errors.	The	text	wrapping	options	are	in	the	dialogs	for	editing	report	and	label	templates.	Added	a	new	column/field	to	effects	and	racks	called	'First	Angle*'	which
displays	the	ASCII	art	angle	format	that	shows	only	the	first	angle,	with	an	asterisk	after	it	if	the	row	contains	multiple	angles	that	are	not	all	the	same,	e.g.,	'-10	*'.	Added	import	show	option	to	interpret	chain	quantities	as	meaning	number	of	devices	or	number	of	chains.	Fixed	Pyrolamas	and	Pyrodigt	racks,	which	didn't	work	because	I	had	forgotten
to	specify	the	number	of	tubes.	Added	control-shift-up/down-arrow	as	hotkey	alias	for	home/end	that	works	on	tables	when	search	field	is	focused,	during	incremental	search.	Prevended	'Update	Per-show	effects...'	from	overwriting	derived	fields	with	blank	fields.	Finale	Inventory	sync:	fixed	sync	bug	that	happened	with	effects	that	had	an	empty
caliber	field.	Added	documentation	link	to	help	menu.2019.11.06-53a743fc-finale3d-win32-installer	(RELEASE)	Tune	flash	trays.	Fixed	firing	system	exporter	device	count	for	chains.	Added	'Insert	row'	icon	for	button	in	script.	Add	icon	associations	for	.FDB	files.	Fixed	menu	UI	for	selecting	table	layouts	from	reports.	We	tried	to	do	this	whole	batch	of
new	columns	at	once	to	minimize	the	number	of	times	you	would	need	to	update	the	blueprints	saved	in	your	shows.	Tuned	motor	speed	functions	for	pre-defined	moving	head	fixtures.	Fix	layout	bug	on	Create	Account	dialog.	Fix	missing	fuse	trails	from	effects.	Show	effect	angle	in	tooltip	over	module	graphic	in	rack	layout	view.	Improved	DMX	error
checking	when	user	presses	play	button,	enabling	the	user	to	defer	setup	until	later.	As	a	workaround	you	could	also	change	the	effect's	type	to	'sfx'	bug	the	workaround	is	no	longer	necessary	with	this	release.	Implement	a	server-side	history	of	'My	Effects',	so	that	any	accidental	overwrite	can	be	recovered	from.	Made	show	importer	recognize	'Rail
Address'	as	a	column	header	to	help	Merlock	users	who	export	as	a	CSV	firing	system	and	then	import	and	re-export	as	Finale	Generic	for	their	old	Merlock	software.	Added	a	white	tip	at	the	bottom	of	empty	cue	flags	so	user	can	easily	identify	any	remaining	empty	cue	flags	in	a	dense	show.	Left/Right	cursor	keys	now	tab	between	cues	and	select
the	effects	at	the	cues;	works	well	with	the	choose	and	set	effect	hot	keys	C	and	E.	Fixed	minor	bug	in	which	'Used'	count	of	racks	didn't	get	updated	after	undo.	Improved	right	click	context	menus	for	Effects	Window	by	removing	r/w	functions	on	read-only	collections.	Implement	minimum	frame	rate	render	setting.2018.11.09-939b468a-finale3d-
win32-installer	(RELEASE)	Fix	a	crash	bug	for	certain	effects.	Tune	Titanium	Salutes.	Matrix	letters	have	option	to	flip	vertical	and	flip	horizontal.	Added	automatic	creation	of	position	groups	when	inserting	effects	into	multiple	position.	Pressing	ESC	while	editing	table	cell	reverts	edit	and	now	leaves	cell	selected.	Save	and	restore	current	window
arrangement	when	quitting	and	restarting	the	app;	and	use	default	arrangement	if	monitor	configuration	is	different	from	when	arrangement	was	saved.	Revamped	the	'Make	into	fan'	dialog,	adding	the	capability	to	make	fans	sorting	by	effect	time,	center	to	outside	or	outside	to	center,	and	adding	a	help	message	box	on	the	dialog	that	explains	what
all	the	options	do.finale3d-installer-2021.11.23-2eeff52af	(BETA	VERSION)	Added	Polish	UI	translation.	Fixed	spelling	error,	'Baraq'	->	'Beraq'	Fixed	very	minor	bug	in	which	it	was	possible	for	racks	to	be	sorted	differently	in	the	rack	table	after	saving	and	loading	show.finale3d-installer-2020.08.24-68ce619c8	(RELEASE)	Change	default	model
brightness	from	1.5	to	1.0.	Fix	some	crashes	in	effect	parsing/building.	Updated	Russian	and	Ukrainian	UI	translations.	Added	'With	Angle'	effect	for	setting	the	rest	angle	for	Explo	X2	Wave	Flamer	macros;	will	add	to	Showven	Circle	Flamer	and	Spark	Fabrica	MH	flamer	supplier	catalogs	when	promote	beta	to	full	release.	Changed	behavior	of	the
11	window	type	menu	items	at	the	bottom	of	the	Window	menu	to	always	bring	the	window	to	the	front	instead	of	toggling	it	between	visible/hidden,	which	is	more	useful	when	the	window	can	get	hidden	behind	others.	Added	'Admin	>	Update	language	translation	file...'	command	for	translators.	'Tools	>	Open	firing	system	script	as	generic	table'
now	shows	raw	data	for	Cobra	CSV	files.	Improved	importing	HBS	show	files	and	'File	>	Import	>	Import	effects	from	HBS	file'	for	shells	in	Finale	Business	whose	prefires	were	not	their	lift	times,	rounding	down	the	prefires	to	zero	so	they	aren't	misinterpreted	as	lift	times.	Improved	Russian	localization.	Made	cake	VDL	parser	more	robust	by	allow
firing	row	descriptions	to	include	only	the	firing	pattern	if	there's	only	a	single	effect	type	used	in	teh	cake,	as	opposed	to	requiring	the	effect	type	label,	as	in	(FNT)	Added	to	the	positions	menu	new	functions	for	creating,	selecting,	and	managing	groups	of	positions.	Made	'Re-align	cues	to	their	event	time'	align	at	the	latest	event	time	instead	of	the
earliest	of	cue,	so	the	first	break	of	the	cue	remains	a	t	the	same	time.	Added	generic	on/off	DMX	flame	projector	to	DMX	fixture	options.	Fixed	bug	with	locked	addresses.	Minor	improvements	to	default	catalog	of	parts.2017.09.09-0ad280f8-finale3d-win32-installer	(RELEASE)	Added	and	tuned	a	lot	of	new	color	names.	Fixed	unnecessary	safety
channel	warning	on	Showven	uFlamer	fixtured.	Sorted	effects	better	in	the	right-click	'Add	compatible	DMX	effect'	submenu,	and	added	separators	to	separate	the	different	kinds	of	effects	like	move-to	effects	from	with-gobo,	etc.	Change	the	per-show	setting	'Create	position	groups	manually'	to	a	per-user	settings	with	the	opposite	sense	and	default,
'Automatically	create	position	groups',	defaulting	to	off,	so	users	to	get	a	proliferation	of	yellow	position	group	flowers	on	the	left	side	of	the	screen	without	knowing	how	to	delete	them.	Made	editing	effects	in	read-only	collections	like	Generic	effects	write-through	the	changes	to	My	effects	and	to	open	shows,	adding	to	My	effects	if	doesn't	already
exist	there.	Updated	Hungarian	and	Brazilian	Portuguese.	Fixed	previewer	to	make	it	take	into	account	the	prefire	column.	Made	the	'Import	show'	function	include	the	Notes	2,	Notes	3,	Custom	Numeric	Field,	and	Alternate	columns.	Implemented	the	'File	>	Export	>	Export	sound	track'	command,	which	previously	did	nothing.	Added	mouse	cursors
for	navigation	modes.	'Sync	with	network'	will	now	sync	your	changes	up	to	Finale	Inventory.	Make	'thick'	and	'thin'	affect	charcoal	trails	Add	reflection	brightness	render	setting.	Changed	split-screen	views	to	be	divided	vertically	evenly	instead	of	2:3.	Fixed	'Replace	with	effect	from	effect	window'	and	'Replace	selected	events	with	this	effect'	right-
click	functions	and	the	control-shift-enter	replacement	hotkey	on	the	effects	window	and	the	'Replace	effect'	main	menu	item	to	handle	replacing	items	with	chains,	chains	with	items,	and	chains	with	chains,	while	preserving	angles	and	addresses	and	adding	or	removing	shells	if	the	chains	have	different	numbers	of	shells.	Added	'File	>	User	settings
>	Show	cost	instead	of	price	in	3D	view.	Reverted	menu	item	change	to	reverse	and	randomize	function,	M	and	shift-M,	poaching	hot	keys	from	the	letters	functions	for	the	new	addressing	functions	instead,	O	and	Q.	Added	right	click	context	menu	for	timeline	cue	flags.	Changed	the	way	'Add	racks'	works,	making	it	always	take	into	consideration
your	existing	racks	as	well	as	your	existing	effects	in	the	show	without	any	dependence	addressing	the	show;	you	can	delete	racks	first	if	you	prefer	to	start	from	scratch.	Added	help	menu	item	for	customizing	reports/labels.	Fixed	'Combine	as	cake'	for	cakes	with	FNT,	CTO,	or	OTC	firing	pattern	rows.	Made	minor	optimization	to	Pyromac	exporter
for	overlapping	DMX	events.	Minor	fix	to	effects	list	report.	Expanded	sort	criteria	for	labels	and	reports	to	eight	slots.	Now,	these	rows	get	choreography	tab	'Unspecified'.	Delighted	to	report	that	this	deficiency	is	finally	fixed.	Added	download-on-target	cursor	image.	Improved	VDL	parsing	robustness	so	it	is	more	flexible	in	reading	VDL	cake
descriptions,	to	improve	backward	compatibility	with	Finale	Business	VDL	cakes.	Hid	the	sort	indicators	on	tables	printed	to	pdf.	Added	support	for	user-defined	motor	speed	functions	in	DMX	patches.	Improving	naming	of	light	fixture	effects.finale3d-installer-2021.04.06-4eeba4e34	(RELEASE)CLICK	HERE	FOR	RELEASE	HIGHLIGHTS	VIDEO
IMPORTANT	NOTICE:	In	this	version,	please	no	longer	subtract	1	when	setting	'DMX	Channel	Base'.	Work-in-progress	Adding	'File	>	User	settings	>	Currency	symbol'	but	it	doesn't	work	yet.	Made	control-G	create	effect	function	fill	in	the	subtype	and	color	fields.	Fixed	slight	jiggling	of	events	on	timeline	due	to	rounding	error.	Change	installer
finish	button	to	read	'Run	Finale3D'.	Add	a	pre-export	check	to	see	if	show	is	missing	safety	channel	effects	for	DMX	fixtures	that	need	than,	and	display	instructional	dialog	if	so.	Current	implementation	affects	displayed	fields	but	not	input/output	fields,	which	currently	remain	in	the	standard	convention	up	=	0.	Added	user	settings	option	and
checkbox	on	the	voice	cues	dialogs	for	'One	voice	cue	per	track'.	Updated	Spanish	UI	translation,	work	in	progress.	Improved	'Make	into	sequence'	to	make	it	handle	sorting	angles	more	intuitively.	Made	'Break	apart	chain'	clear	the	'Chain	Device	VDL'	field.	Fix	bug	where	Google	Maps	images	were	mirrored.	Fixed	checkbox	elements	interactivity	in
the	add	racks	dialogs;	clicking	on	the	checkbox	itself	updated	the	row	content	but	clicking	on	the	checkbox	text	changed	the	checkbox	but	didn't	update	the	row	content.	Fix	colorized	material	loading	in	SketchUp.	Add	secondary	break	type	to	effect	editor,	set	soft	break	types.	Added	'Scenery	>	Set	window	to	standard	aspect	ratio...'	as	an	alternative
to	render	settings	because	it	is	such	an	important	feature	for	using	backdrop	images.	Fixed	PyroSure	exporter	errors.	Fixed	duplicate	parts	bug	when	refreshing	My	Parts	from	network.)Added	network	inventories	list	and	setNetworkInventories()	function.	Previously	user	would	need	to	fill	the	Module	Or	Slat	Type	column	also	in	the	locked	rows,	not
just	the	addresses.	Fix	bugs	relating	to	inventory	sync	and	fractional	quantities.2019.04.30-a0ac36e4-finale3d-win32-installer	(RELEASE)	Implemented	more	performance	and	responsiveness	improvements.	Fixed	Z-order	problem	when	user	clicks	on	parent	context	menu	that	is	partially	covered	by	child	context	menu.2017.08.30-bac4ff04-finale3d-
win32-installer	(RELEASE)	FireOne	import/export	works	again.	Update	Hungarian	UI	translation.finale3d-installer-2020.02.11-3dd3d7487	(RELEASE)	Made	'File	>	Import	>	Import	effects'	functions	create	new	part	numbers	that	do	not	conflict/overwrite	part	numbers	of	the	collection	that	you	are	importing	into,	to	facilitate	converting	batches	of
effects	from	Finale	Business	in	multiple	HBS	files.	Added	title	in	the	upper	right	of	design	view	to	explain	if	you	are	in	'Customize	Simulation'	mode	or	'Break	Apart	Cake'	mode	or	'Demo'	mode.	Fixed	word	placement	and	translation	handling	for	cakes,	candles,	slices,	and	single-shots	in	French	and	Spanish.	Made	'Add	racks'	function	show	a	message
'No	more	more	racks	required'	if	in	fact	no	more	racks	are	required.	Added	context	menu	item	for	clicking	on	ground	for	'Add	position	at	this	point'.	Use	default	firing	system	for	people	who	type	in	addresses	without	using	the	'address	show'	function.	finale3d-installer-2022.05.25-dc1d896ea	(BETA	VERSION)	Additional	minor	improvements	to	Cobra
export	dialog.	Remove	height	from	VDL	when	extracting	it	into	height	column.	Added	Jingduan	firing	system	exporter.	Made	'fan'	and	'w-shape'	and	other	firing	patterns	imply	the	effect	is	a	cake	automatically.	Added	a	helpful	dialog	after	user	sets	the	'show	image	under	horizon'	option	to	offer	to	set	the	aspect	ratio	to	standard	aspect	ratio,	letterbox
mode,	so	positions	aligned	to	the	image	will	align	correctly	in	videos.	Create	effect	macros	from	the	effect	menu,	store	them	in	your	effect	libraries,	and	click	on	them	to	insert	a	re-usable	piece	of	a	script,	similar	to	copy/paste.	Fixed	icon	generation	bug.	For	importing	HBS	files,	fixed	the	default	tip	color	for	HBO40,43,47,48,	to	red.	Added	labels
templates	for	Dymo	roll	printers	30336	and	30252	x	portrait	and	landscape	orientations.	Implemented	distance-based	falloff	for	break	flashes	lighting	up	the	whole	world.	Added	generic	DMX	safety	channel	fixture	type.	Added	helpful	dialog	to	prevent	people	from	trying	to	replace	chains,	since	that	doesn't	work,	and	to	tell	people	what	to	do	instead.
Save	and	restore	window	minimization	and	maximization	status	in	saved	window	arrangements.	Added	'Edit	this	effect'	menu	item	to	RMB	context	menus	on	parts	table.	Added	margin	at	edges	of	timeline	for	'Zoom	to	selected'	button	action	so	you	can	tell	that	selected	items	don't	etend	beyond	edges	of	the	window.)finale3d-installer-2020.03.23-
f4594c902	(RELEASE)	New	inventory	sync	process	and	UI.	Fix	bug	where	the	render	time	was	displayed	twice	in	the	double-size	previewer	view.	Fixed	problem	with	wrong	counts	in	the	position	filter	bar	on	shows	with	more	than	100	positions.	Updated	Hungarian	UI	translation.	Added	'Script	>	Add	time	variance...'	function	to	jitter	the	times	of	the
selected	events	to	make	the	sequence	less	robotic.finale3d-installer-2020.06.19-2f74f7103	(RELEASE)	Make	'Effects	>	Break	apart	cake'	function	apply	cake's	prefire	to	first	component	while	still	handling	lift	time	correctly,	for	cases	in	which	user	has	assigned	prefire	to	the	cake	that	is	different	from	first	effect's	lift.	Added	optional	dmxSpeedMin
and	dmxSpeedMax	parameters	to	:power	and	:rpower	functions	in	DMX	Patches.	Added	the	term	'Placeholder'	to	VDL	that	interprets	as	variegated	peony,	as	in	Business,	for	compatibility	so	default	Business	effects	don't	look	invisible.	Changed	Finale	Inventory	settings	dialog	to	go	to	the	specific	web	page	instead	of	finale3d	home	page.	Fixed
Pyrodigital	export	option	for	manual	scripts,	which	was	broken	in	our	initial	release	of	the	per-firing	system	export	options	dialog.	Added	'Reverse	Angle	HPR'	field	for	rack	reports	to	sort	angles	left-to-right.	Clear	the	undo	stack	after	loading/populating	effect	collections	so	that	control-Z/undo	doesn't	clear	them.	Added	16-pin	slat	option	for	fireTEK.
Added	hover	mode	for	effect	bar	effect	titles	that	changes	text	from	description	to	part	number;	and	added	option	to	show	part	numbers	by	default.	Fixed	minor	formatting	bug	in	rack	layout	view,	displaying	rack	size	=	1.8in	instead	of	1.811in,	removing	extra	precision.	Added	new	custom	camera	presets	buttons	on	right	of	screen.	Affected	firing
systems	are:	Cobra,	FireOne,	fireTEK,	Galaxis,	PTX,	Pyrodigital,	StarFire,	Firemaster,	Pyrosure,	FireByWire.	Fixed	a	'dropdown	not	working'	issue,	but	more	still	remain	to	be	fixed.	Added	large	playback	clock;	added	option	to	turn	it	off	in	show	>	options	menu.2017.12.28-19ab6f9a-finale3d-win32-installer	(RELEASE)	Improved	double-click-then-drag
text	selection	in	input	fields	for	selection	beginning	with	a	word.	Made	parts	window	effect	icons	be	the	insert	buttons,	and	added	hover	graphic	similar	to	effect	bar.	Fixed	parsing	of	French	'rouge	et	tronc'	and	that	general	pattern	for	non-English	effect	names.	Automatically	convert	'And'	to	ampersand	when	interpreting	VDL,	e.g.,	'Red	And	Blue
Peony'	-->	'Red	&	Blue	Peony'.	Make	importing	work	for	trial	users.finale3d-installer-2020.03.31-ed11076a0	(RELEASE)	The	function	'Racks	>	Add	racks	for	show'	now	lays	out	racks	grouped	by	rack	part	number,	not	just	by	size.	Improved	copy/paste	between	shows	to	add	per-show	parts	automatically	instead	of	putting	up	an	'Add	part	to	per-show
parts?'	dialog	after	the	fact.	Added	contextual	error	checking	and	instructional	error	messages	to	all	DMX	functions	to	make	it	easy	to	learn.	Added	error	checking	in	Pirotex	exporter	for	non-chronological	pins	on	AKM-10	slats.	Tune	ground	flare.	Fixed	Piroshow	exporter	DMX	channel	value	rounding	in	latest	release	which	caused	problems	with
Explo	X2	Wave	Flamer	macros.	Added	error	checking	in	addressing	operation	for	DMX	effects	with	conflicting	channel	ranges,	while	still	enabling	safety	channel	effects	and	flame	effects	to	be	on	similarly	configured	master	fixture	positions.	Improved	Pyromac	exporter	for	DMX.	Added	'Custom	Numeric	Field'	to	the	addressing	sort	and	constraint
options.	Fix	shell-of-shells	/	artillery.	Added	right-click	context	menu	on	rack	layout	background,	with	options	for	zoom	and	reset	view.	Added	'Interpret	chain	price	as	per-shell'	option	under	user	settings,	which	defaults	to	OFF;	when	OFF	a	0	chain	of	5	in	the	show	counts	as	0	not	0.	Fix	effect	editor	bug	causing	many	undo	steps	to	be	created	when
dragging	sliders.	Added	'File	>	User	settings	>	Click	action	in	effect	window'	with	options	for	select-row,	select-cell,	or	insert-effect.	Fixed	pop-up	menu	scrollbar	behavior	for	when	user	drags	cursor	outside	of	scrollbar	while	scrolling.	Fixed	height	of	'Create	video'	dialog	so	it	fits	on	short	displays.	Finale	Inventory	sync:	allow	the	Devices	column
(called	ChainNumberOfDevices	in	Finale	Inventory)	to	be	empty	rather	than	defaulting	to	1.	For	example,	"Red	Bowtie	w/	Green	Ring"	now	has	the	ring	properly	around	the	middle	of	the	bowtie.	Changed	ground	flare	and	bengal	effect	heights	in	Generic	Effects	to	1m.	Added	25-pin	standard	option	for	pin	board	addressing,	from	the	firing	systems
menu	on	the	addressing	dialog.	Improve	performance	and	stability	with	large	numbers	of	effects	onscreen	at	the	same	time.	At	last,	added	saved	user	settings!	Added	'Addressing	>	Report	missing	racks	as	errors'	setting	which	makes	it	easier	to	ignore	cakes	or	certain	sizes	of	effects	or	positions	as	far	as	racks	are	concerned,	without	addressing
errors	being	generated.	Fixed	import	effects	dialog	'Prefire	units'	selector,	which	didn't	work	in	some	circumstances.	Updated	Brazilian	Portuguese,	Polish,	Russian,	and	Ukrainian	UI	translations.	Fold	the	Launch	star's	duration	and	windFriction	into	Launch.finale3d-installer-2020.07.11-839bd9e1a	(RELEASE)	Added	checkbox	'Treat	missing	racks	as
errors'	to	the	addressing	dialogs,	giving	user	the	option	of	addressing	a	show	with	racks	for	some	effects	and	not	others	without	reporting	errors.	Fixed	the	description	field	formatting	in	rows	so	that	it	contains	ellipses	at	the	end	if	and	only	if	the	row	represents	multiple	devices	that	are	not	all	the	same;	no	ellipsis	if	they	are	the	same.	Fixed	bugs	with
importing	chains,	mostly	edge	cases	like	chains	of	single	devices.	Fixed	crash	bug	introduced	yesterday	wherein	printing	labels	to	a	show	that	has	a	defined	name,	not	just	a	filename,	would	crash.2018.08.16-6c877e3b-finale3d-win32-installer	(RELEASE)	Improvements	to	Spanish	effect	name	translator.	Added	windows	menu	preset	for
design+positions.	Added	addressing	sort	options	for	ANGLES-FIRST,	REVERSE	SIZE,	PAIRS	FIRST,	LONGEST	FLIGHTS	FIRST.	Update	the	position	pre-assigned	racks	when	user	changes	rail	numbers	of	rails	in	the	rack	layout	view.	Fixed	combine-as-cake	problem	with	narrow	fans	due	to	rounding	error.	Effect	editor:	Make	an	empty	string	in	the
VDL	field	of	the	effect	editor	cause	a	'magenta	comet'	to	appear	like	other	completely	unrecognized	strings	do.	Changed	DMX	patch	term	name	from	'prefireBeginEndPatch'	to	'setupBeginEndPatch'	but	still	support	old	name.	Added	angle	to	the	tooltips	on	rack	layout	screen.	Made	the	'Address'	field	of	labels	support	the	'Fancy	Address	Colors'	of
black	for	module,	red	for	pin,	even	when	the	field	contains	an	address	range	of	multiple	addresses.	Added	'Size	Or	Sleeve'	to	addressing	sort	options	on	addressing	dialog.	Minor	optimization	to	Mongoose	exporter	for	DMX	events	longer	than	10s.	Improved	DMX	Patch	capabilities.	Improved	Cobra	step-by-events	script	export	format	by	grouping
together	same-time	events	into	the	same	step.	EXPERIMENTAL:	clicking	on	grass	now	deselects	positions	if	no	effects	were	selected	at	time	of	click.	Fixed	importing	chaing	effects	with	'File	>	Import	>	Import	effecs	from	HBS	file'.	Added	menu	item	'Positions	>	Fix	position	names	(invisible	effects)...'	to	fix	any	script	events	whose	position	names



don't	match	actual	positions,	which	is	is	a	common	source	of	'Why	are	my	effects	invisible?'	confusion.	Changed	the	name	'Catalog	parts'	to	'Basic	parts'.	Fix	bug	causing	the	effect	editor	content	to	disappear	if	you	added	a	blank	launch	and	tried	to	edit	it.finale3d-installer-2020.07.22-c0e9c23e1	(RELEASE)	Fix	crash	bug	with	certain	effects	that	had
stars	that	end	in	reports.	Fixed	shift-page-up/down	behavior	in	table	views.	Fixed	crash	bug	that	occurred	when	clickign	the	'hide	rails'	link	and	then	hovering	over	a	rack	in	the	rack	layout	page.	Removed	the	type	variations	of	Custom	Numeric	Field	as	addressing	sort	terms.	This	release	is	the	first	public	beta	that	supports	'move-to'	effects	and	light
beams.	Make	ground	flare	and	flash	pot	both	be	silent.	Added	a	generic	1CH	light	fixture.	Make	'lemon'	color	less	orange.	Fixed	bug	in	GS2	export	in	which	dt	and	stepDelay	were	formatted	incorrectly	if	longer	than	60	seconds.	Brighten	the	default	playback	brightness	a	little	bit.	Made	StarFire	firing	system	export	use	union	of	item	notes	for
sequence	notes	instead	of	first	item's	notes.	Added	150	cakes	to	basic	parts.	Added	Galaxis	GS2	exporter	version	2.6,	including	device	table.	Fixed	and	verified	downloader	for	the	new	and	old	Pyrodigital	field	controllers.	Added	extension	to	Pirotex	exporter	that	interprets	'Custom	Position	Field'	as	'Channel	override'	for	AKM-10	slats	connected	in
series.	Remove	distance-based	particle	LOD	decimation.2018.12.29-97351410-finale3d-win32-installer	(RELEASE)	Fix	case	packing	and	'chains	count	as	one	unit'	Finale	Inventory	integration	bugs.	Dragging	cue	flag	with	associated	empty	and	non-empty	events	now	removes	the	empty	events.	Made	changing	rails	automatically	normalize
capitalization	for	firing	systems	with	HEX	addresses	or	letters	in	their	addresses.	Many	changes	to	the	renderer.	Added	'Show	>	Set	show	information...'	command	and	dialog.	Fix	bug	causing	some	trails	to	'blink	out	of	existence'	too	soon	(mostly	comets).	Changed	the	'Go	to	supplier	catalog	page	to	download	effects'	dialogs	to	offer	to	open	the	web
page	directly.	Added	'Combine	as	cake'	function	to	create	a	cake	from	a	selected	pattern	of	effects	on	the	timeline.	Implemented	cake	shot	timing	randomness,	with	a	toggle	on	the	render	config	dialog.	This	should	reduce	crashes	for	some	people.	Improved	error	message	when	exporting	a	DMX	script	using	Cobra	V5	to	explain	you	need	to	switch	to
Cobra	V6.	Option	in	File	>	User	settings,	to	support	multiple	monitors	for	window	layouts.	Made	'Create	chain	from	selected	events'	and	the	import	chain	functions	produce	more	succinct	VDL	when	shells	and	delays	are	all	the	same.	Filter	out	non-choreographed	effects	when	pulling	down	from	Finale	Inventory.	Added	instructions	dialogs	with	do-
not-show-again	options	for	main	menu	DMX	functions.	Added	import	setting	option	to	ignore	durations	of	effects	in	the	imported	file.	Improved	the	unchecked	'Treat	all	missing	racks	as	errors'	option	in	addressing	dialog	to	accommodate	multi-caliber	mortar	racks	property	for	error	reporting.	Re-enabled	writing	to	Finale	Inventory	account.	Fix
translation	templates	missing	some	strings.	Added	context	menu	commands	for	events	in	script	and	timeline	and	3d	view	for	'Select	this	effect	in	Effects	window'.	Added	user	setting	option	to	display	chain	quantities	as	per	shell	or	per	chain.	Fixed	cake	rack	definition	in	standard	parts	to	make	it	compatible	with	ground	effects.	Changed	timeline	UI
such	that	clicking	on	timeline	background	drags	timeline	instead	of	creating	a	selection	rect;	hold	shift	to	create	a	selection	rect.	light	is	for	stage	lights	and	moving	lights,	which	are	not	yet	implemented.2019.09.18-36fb0a1f-finale3d-win32-installer	(RELEASE)	Switch	video	encoding	to	use	VP9	encoder.	Added	'Set	chain	angles'	function	that	lets	you
enter	a	list	of	angles	and	applies	them	to	all	selected	chains.	Made	DMX	fixture	positions	appear	as	blue	boxes	instead	of	yellow	disks,	for	pyro.	Fix	some	effect	editor	crashes,	and	make	the	effect	editor	faster/more	responsive.finale3d-installer-2020.06.28-5f30eac6b	(RELEASE)	Fixed	crash	bug	for	chains	larger	than	100	shells,	crashing	in	labels
printing.	Added	support	for	multi-effect	roman	candles.	'Create	cake	effect	from	selected	items'	adds	'XXX	Degrees'	to	calculated	VDL	to	incorporate	the	cake	fan	angle	correctly.2019.10.18-6a64b32d-finale3d-win32-installer	(RELEASE)	Add	movie	encoder	dropdown	choice	to	render	movie	dialog.	Make	terrain/sky/model	brightness	a	text	entry
parameter	in	render	settings	dialog	rather	than	a	dropdown.2017.10.30-ac4134c6-finale3d-win32-installer	(RELEASE)	Added	effect	bar.	Added	ghost,	smiley,	and	heart	to	generic	effects.	Added	new	timeline	feature	--	ability	to	stretch	durations	of	groups	or	selections	sets	by	dragging	hotspot	at	right	end	of	timeline	bar.	Fixed	labels	formatting	bug	in
which	fields	disappeared	when	user	set	padding	wider	than	width	of	field.	Added	preflight	information	to	the	'Update	Per-show	effects...'	dialog	so	yu	know	if	there	would	be	changes.	Made	the	quota	cells	in	the	effect	window	turn	green	or	red	depending	on	whether	used	exceeds	quota.	Made	'File	>	Import	>	Import	effects	from	HBS	file'	work	for
parts	that	have	duplicate/blank	part	numbers.	Re-tuned	the	sky	image	adjustments	for	the	default	image,	stretching	the	image	horizontally	to	reduce	the	black	area	in	the	rear	and	increasing	the	darkening	at	the	edges	which	is	possible	for	the	larger,	stretched	image.	Fixed	but	we	introduced	in	Explo	X2	Wave	Flamer	effects	in	the	last	beta	release
when	changing	DMX	Patch	terminology	from	'prefire'	to	'setup'.	Improved	backdrop	image	adjustment	dialog.	Added	the	page	break	conditions	to	the	title	of	the	labels	pages,	so	for	example	if	you	have	page	breaks	on	universe	or	module,	the	title	of	the	page	will	indicate	the	universe	or	module	shown	on	the	page.	Changed	script	context	menu	item
'Replace	effect...'	to	'Replace	with	effect	from	effects	window'	to	start	moving	away	from	the	popup	effect	chooser	window	while	improving	the	usability	of	the	main	effects	window.	Draw	timeline	bars	in	the	color	of	light	effects	for	DMX	fixtures.	Fixed	several	problems	with	multi-part	effects.	Added	rack	summary	page	showing	existing	and	added
racks	resulting	from	'Add	racks'	functions.	Removed	the	export	warning	for	'round	to	resolution'	but	kept	the	troubleshooting	menu	item	in	case	you	care.	Changed	hotkey	for	'Rotate	cakes'.	Change	scene	lighting	parameters	to	be	less	dark.	Fixed	printing	crash	bug	on	the	'Special	reports	>	Effects	Collection	Product	Report'.	Yes,	somebody	asked	for
this	change	too.	Fixed	minor	bug	in	'Flights	>	Make	flights	or	chains	into	fans',	which	previously	could	get	chain	shells	out	of	order	in	some	circumstances.	Make	effect	editor	only	accept	valid	effect	types.	Fix	bug	affecting	a	FireOne	and	other	MDB-based	firing	script	exporters.2018.11.09-679741ce-finale3d-win32-installer	(RELEASE)	Added	'Effects
>	Break	apart	assortment	quotas	for	Finale	Inventory	users.'	Added	automatic	break	apart	and	recombine	assortment	quantities	to	the	update	from	and	to	Finale	Inventory	sale	order	functions.	Fixed	'Replace	effect'	bug	wherein	applied	effect	is	blank	if	effect	isn't	already	present	in	show	and	if	show	has	a	quota	for	the	effect.	Fixed	tube	order	bug	in
'Combine	as	cake'	for	right-to-left	slice	cakes.	Fix	bug	causing	inventory	sync	to	fail	if	the	target	inventory	has	0	products.	Added	drag-and-drop	cursor	image.	The	'Make	into	sequence'	and	'Spread	out	evenly/accelerating/etc.'	dialogs	now	save	the	state	of	the	grouping	checkbox	so	you	don't	need	to	check	it	every	time,	and	also	automatically	check	it
if	any	groups	from	the	combine-as-group	action,	g-key,	exist	in	the	selected	effects,	since	you	generally	always	want	to	keep	them	together.	Added	DMX	support	for	the	Hansol	Volcano	flame	system.finale3d-installer-2021.11.17-64adbec3c	(RELEASE)	Added	'Load	into	racks'	button/function	to	the	rack	layout	window,	enabling	user	to	load	items	into
racks	after	then	have	firing	system	addresses.	Changed	interpretation	of	prefire,	such	that	prefire	<	0.5	is	interpreted	as	a	fuse	delay,	and	prefire	>=	0.5	is	interpreted	as	a	lift	for	aerial	shells.	Updated	Brazilian	Portuguese	UI.	This	should	be	faster	for	most	people.	Fixed	bug	that	import	show's	configuration	dialog	appeared	blank	if	no	shows	were
open	at	the	time	of	doing	the	import	show.	Tune	launch	angle	spread.	Added	new	window	arrangement	#0,	which	puts	the	effects/inventory	in	a	window	*above*	the	design	view	and	script.	Clicking	on	a	specific	tube	in	a	rack	in	rack	layout	view	now	scrolls	to	that	specific	event	in	the	script	window	rather	than	just	the	first	event	in	the	rack.	Decrease
the	default	launch	angle	random	spread	a	little	bit.	Add	'configure	Finale	Inventory	connection'	menu	item.	Updated	and	reduced	help	menu	pages.	Made	'Prefire'	and	'Duration'	field	values	optional	in	effects	window,	for	cleaner	integration	with	Finale	Inventory	for	when	effects	don't	have	defined	values.	Fixed	a	different	tube	order	bug	in	'Combine
as	cake'.2019.09.20-db3d85e7-finale3d-win32-installer	(RELEASE)	Updated	Italian	UI	translation.	Fix	the	'Set	ground	to	Google	Maps'	feature,	which	had	broken.	Replace	magnifying	glass	icon	and	its	zoom	function	with	home	icon	that	resets	to	initial	view.	Added	'Dummy	Cue'	to	Generic	Effects	collection,	to	use	for	dummy	script	rows	that	do	get
firing	system	addresses.	Add	ability	to	edit	Finale	Inventory	products	from	Finale	3D.	Fix	crash	that	occurred	when	inserting	an	effect	with	certain	non-ascii	characters	in	its	description.	Fixed	PDF	report	generator	for	supporting	Euro	and	Pound	and	other	currency	symbols.	Improved	the	Angles*	column	to	make	it	better	in	printed	reports.	Support
'Stock	#'	as	an	alias	for	part	number,	for	importing	ShowSim	inventory	files.2019.03.08-64b114e6-finale3d-win32-installer	(RELEASE)	Fixed	crash	bug	that	occurred	when	importing	effects	file	that	is	missing	a	part	number	column,	merging	into	an	existing	effects	file.	Made	'Import	show'	function	support	Pyromate	SmartShow	CSV	script	format.
Changed	the	timeline	UI	to	make	selection	rect	easier.	Support	importing	HBS	chains	of	compound	effects	like	shells	with	bouquets.	Changed	cake	and	candle	prefire	to	be	the	prefire	of	the	first	effect,	not	a	fuse	delay	prior	to	the	first	launch.	Added	a	large	section	of	conditional	formatting	options	to	reports	for	changing	the	formatting	of	cells	or
rows	based	on	user-defined	criteria.	Fixed	bug	with	'One	voice	cue	per	track'	feature,	applying	to	tracks	for	which	first	event	time	is	not	from	the	event	that	has	the	first	effect	time.	Add	ground	strobe.2018.10.15-115df580-finale3d-win32-installer	(RELEASE)	Recognize	m/m	as	meaning	millimeters	in	effect	parser.	Added	'File	>	User	settings	>	Pasted
events	include	rail,	pin,	and	rack	addresses'	which	give	you	the	choice	of	whether	copy/pasting	includes	the	addresses,	which	is	useful	if	you	are	copying	from	Excel,	or	does	not	include	addresses,	which	is	the	default	and	the	current	behavior.	Added	'Print	>	Report'	menu	to	File	menu,	which	now	works.	Improved	table	layout	menu	item	names	to
make	them	more	understandable.	Import	effects	functions	now	use	current	language	setting	for	importing	default	subtype	and	color	fields,	instead	of	guessing	the	language	based	on	other	words	in	the	descriptions,	which	was	often	a	bad	guess.	Made	clicking	a	filled	pin	square	on	a	rail	in	the	rack	layout	view	select	just	the	events	addressed	to	that
pin	and	unselect	all	others.	Added	check	and	confirmation	dialog	for	writing	to	Finale	Inventory	account.	Added	cancel	box	to	full	text	search	box	on	table	windows.	Changed	DMX	fixture	DMX	patches	for	ADJ	Fog	Fury	Jet	to	turn	fot	jet	on	at	the	same	time	as	lights.	Changed	AUTO-FIRE	to	AUTOFIRE	in	exported	Cobra	script.	Force	loaded	SketchUp
models	to	have	their	origin	at	the	bottom	center	of	their	bounding	box.	Show	an	error	if	you	try	to	login	to	the	client	and	your	email	address	has	not	been	verified.	Make	prefire	override	from	VDL	or	table	column	work	in	the	effect	editor.	In	rack	layout	window,	hovering	cursor	over	pin	numbers	in	rail	graphic	will	highlight	all	script	rows	associated
with	that	firing	system	pin.finale3d-installer-2020.03.27-2b7038895	(RELEASE)	PLEASE	NOTE:	This	release	adds	new	columns	to	the	effects	window,	and	because	of	this,	you	will	be	prompted	to	sync	your	changes	to	My	Effects,	even	though	you	have	not	made	any	changes.	Fix	bug	where	wind	microcurrents	were	disabled	to	the	left	of	Origin	Man.
Fix	bug	from	Jon	Loreto	around	using	mine	breaks	in	the	sky.finale3d-installer-2022.04.27-c99e9adbf	(BETA	VERSION)	THIS	IS	THE	FIRST	PUBLIC	BETA	RELEASE	WITH	THE	NEW	EFFECT	PARSER	AND	EFFECT	EDITOR	CHANGES.	Add	'sfx'	and	'light'	products	to	Finale	Inventory	sync.finale3d-installer-2019.11.17-170eec88b	(RELEASE)	Added
full	set	of	features	for	users	to	import	their	own	background	images.	Make	the	effect	editor	placement	and	topmost	logic	work	like	other	windows.finale3d-installer-2022.02.07-401796f92	(BETA	VERSION)	Added	text	wrapping	option	for	label	fields.	Added	size	filter	to	the	effect	palette.	Made	'Whistles'	aerially	ambiguous	so	it	is	interpreted	as	small
rockets	in	context	of	a	cake	and	aerial	shell	payload	outside	of	context	of	a	cake.	See	documentation	page	for	more	info.	The	effects	are	added	to	Generic	Effects	and	they	generate	the	correct	DMX	output	for	the	channels	but	we	do	not	yet	have	visualization	of	lights	so	the	rendering	stand-in	is	ground	strobes	and	flares,	which	look	terrible	but	which
do	enable	you	to	script	DMX	shows	with	stage	lights	of	this	type.	Delighted	to	report	that	this	deficiency	is	finally	fixed.finale3d-installer-2021.09.17-f684ccb07	(BETA	VERSION)	Updated	Brazilian	Portuguese	UI	translation.	Added	'Script	>	Time	adjustments	>	Speed	up	cadence	at	end',	which	adjusts	the	timing	of	an	existing	sequence	to	accelerate
toward	a	crescendo.	Minor	fix	to	PyroDigiT	exporter,	for	reporting	warnings.	Fixed	the	red	underline	underneath	the	selected	blueprint	puzzle	piece	icon.finale3d-installer-2020.06.03-2f54f260a	(RELEASE)	Fixed	bug	that	occurred	when	trying	to	sync	very	large	My	Effects	inventories.	Added	4-pin	and	8-pin	module	types	for	RJ	Equip	firing	systems.
Changed	max	positions	insertable	at	one	time	from	the	menu	from	400	to	10000.	Added	'Script	>	Chains	>	Renumber	chains...'	to	support	the	new	chain	reports	documented	Made	'Add	time	variance...'	function	round	times	to	timeline	snap-to	resolution	if	in	effect.	Added	'Effects	>	Break	apart	assortment	quotas'	menu	item.	Improved	the	dialogs	and
undo	functionality	for	renaming	positions	by	editing	directly	in	the	positions	window,	with	new	functionality	that	updates	script	rows	that	reference	the	renamed	positions.finale3d-installer-2021.08.02-85a2f2ed1	(BETA	VERSION)	FINALE	INVENTORY	USERS:	Moved	'Finale	Inventory'	submenu	from	the	'Effects'	menu	to	the	'File'	menu.	Improved
header	text	of	'Add	racks'	dialogs	to	tell	you	how	many	existing	racks	you	are	already	have	(if	you	are	not	doing	the	add	racks	operation	that	preserves	existing	racks.	Make	mine	layers	closer	together.	Added	'Request	trial	license'	link	in	upper	right	if	running	in	demo	mode.	Added	'Zoom	to	selected'	button	on	timeline,	or	hold	shift	to	zoom	full	out.
Change	time	format	from	hh.mm.ss.ddd	to	hh:mm:ss.ddd.	Reset	maximization	status	of	hidden	windows	when	invoking	predefined	window	arrangement	presents,	to	avoid	previously	maximized	and	hidden	windows	reappearing	as	maximized.finale3d-installer-2021.06.21-850a2677d	(BETA	VERSION)	Added	'Images	window'	hot	key	in	'Window'	menu;
added	'Window	>	Set	main	window	to	>	Images	window'	option	also,	which	was	missing.	Added	front/top/side	camera	preset	buttons	on	right	of	screen.	Made	'Clear	rack	assignments'	NOT	clear	the	address	'locked'	flag.	Previously	there	were	some	bugs	that	made	it	impossible	for	a	user	to	use	the	collection	filter	to	resolve	conflicting/same	part
number	ambiguities.	Effect	editor:	Remove	bug	causing	effect	values	to	'jitter'	around	values	when	being	edited.	Added	two	new	addressing	sort	options:	Fan	Flights	First,	and	Fan	Flights	Last.	Added	error	messages	to	the	'Add	racks'	dialog	when	user	attempts	to	select	a	rack	whose	Rack	Type	doesn't	match	the	effects.	Fix	bug	where	high	wind
speed	was	causing	very	exaggerated	wind	turbulence.	---	Added	script	notes	feature	for	Cobra	exports	--	script	rows	with	a	'Note'	field	but	not	containing	'Part	Number'	field	are	included	as	note	rows	in	exported	Cobra	scripts.	Spanish	effect	name	improvements.	Added	explanation	dialogs	to	prevent	user	from	trying	to	use	effect	editor	on	cake	sim,	or
on	chain	sim.	Draw	the	rack	number	above	the	rack	when	cursor	is	over	rack	in	racks	view.	Effect	Editor:	Hide	the	'shot'	node	when	there	is	a	single	shot	node	in	the	tree.finale3d-installer-2022.05.18-e4afd1105	(BETA	VERSION)	Various	improvements	to	the	Mongoose	exporter.	Parts	file	menu	moved	to	be	submenu	of	the	blue	selector	of	teh	catalog
window	itself,	to	consolidate	functionality	in	one	place.	Fix	effect	parsing	crash	bug.	Internally	separated	DMX	addressing	functions	from	pyro	addressing	functions,	to	enable	completely	decoupling	them	in	the	user	interface.	Tune	down	default	speed	of	mines.	Improved	visual	styling	of	table	windows	by	adjusting	font	size,	padding,	and	contrast	of
font	colors.	Added	table	layout	blueprints	in	the	gear	menu	of	the	effect	window	for	all	the	quantity	filters	--	all_effects_used,	all_effects_having_quota,	all_effects_used_or_having_quota,	quota_positive,	quota_negative,	quota_not_zero,	available_positive,	available_negative,	available_not_zero,	available_10_or_more,	available_less_than_10.	Fixed	minor
selection	bugs	for	selecting	groups	in	3D	window	and	using	selection	rects.	Fixed	bug	with	the	'angles	first'	and	'angles	last'	sort	options	for	reports	and	addressing.	Added	two	new	Part	Types:	sfx,	and	light.	First	two	example	customizable	reports	are	setup-by-module	and	angle_count_per_module,	accessible	from	File	>	Print.	Added	end	caps	to	the
playhead	image.2017.11.20-34ce9871-finale3d-win32-installer	(RELEASE)	Support	min/sec	time	format	shortcuts	like	10:10	to	be	read	as	10m10s	instead	of	10.1s.	Added	optional	Parente	Firemaster	per-show-setting	of	firemasterSequenceNumberOffset.	Improved	effect	name	parsing	handling	of	slash	and	backslash.	Made	effect	window	auto-
dismiss/close	when	user	inserts	or	replaces	an	effect	if	effect	window	was	invoked	by	'C'.	Fix	broken	link	in	signup.2017.10.03-5b75d507-finale3d-win32-installer	(RELEASE)	Fix	several	effect	rendering	bugs.	Made	'enter'	key	invoke	the	effects	window	from	design	view.	Updated	speeds	of	MARQ	moving	head	DMX	fixture.	Added	a	new	DMX	Fixture
Type	for	Galaxis	Safety	Channel	and	Flamaniac	Safety	Channel,	since	those	two	flame	systems	have	safety	channels	that	can	be	configured	independently	of	the	fixture's	fire	channels	and	thus	need	to	be	in	separate	positions.	Fixed	price	field	in	PyroShow	firing	system	export.	Added	Romanian	language	option	in	preparation	for	adding	Romanian	UI
translation.	Made	the	function	'Set	tracks	based	on	groups	sequentially...'	be	based	on	event	time	instead	of	effect	time;	and	made	the	function	support	adding	leading	zeros	to	the	track	numbers	if	the	user	selects	it	on	the	dialog.	ALL	USERS:	Moved	'Effects	files'	submenu	from	effect	window	collections	drop-down	list	to	the	main	'File'	menu.	It	now
shows	the	locations	of	all	Finale	Inventories	you	are	connected	to.	Changed	number	of	digits	for	pins	in	Pyromac	exporter.	Added	new	VDL	term	LFT	to	specify	the	lift	delay	of	an	aerial	shell	explicitly,	for	cases	in	which	user	wants	it	to	be	different	from	a	prefire	>=	0.5.	Example:	10s	RC	4.0	PFT	Red	Peony	3.0	LFT	1.0	DLY,	which	is	a	roman	candle
with	a	1s	delay	before	launch	and	3s	delay	in	the	air.	Added	RMB	context	menu	on	positions	for	'Set	as	reference	position	for	rulers.	Fix	bug	causing	certain	effects	to	not	be	rotated	when	the	position	is	rotated.	Made	VDL	parser	accept	'25	FAN'	or	'25	Z'	or	'25	STR'	as	shorthand	for	25	shot	fan,	z,	or	str;	also	added	'st'	as	an	abbreviation	for	shot.
Removed	insert	icon	in	upper	right	corner	of	design	view.	Made	the	available	and	on_hand	cells	in	the	effect	window	turn	red	if	remaining	quantity	goes	negative.	Tune	airburst.2019.03.07-8423149b-finale3d-win32-installer	(RELEASE)	Improve	memory	usage,	fix	some	crashes	that	were	due	to	running	out	of	memory.	Minor	improvements	to	the
'DMX	>	Create	DMX	effect'	dialog	to	make	it	easier	to	use.	3d	nav	operations	from	clicking	on	models	will	now	deselect	events.	Add	launch	menu	items	to	the	effect	node	when	it's	in	single	shot	mode.	Fixed	rounding	error	issues	in	'Combine	as	cake'.	Made	EasyRacks	try	harder	to	create	single	shot	racks	with	all	rows	lengths	the	same,	even	if	that
means	making	the	maxtrix	of	tubes	more	rectangular,	less	square.	Changed	behavior	of	the	11	window	type	menu	items	at	the	bottom	of	the	Window	menu	to	always	bring	the	window	to	the	front	instead	of	toggling	it	between	visible/hidden,	which	is	more	useful	when	the	window	can	get	hidden	behind	others.finale3d-installer-2021.06.09-e5ecf3b7f
(RELEASE)Release	Highlights	Video	Added	'Scenery	>	Background	images	>	Set	backdrop	image...'	as	a	simple	way	to	import	background	images,	similar	to	how	Finale	Business	worked.	Added	new	Anonymous	Small	Steel	Can	moving	head	gobo	light	fixture	DMX	support,	Standard	Fixture	ID	059.	Added	CONTAINSSUBSTRING	function	to
conditional	formatting	expression	language.finale3d-installer-2021.11.19-117265cce	(BETA	VERSION)	Widened	menus	on	report	config	dialogs.	The	new	Effect	Editor	is	an	alpha-level	feature,	you	may	need	to	stay	on	an	older	version	if	you	need	to	edit	effects.	Made	simple	'Ok'	dialogs	close	automatically	if	user	clicks	on	any	other	window,	to	prevent
them	from	locking	up	the	interactivity.2019.05.24-b61bf5e1-finale3d-win32-installer	(RELEASE)	Fixed	crash	bug	in	'Add	racks'	function	that	applied	if	show	contains	invalid	part	numbers	that	do	not	have	parts	in	the	Per-show	parts	list.	Fixed	crash	bug	when	Hobbyist	or	Free	Trial	user	attempts	to	do	rack	layout,	which	requires	the	Pro	version.
Added	translation	improvements	for	Russian	effect	names.	Fixed	minor	bug	with	user	setting	for	cue	flags	visibility;	checkbox	was	wrong	and	menu	item	didn't	work	the	very	first	time	used.	Fixed	checkmarks	on	Windows	menu.	Additional	improvements	and	changes	to	French	effect	name	translations.2018.04.11-7b2c074d-finale3d-win32-installer
(RELEASE)	Added	full	Spanish	translation	of	all	VDL	terms.	Made	effect	durations	in	script	be	references	to	durations	of	the	effect	definitions	in	the	parts	file,	instead	of	copied	by	value,	for	all	effect	types	other	than	flame	and	other_effect	and	not_an_effect,	which	may	require	the	ability	to	change	the	duration	on	a	per-instance	basis	in	the	script.
Improved	the	stability	of	the	rows	in	the	'Add	racks'	dialog	for	situations	involving	fits-any-size	racks	being	shared	among	multiple	rows,	preventing	the	disabled	statuses	from	jumping	around	when	the	user	is	making	selection	of	rack	for	each	row.	If	paste	or	insert	rack	right	on	top	of	an	existing	rack,	shift	the	newly	inserted	rack	slightly	so	you	can
see	that	you	have	a	stack.	Moved	insert	button	column	on	part	window.2017.10.02-141348ba-finale3d-win32-installer	(RELEASE)	Improve	rendering	performance,	particularly	high	quality	mode.	Changed	UI	paradigm	such	that	now	rulers	are	always	displayed	whilst	positions	are	unlocked.	Added	black	outline	on	default	button	at	base	of	dialog	when
input	field	has	focus.	Added	'hand'	navigation	button	for	panning	mode.	Change	behavior	of	'cut'	and	'delete'	in	design	view	to	remove	subtrees,	i.e.,	positions	attached	to	deleted	models	and	effects	at	deleted	positions,	instead	of	just	detaching	them.	Updated	Anonymouse	5	Head	Flamer	DMX	Patches	to	enable	rotating	the	flame	effects	in	the	user
interface.	The	UI	now	supports	a	workflow	that	feels	a	lot	like	Finale	Business.	Improved	the	'Address	show'	summary	for	any	flame	system	by	not	including	flame	shots	in	the	e-match	count.	Added	30	channel	FireOne	option	so	users	don't	need	to	make	a	custom	module.	Added	tooltips	for	rack	pins	in	rack	layout	window	showing	effect	name	and
size.	Added	menu	item	'Change	fixture	and	convert	effects'	to	be	able	to	change	the	type	of	a	DMX	fixture	such	as	from	Explo	to	MagicFX	and	to	automatically	convert	all	effects	in	the	show	over	to	the	new	fixture	type.	Added	collection	selector	to	'Edit	effect/rack	VDL'	dialogs,	defaulting	to	active	collection.	Fix	issue	causing	cake	icons	to	be	rendered
from	very	far	away.	Tuned	spinners	to	look	more	natural.	Fix	bug	with	adding	a	product	to	a	Finale	Inventory	when	the	product	already	exists	in	the	inventory	as	a	non-choreographed	part.	The	observer/camera	is	now	correct	and	sounds	like	it	does	when	you	play	the	show	inside	Finale3D.	Added	a	check	for	overlapping	DMX	channel	ranges;	check
occurs	when	you	play	the	show.	Widened	module	type	selector/menu	in	position	properties	dialog.	Tune	'palm'	shells.	Prompt	to	sync	unsaved	finale	inventory	changes	on	exit.	Added	Ukranian	localization.	Made	Explo	exporter	support	shows	longer	than	60min.	Implement	new	logic	for	keeping	certain	windows	on	top	of	other	windows.	Added	a	'hang
reporter'	(like	the	crash	reporter)	that	will	let	us	diagnose	cases	where	Finale3D	hangs.2018.02.12-9e0ae91a-finale3d-win32-installer	(RELEASE)	Improved	basic	effects	list,	adding	cakes	and	rounding	duration,	prefire,	height	to	one	or	two	digits.	Updated	Polish	translation.	Added	a	new	optimization	to	the	DMX	script	exporter	that	reduces	the	size	of
the	script	10-20%	on	most	DMX	capable	firing	systems.	Improved	DMX	effect	names	and	grouping	in	menus	of	fixed	angle	effects	for	MagicFX	Flamaniac,	Anonymous	5-head	flamer,	and	Showven	uFlamer	Vulcano.	Added	Pyrolamas	racks	supplier	catalog.	Added	pitch	and	roll	columns	to	script,	to	show	the	effect	angle	in	an	alternative	representation
that	is	needed	for	some	single	shot	racks.	Fixed	Ukrainian	Hyvernia	currency	symbol	and	Russian	Ruble	currency	symbol	in	printed	reports,	removing	them	instead	of	printing	a	question	mark.	Updated	Russian	and	Ukrainian	translations.	Fixed	error	messages	when	adding	DMX	effect	to	pyro	position.	Fixed	bug	wherein	English	-->	VDL	translation
changed	valid	VDL	terms	like	bouquet	-->	mine.	Change	progressive	render	framerate	target	to	60	fps,	which	results	in	more	flicker	while	scrubbing,	but	also	more	responsiveness.	Added	filter	selector	to	'Add	racks'	dialog	to	limit	rack	choices	to	a	specific	collection.	Made	position	properties	dialog	reset	moduleType	when	user	changes	firing	system.
Import	parts	now	inherits	the	selectors	from	the	previously	active	parts	window.2017.09.07-67242ee0-finale3d-win32-installer	(RELEASE)	Fixed	bug	where	'silver	tipped'	(but	not	'silver	tip')	effects	had	a	default	trail	color	of	gold	instead	of	silver.	Added	ability	to	customize	rack	layout	and	site	layout	printed	diagrams	from	the	gear	menu	of	the	rack
layout	window.	Made	combine-as-cake	handle	parallel	firing	rows.	Fixed	bug	with	importing	hbs	files	wherein	candles	were	imported	without	a	part	type	and	thus	invisible.	Fix	scale	bug	in	"Add	Ground	Image".	Fixed	crash	bug	on	addressing	with	modules	constrained	to	rack	clusters.2017.10.18-efcd71df-finale3d-win32-installer	(RELEASE)	Add	more
color	variation	to	silver	fountains/gerbs.	Fix	'license	valid	through'	date	display	logic.finale3d-installer-2020.04.03-f9e2a3ace	(RELEASE)	Removed	rack	palette	from	rack	layout	window,	on	the	theory	that	the	effects	window	itself	is	now	adequate	as	a	palette	for	inserting	racks.	Widened	the	context	menu	for	selecting	the	part	in	the	'Add	racks'	dialog,
and	added	the	rack	descriptions	to	the	menu	items,	not	just	part	number	and	collection.	Add	prompt	to	sync	'My	parts'	when	shutting	down	app.2018.01.18-f44cf545-finale3d-win32-installer	(RELEASE)	Fixed	crash	bug	wherein	displaying	rack	window	for	the	first	time	would	crash	if	a	single	position	was	selected.	Clear	assignments	to	racks	when	they
are	cut	or	deleted	from	the	rack	layout	window.	Added	'Group'	as	a	constraint	option,	enabling	user	to	use	groups	to	control	what	sets	of	effects	at	the	same	time	and	launch	position	are	e-matched	in	series	to	the	same	pin	by	setting	'Max	e-matches	per	pin'	to	a	large	value	and	then	adding	'Group'	as	a	'Pin	Constraint'	on	the	addressing	dialog,	and
putting	items	meant	to	be	e-matched	together	into	the	same	groups.finale3d-installer-2020.03.14-faa75bec6	(RELEASE)	Fix	render	bug	causing	fountains	to	be	cut	off	'instantly'	at	the	end	of	their	duration.	Added	Mongoose	firing	system	exporter.	Added	an	option	to	display	rack	numbers	in	the	rack	layout	view,	'Show/hide	rack	numbers',	which	is
another	link	in	the	upper	left	of	the	window.	Added	Weight	and	NEQ	columns	to	effects	window	and	script	window.	Improved	'permissions	explanation'	dialog,	which	should	hopefully	make	it	more	clear	what	happened	if	you	are	getting	Trial	mode	all	of	a	sudden.	Added	real-time	pin	counts	and	module	counts	per-position,	available	from	the	'Show'
menu.	Added	single_shot_setup_by_module_with_pan_tilt_angles	and	single_shot_setup_by_module_with_pitch_roll_angles	reports.	This	fixes	a	crash	in	the	building	of	crackling	fountains,	glittering	fountains,	etc.	Provided	option	to	turn	voice	cues	on	during	playback	while	scripting,	as	user	setting.	Record	a	flag	if	user	declines	so	as	not	to	harass	user
every	time	the	show	is	opened.	Automatically	save	current	table	layouts	when	quitting	application,	and	restore	when	launch,	similar	to	window	arrangements.	Improved	the	dialogs	and	undo	functionality	for	renaming	positions	by	editing	directly	in	the	positions	window,	with	new	functionality	that	updates	script	rows	that	reference	the	renamed
positions.	Made	cakes	like	'75mm	10	shot	cake	red	comet	+	blue	mine'	preserve	relative	effect	heights.	Allow	track	fields	that	begin	with	text	followed	by	a	number	to	be	interpreted	as	the	number,	e.g.,	'T9'	-->	9.	Minor	change	to	Explo	SHW	export	format,	exporting	position	in	the	Position	column	instead	of	the	Pos	column.	Added	generic	DMX	safety
channel	effects	for	flames	with	channel	values	128,	180,	and	255	to	accommodate	safety	channel	active	value	ranges	on	different	hardware.	Made	the	'Hide	palette'	and	'Hide	generic	effects'	buttons	on	rack	layout	palette	remain	ideal	font	size	even	when	palette	is	shrunk	down	because	it	is	wide,	so	the	buttons	don't	become	unreadable.	Added	NULL
terminator	to	Pyrodigital	PDM	files	to	make	them	compatible	with	external	downloaders	to	the	FC-E	Raptor.	The	'Make	into	sequence'	dialog	now	calculates	the	initial	default	duration	to	be	the	initial	time	range	of	the	selected	effects.	Added	'Click	action	for	positions	in	Design	Window'	user	setting	to	turn	off	the	automatic	collection	switching	if	you
don't	want	it.finale3d-installer-2022.02.24-ff3bdf693	(BETA	VERSION)	In	Cobra	exporter,	exclude	part	number	in	braces	and	fixture	ID	in	brackets	in	the	description	field	for	DMX	events,	to	create	more	room	within	the	character	limit	for	the	DMX	channel	labels.	Fixed	import	and	create	effect	bug	in	which	descriptions	with	no	recognized	terms
would	yield	an	errant	duration	value.2019.05.28-a90c0aac-finale3d-win32-installer	(RELEASE)	Added	Explo	module	types	for	1k,	5k,	20k,	wave_player.	Added	'Racks'	button	to	rack	layout	view	for	adding	as	many	additional	racks	are	required	for	the	position	being	viewed,	keeping	the	existing	racks.	Made	importing	scripts	ignore	vacuous	module/pin
columns	if	non-vacuous	ADDR	column	exists,	for	ShowDirector	CSV	and	SCX.	Added	new	script	columns,	hidden	by	default,	for	PAIR,	STRAIGHT	UP,	and	FLIGHT	COUNT,	which	can	be	used	for	addressing	sorts	and	constraints.	Fix	crash	when	closing	the	main	window	before	the	login	window.	Made	rack	tube	tooltip	red	if	tube	has	compatibility
error.	Support	double-click	to	edit	cell	when	in	mode	of	'File	>	User	settings	>	Click	action	in	effects	window	>	Select	row.	Improved	labels	configuration	dialog.	Added	drag-and-drop	from	the	effect	bar	into	the	scene.	Made	'Replace	effect'	function	put	up	a	dialog	offering	to	update	effect	durations	that	were	editable	or	not,	if	any	selected	events	had
editable	durations.	Added	menu	items	to	gear	menus	for	selecting,	saving,	and	editing	report	templates.	Added	reverse-mapping	to	position	group	names	so	grouped	rows	in	script	displayed	as	single	row	will	show	the	position	group	name	in	the	position	column.	Fixed	addressing	but	that	resulted	in	inefficient	use	of	firing	system	hardware	in	some
circumstances.	Added	support	for	Cauvet	Slim	Par	56	par	light	DMX	fixture.	Changed	minimum	size	of	a	position	to	0.01m.	Minor	improvement	by	turning	position	rulers	off	entirely	when	positions	are	locked,	so	less	clutter	on	screen.	Add	implicit	'with'	in	effect	names	for	pistil	when	missing,	e.g.,	'cometa	roja	cola	de	oro'	-->	'comet	red	w/	tail
gold'.2018.03.23-6caa758d-finale3d-win32-installer	(RELEASE)	Improved	script	scrolling	and	its	highlight	of	next	firing	row.	Added	'Safety	Distance	Meters'	to	the	script	table,	referencing	effect	table.	Fixed	rendering	bug	causing	stars	and	sparks	to	appear	out	of	nowhere	when	the	scene	complexity	hit	the	render	particle	limit.	Added	Megafire
exporter.2019.09.26-a0c6aee0-finale3d-win32-installer	(RELEASE)	Improve	the	Finale	Inventory	sales	order	syncing	functions.	Fixed	problem	where	pattern	breaks	were	not	properly	registered.	Automatically	separate	overlapping	slices	when	importing	HBS	cakes,	to	make	the	transformation	to	VDL	more	sure	fire.	Added	100ms	resolution	option	for
FireByWire	exporter	for	versions	of	the	FireByWire	software	that	are	not	able	to	import	1ms	resolution	times.	Fixed	minor	bug	in	'Create	cake	effect	by	combining	items'	to	make	it	correctly	support	effects	with	explicit	prefire	and	LFT	in	them,	and	to	make	the	cake's	prefire	be	the	original	prefire	of	the	first	item	combined	into	the	cake.	Fix	bug	with
long	sales	order	ids	not	working	with	Finale	Inventory	integration.	Defined	standard	flash	effects	and	move-to	DMX	effects	for	the	color	orange,	and	implemented	in	the	MARQ	Gesture	Spot	100	effects,	which	are	in	the	Assorted	DMX	supplier	catalog.	Added	support	for	control-left/right	arrow	when	editing	text	to	jump	by	words.	Display	the	correct
GPU	in	the	'About	Finale'	dialogs	when	running	on	GPU-switching	computers.2018.01.25-19d5cfc3-finale3d-win32-installer	(RELEASE)	Fixed	bug	wherein	inserting	events	with	timeline	snapping	to	fps	would	insert	effect	at	wrong	time.	Made	non-chain	items	insert	a	single	device	no	matter	what	the	value	in	the	'Devices'	column	is.2018.05.22-
f413965e-finale3d-win32-installer	(RELEASE)	Fix	multi-segment	transition	bug.	Fix	bug	that	affected	ghost	shells	with	multi-phase	stars.	Simplified	column	header	context	menu.	Added	timeline	feature	to	stretch	durations	of	individual	effects	that	have	editable	duration	by	dragging	hotspot	at	right	end	of	their	timeline	bar;	the	Type	of	the	effect
determines	whether	its	duration	is	editable	--	sfx	and	lights	have	editable	duration,	whereas	flame	and	pyro	type	effects	do	not.	See	StarFire	page	in	documentation	section.	Added	Pyrodigital	FMA	module	name	explicitly	to	the	list.	Added	image	processing	features	to	add	gradients	to	turn	daylight	pictures	of	shootsites	into	convincing	nighttime
pictures.	Changed	the	default	script	table	window	formatting	option	for	new	shows	to	consolidate	both	chain	rows	and	group	rows.	Made	the	function	that	fixes	bad	position	names	also	fix	bad	references	in	the	racks	window.	Fixed	Chain	Gap	bug	in	displayed	sequence	for	long	chains.	Support	Unicode	characters	in	translation	to	VDL	and
normalization	of	native	language	effect	descriptions.	Automatically	switch	to	a	collection	that	contains	effects	used	in	the	show	when	switch	out	of	rack	layout	view,	e.g.,	shift-2	or	shift-0.	Improved	the	'Create	effect'	and	'Edit	effect'	dialogs	to	include	optional	fields	for	specifying	the	non-visual	attributes	of	the	effect.	Added	track	column	to	CSV	firing
system	export,	and	made	cue	column	and	semi-auto	modality	unaffected	by	track	column,	and	documented	format	specification	in	software	section	of	the	website.)	Added	track	to	PyroDigiT	exporter	for	semi-autonomous	fire.finale3d-installer-2020.01.27-3c3364836	(RELEASE)finale3d-installer-2020.01.24-f21f3b679	(RELEASE)	For	Pyrodigital
download,	appended	extra	NULL	character	to	downloaded	data	to	amke	transfer	more	reliable.	Fixed	load/save	bug	with	racks	that	messed	up	rack/tube	assignments	assigned	if	there	were	gaps	in	the	rack	number	sequence.	Just	add	the	variable	and	give	it	a	value.	Moved	'Disable	UI	sound	effects'	from	per-show	settings	to	user	settings.	Added
checkmark	image.	Added	'Script	Name'	option	in	Cobra	export	options	instead	of	always	using	the	FIN	show	name,	but	leaving	field	blank	defaults	to	using	FIN	show	name,	and	there's	a	context	sensitive	help	message	to	explain	that.	Added	ability	to	rename	position	groups.	Added	'Sky	image	adjustments'	with	parameters	to	make	a	photograph	into	a
good	background	image.	Updated	Chinese	Simplified,	Chinese	Traditional,	and	Brazilian	Portuguese	UI	translations.	If	user	does	'Assign	DMX	channel	ranges'	for	fixtures	that	include	just	one	master	and	all	the	rest	slaves,	and	if	all	of	them	do	not	yet	have	DMX	universe	and	channel	base,	then	infer	that	the	user	wants	those	slaves	associated	with
that	master	and	do	it	for	him.	Added	ability	to	change	module	address	in	the	rack	layout	window	by	clicking	on	the	module	address	and	entering	a	replacement	number.	Fix	the	login	flow	when	offline	login	fails	because	of	unmatched	computer	id.	Added	option	to	turn	off	automatic	creation	of	position	groups.	Added	VDL	implementation	of	'Octopus'
as	'clusters	of	stars,	defaulting	to	gold'.	Fix	some	OpenGL	usage	bugs	causing	crashes	in	Parallels	and	some	Intel	GPUs.	Improve	UI	responsiveness.	Added	max.	Fixed	bug	in	long	exposure	rendering.	Added	FM-24	option	for	FireLinx	firing	system.	Added	more	fields	that	can	be	used	in	labels:	show	name,	show	date,	show	location,	show	option	1,
show	option	2,	show	date	plus	name,	size	plus	description,	part	number	plus	description,	and	ematch/chain	message.	Fixed	padding	on	icons	in	reports,	such	as	in	cue_list	report.	Fixed	a	bug	in	which	size	min/max	and	other	special	racks	characteristics	wasn't	being	taking	into	account	in	the	'Add	racks'	dialog.	NOT,	making	all	states	distinguishable.
Tune	effect	heights.	New	darker	timeline	color	scheme.	Make	time	rain	leave	a	crackling	trail.	Pass	#2	of	German	effect	name	translations.	Turned	off	the	Piroshow	exporter	feature	that	automatically	separated	shots	by	10ms	to	accommodate	electical	limitations,	and	made	it	optional	for	users	to	add	by	creating	a	per-show	settings	of
'piroshow10MsSeparation'	with	value	=	true.	Updates	to	Russian	and	Ukrainian	translations.	Removed	the	preview	window	that	would	appear	if	you	hover	over	an	effect	icon	in	the	effect	window	at	tjust	the	right	place,	on	the	theory	that	it	was	more	annoying	than	appreciated.	Changed	the	'Padding'	field	in	label	customizations	to	'Vertical	padding'
and	added	'Horizontal	padding'	field,	to	decouple	the	two	types	of	padding.	This	rule	avoids	flowerpotting	sims	from	prefires	that	aren't	lift	times.	Removed	the	'DMX	effect	filter'	field	from	the	position	properties	and	'Configure	position	as	DMX	fixture'	dialogs,	since	it	is	no	longer	needed	now	that	we	have	user-defined	fixtures.	Added	'Print	again	to
temporary	file'	function	to	main	File	menu	to	make	it	quick	to	print	a	preview	of	a	report	multiple	times	without	choosing	a	filename	each	time.	After	user	changes	an	effect	row	in	effects	window,	the	step	that	updates	the	effect	in	the	show	will	now	update	all	fields	of	the	changed	effect,	not	just	the	changed	field.	Add	helpful	annotations	to	the	DMX
errors	in	the	addressing	dialog	to	tell	user	what	the	errors	are.	Show	a	dialog	when	we	try	to	run	with	an	unsupported	version	of	Parallels.2019.03.13-c788ba03-finale3d-win32-installer	(RELEASE)	Made	ruler	coordinates	relative	to	reference	position	if	user	has	selected	one	from	the	context	menu.	Fix	cake	and	angle	offsets	for	flames.	Make	saving
the	show	be	resilient	to	the	output	file	temporarily	not	being	writable	(we	think	this	will	help	work	around	certain	virus	scanners	locking	the	file	sometimes).2018.11.29-9999af6e-finale3d-win32-installer	(RELEASE)	Add	machine	id	and	machine	name	to	About	dialog.	Fixed	hit	detection	problem	on	position	tooltips	that	generated	multiple	click	sounds
when	cursor	moved	slowly	over	position	name.2019.06.12-20ba1970-finale3d-win32-installer	(RELEASE)	Fixed	labels	crash	bug	that	occurs	when	script	rows	have	a	bad	part	number.	Fixed	import	show	bug	wherein	angles	of	non-English	cake	descriptions	were	imported	with	an	incorrect	PAN	angle.	Improved	reliability	of	combine-as-cake	by
normalizing	times	and/or	angles	if	given	sequence	of	shots	does	not	have	a	realistic	cake	construction	as	specified.	Minor	fixes	to	MAGICFX	safety	channel	fixtures.)NOTE(Added	Explo	GX2	fixture	as	an	option.finale3d-installer-2021.04.29-94f891203	(BETA	VERSION)	Added	fixture	definition	for	TomShine	30W	moving	head	light	fixture	--	but	no
simulations	yet.	Make	vdl	parser	recognize	'mines'	and	'comets'	as	plurals.	This	will	be	fixed	in	another	release	soon,	but	this	release	fixes	the	new	crash	that	started	occurring	in	'crackling	fountain'.	Added	support	for	ADJ	QWH12X	RGB	Par	light	fixture	by	DMX.	Fixed/removed	the	Pre-Wired	Rails	column	from	the	Rack	Totals	report.	Added	'DMX	>
Detect	fixture	definition	inconsistencies...'	for	troubleshooting	if	you	are	defining	your	own	fixtures.	Fixed	a	few	missing	UI	phrases	for	localization	to	other	languages.	Reset	rack	layout	to	'Edit	racks'	mode	when	user	changes	the	position	selector.	Added	'Script	>	Time	adjustments'	submenu,	moved	a	few	commands	into	it.	Made	the	default	script
table	layout	sort	by	effect	time	instead	of	event	time.	Update	Spanish	and	Italian	UI	translations.	Added	'Script	>	Time	adjustments	>	Insert	minimum	separation...'	to	insert	specified	separation	as	necessary	between	tight	sequences	of	cues,	to	help	with	pin	board	/	voice	cues	shows.	Fix	flash	pot	and	flash	tray	simulations.	Added	Show	>	Goto	time...
Add	'laser'	as	a	synonym	of	'ultrafast'	for	laser	comets.2017.10.13-3b843d83-finale3d-win32-installer	(RELEASE)	Fix	tiger	tails	and	whirlwinds.	Added	'compatibility	mode'	render	checkbox	for	low-end	hardware.	Added	single-shot	39	letter	mines	to	generic	effects	for	shooting	letters	with	mines	having	smaller	clusters	of	stars.	Changed	right	click
action	on	position	group	icon	or	camera	preset	icon	on	left/right	sides	of	design	view	from	the	action	of	deleting	the	icon	to	the	action	of	bringing	up	the	rename/delete	dialog.	Added	highlights	for	multiiple	e-match	rows	in	Wiring	Script	report;	also	highlighted	non-blank	notes	fields;	centered	text	in	various	columns;	highlighted	rail/pin	columns;
general	formatting	improvements	Improved	formatting	of	Cue	Sheet	report	and	changed	name	to	Pinboard	Cue	Sheet.	Fix	bug	with	flames	and	explicitly	angled	shots	(e.g.	"L45	gold	comet")	not	working	properly	when	trajectory	is	angled.	Fixed	old	bug	that	the	'Add	racks'	functions	would	skip	adding	the	names	of	rack	groups	comprised	of
sideways/rotated	racks.	Made	modules_per_position	show	ranges	of	modules	in	single	rows.	Made	more	interesting	set	of	default	effects	for	effect	bar.	Enlarged	maximum	module	size	that	the	rack	layout	pin	editing	was	capable	of	handling	to	400	pins,	from	128.	Inserted	duration	into	VDL	for	cakes	in	Finale	Generic	CSV	export	since	Finale	Business
doesn't	read	the	duration	column.2017.11.14-8af51a6b-finale3d-win32-installer	(RELEASE)	Made	'offset	times'	function	support	negative	formatted	values,	like	'-2m'.	Added	support	for	Tomshine	moving	head	gobo	fixture.	Added	a	new	VDL	term	'Move-To'	for	moving	head	flamers	and	light	fixtures	that	create	continuous	sweeps	over	angle-ranges
defined	by	the	trajectory	dots.	Change	tuning	on	crossette	mine	breaks.	Improved	sound	effects	for	drag-and-drop.	Made	hovering	over	a	master	DMX	fixture	position	automatically	highlight	any	slave	fixtures	associated	with	it;	and	made	hovering	over	a	slave	fixture	automatically	highlight	the	master	that	it	refers	to.	Improved	position	padlock	icon.
Renamed	'Parente'	to	'Firemaster'.	Changed	hovering	over	event	or	cue	flag	on	timeline	indicator	to	highlight	associated	script	rows	in	red.	Added	drag-and-drop	wiring	to	rack	layout	--	work	in	progress,	racking	still	not	very	usable.2018.09.05-ef698ec5-finale3d-win32-installer	(RELEASE)	Added	tooltips	for	the	rack	buttons	in	rack	palette	in	the	rack
layout	window.	Fixed	bug	in	default	magnification	of	site	layout	screen,	which	was	introduced	a	few	weeks	ago.	Changed	3D	navigation	paradign	to	'pan-and-pointer'	dominant	mode,	with	optional	orbit	mode	if	holding	control;	hold	shift	for	selection	box.	Fix	crash	that	occurred	if	you	run	Finale3D	without	any	audio	devices	enabled	on	the	computer.
Fixed	a	few	phrases	that	weren't	in	the	localization	table.	When	importing	from	CSV,	avoid	interpreting	'Finale	Box'	as	meaning	a	chain,	a	bug	that	interfered	with	importing	some	cakes.finale3d-installer-2020.01.16-524ab7652	(RELEASE)	Big	improvements	to	gray	'compiling	launch	instances'	screen	speed.	Fixed	'Straight	up'	and	'Pair'	and	'Is	Chain'
fields	in	the	script	window,	making	them	filterable	with	text	in	the	search	bar	like:	straight	up	=	true.	Added	'Pin	Absolute',	'Module/Pin	Address'	and	'Module'	field	options	for	labels,	which	convert	slat-based	pin	numbers	to	module-based	pin	numbers	for	virtual	slats	and	splitter-box	based	firing	systems	that	use	pin	numbers	relative	to	the	module
instead	of	the	slat.)NOTE(Added	'Chains	First',	'Chains	Last'	and	'Chain	Reference'	to	address	sorting	criteria	options.	Make	non-randomized	break	orientations	depend	on	their	start	velocities	(so	that	mine	pancakes	point	in	the	correct	direction).2019.08.22-6098e28d-finale3d-win32-installer	(RELEASE)	Speed	improvements	and	memory	reduction	in
rendering.	Make	Google	Maps	downloaded	ground	images	save	when	the	show	is	saved.	Added	'Renumber	racks	right	to	left',	to	complement	the	existing	feature	'Renumber	racks	left	to	right'	on	the	context	menu	for	right	clicking	on	racks	in	the	layout	view.	Fix	bug	with	newlines	in	Part	Notes.	Fixed	effect	palette	menus	and	search	bar	input	box
when	rendering	in	letterbox	mode.	Updated	Polish,	Hungarian,	and	Dutch	translations	Fixed	obscure	clipping	bug	in	rack	layout	screen	wherein	module	graphics	could	be	partially	off	screen	when	using	multiple	module	types	in	the	same	position.	Made	collection	filter	on	'Add	racks'	dialog	prevent	easy	racks	from	being	the	default	selections	if
filtering	to	a	non-easy	racks	collection.	Added	DMX	support	for	ADJ	Fog	Fury	Jett.	Fixed	minor	UI	bug	with	initial	state	of	the	'Use	values	from	default	addressing	blueprint'	checkbox	on	dialog	from	rack	layout	addressing	link.	Remove	medium	quality	mode.	Fix	effect	editor	bug	causing	newly	typed-in	effects	to	not	get	a	valid	effect	type.	Fixed	chain
specifications	report.	Added	test	and	warning	when	you	click	the	module	number	in	the	rack	layout	window	to	change	the	address,	warning	you	if	your	change	conflicts	with	an	existing	module.	Added	first	version	of	Italian	translation.	Improve	3D	rendering	speed.	Added	significant	new	feature:	'Re-arrange	tubes	in	adjustable	angle	racks	to	avoid
collisions'	option	on	addressing	dialogs,	which	automatically	re-arranges	tubes	in	an	optimized	layout	within	single-shot	racks	such	that	tubes	do	not	angle	at	each	other	and	such	that,	to	the	extent	possible,	sets	of	adjacent	tubes	have	the	same	size	and	part	number	to	make	the	layout	appear	sensible	to	the	crew	setting	up	the	racks;	in	addition	to
other	subtle	optimizations	like	optimizing	for	symmetry	and	a	preference	for	tubes	angling	away	from	the	rack	instead	of	across	it.finale3d-installer-2021.02.26-171a95430	(BETA	VERSION)	Fixed	Cobra	exporter	for	long	DMX	durations,	changing	format	to	include	minutes	instead	of	just	seconds.	Changed	'Used'	count	calculation	to	be	based	on
numDevices	in	perShowEffects,	so	the	option	to	display	the	count	as	full	chains	works	more	reliably.	Progress	in	Hungarian	translation,	very	close	to	done.	Added	DMX	support	for	Mongoose	and	updated	exproted	script	format.	Removed	hand	and	home	buttons.	Added	32	pin	and	16	pin	options	for	fireTEK	firing	systems.	Support	copy/pasting	racks
between	positions.	Made	minor	refinements	to	VDL.	Also	made	shift-clicking	work	for	'Add/remove	filter'	menu	for	tables.	Automatically	add	the	words	'Single	Shot'	to	the	description	in	the	'Edit	effect	VDL'	dialog	if	the	effect	being	edited	has	Type	=	single_shot	but	no	indica	xxx	indication	in	the	VDL	that	it	is	a	single	shot.	Added	'File	>	Admin	>
Update	standard	blueprints	in	show...'	menu	item	to	update	blueprints	saved	in	show	if	the	software	has	a	more	up	to	date	version	available.	Removed	page	breaks	from	default	labels	formats.	Fixed	crash	bug	wherein	closing	a	show	while	it	was	playing	could	cause	a	crash.2019.02.27-6c8fbae0-finale3d-win32-installer	(RELEASE)	Now	supports
running	under	Parallels	v14+	on	Macs.	Updated	Norwegian	translation.	Fixed	'Edit	position	properties'	to	update	references	if	user	changes	position	name.	Improvements	to	sync	dialog	progress	display.finale3d-installer-2020.04.08-8bc82371c	(RELEASE)	Updated	Brazilian	Portuguese	translation.	Made	all	operations	scroll	script	to	keep	next	firing
row	in	view.	Improvements	to	Cobra	exporter	and	better	error	checking	against	firmware	limitations.	Improved	cake	VDL	parsing	to	allow	specifying	firing	pattern	for	some	rows	and	leaving	other	rows	as	default.	Made	the	chain	specifications	label	templates	sort	by	effect	time	instead	of	by	angle	as	the	last	sort	criterion,	so	the	printed	labels	for	the
chain	are	in	order.	Fix	deleted	effect	render	caching	bug.	Minor	improvement	to	sorting	of	options	in	the	fixture	context	menu	'Add	DMX	effect	for	fixture.'	Minor	improvement	to	timeline	bar	stretching	UI	for	circumstances	in	which	two	items	are	selected.	Made	Pyrodigital	fix	for	macros	beginning	with	zippers	use	the	correct	Hazard/CGHZ	value.
Add	stronger	test	for	conflicting	DMX	channel	base	configurations	that	catches	single-channel	DMX	personalities	also.	Hide	timeline	during	playback	if	cursor	outside	window,	for	more	immersive	option.finale3d-installer-2020.02.17-4d08a634c	(RELEASE)	Added	Pyromate	analog	module	type	option	with	letter	addresses,	A-L	instead	of	numbers	1-12,
for	the	45-pin	slats.	Added	'Tube	loading	order'	specification	in	rack	create/edit	dialog,	providing	user	control	over	the	pin	numbers	in	single-shot	racks	with	multiple	rows.	Added	ability	to	customize	table	windows	by	moving	columns	left/right.	Effect	Editor:	Remove	chain-number-of-devices	from	Effect	Editor.	Added	a	transparent	color	option	for	the
backdrop	images	so	user	can	designate	a	particular	color	as	transparent,	as	an	alternative	to	using	a	PNG	image	with	an	alpha	channel.	Added	'Group'	as	a	constraint	option,	enabling	user	to	use	groups	to	control	what	sets	of	effects	at	the	same	time	and	launch	position	are	e-matched	in	series	to	the	same	pin	by	setting	'Max	e-matches	per	pin'	to	a
large	value	and	then	adding	'Group'	as	a	'Pin	Constraint'	on	the	addressing	dialog,	and	putting	items	meant	to	be	e-matched	together	into	the	same	groups.finale3d-installer-2020.03.17-2db8a218e	(RELEASE)	Fix	bug	with	Finale	Inventory	sync	and	very	long	descriptions.	Fixed	the	bug	in	which	inserting	a	rack	updates	existing	racks	in	the	show	from
a	different	collection.	Made	design	view	selection	rect	ignore	positions	if	it	includes	top-of-trajectory	donuts	of	events.)WIP:	Added	placeholder	icons	for	song	editing,	event	selection	on	timeline,	drag-and-drop,	rotating	trajectory.	Added	new	pre-wired	pin	patterns	for	racks	that	traverse	rows	in	the	reverse	order,	to	match	common	configurations	of
PyroDigiT-like	racks.	Added	DMX	support	for	ShowVen	SonicBoom	Plus	SmokeJet,	Standard	Fixture	ID	062.finale3d-installer-2022.02.10-12fb4ff6a	(RELEASE)	Widened	menus	on	report	config	dialogs.	Make	25mm	comets	a	little	slower	by	default.	Save	and	restore	the	effects	window	table	layout	and	active	collection	when	quitting	and	relaunching
app.	Fix	creating	new	products	in	Finale	Inventory	from	Finale3D.	Made	commands	like	'Add	racks	for	show'	pop	up	the	required	windows	in	their	previous	position	instead	of	re-arranging	all	windows.	Fixed	bug	in	parsing	invalid	VDL	cake	firing	patterns	descriptions.	Rounded	durations	in	effect	rows	to	two	digits.	Changed	single-shot	prefire	to	be
the	prefire	of	the	effect	in	the	single	shot,	not	always	0.	Added	Cost,	Weight,	and	NEQ	columns	to	the	basic	report	templates	that	they	apply	to.	Updated	German,	French,	and	Polish	UI	translations.	Fixed	'Script	>	Chains	>	Set	chain	delays'	which	previously	was	based	on	delays	between	effect	times,	which	isn't	correct	if	shells	in	the	chain	have
different	prefires.	Added	'File	>	Import	>	Import	effects	from	HBS	file'	to	make	it	easier	to	import	effects	from	Finale	Business.2019.10.05-8754bf6f-finale3d-win32-installer	(RELEASE)	Fix	bug	causing	duration	adjectives	to	not	apply	to	pistils.	Added	'Script	>	Angles	>	Rotate	cakes	180	degrees'.	Fix	inch->meter	conversion	bug	in	Finale	Inventory
sync.	Re-addressing	after	locking	addresses	no	longer	crashes.	First	beta	version	of	effect	editor	gui.2019.04.06-ff550ad1-finale3d-win32-installer	(RELEASE)	Progress	on	French,	German,	Spanish,	Russian	user	interface	translations.	Fix	inventory	sync	problem	that	was	causing	some	effect	changes	to	not	sync	up	to	the	server.	Added	'DUR'	keyword
to	VDL	to	allow	specifying	duration	of	an	effect	within	a	multi-shot	cake	or	candle,	e.g.,	10s	10	shot	1.5	DUR	gold	comet	cake.	Flushing	the	render	caches	may	help	speed	up	Finale3D	if	it	slows	down.	Also	made	shift-clicking	'Move	left/right'	for	table	columns	work.	Work-in-progress	Finale	Inventory	integration.	Added	Rockville	Battery	Par	50	Par
Light,	and	YF	Beam	230	Moving	Head	DMX	support.	Made	'Replace	with	this	effect'	work	for	racks	too.	Minor	Pyromac	exporter	changes.	Fixed	slowness	due	to	generating	all	icons	after	using	effect	chooser	or	typing	text	into	parts	window	filter.	Fixed	cakes	related	bug	in	show	import	wherein	cakes	would	be	imported	sideways.	Improved	FireTEK
and	PyroSure	module	names	to	remove	confusion.2019.07.12-5c88cf91-finale3d-win32-installer	(RELEASE)	Fixed	a	GPU	detection	bug	that	was	sometimes	causing	an	'Invalid	GPU'	warning	dialog	to	appear	on	startup	when	it	should	not.	Fix	Finale	Inventory	location	menu	chooser.	Disable	the	automatically	loaded	show	template	if	user	does	not	have
a	hobbyist	or	pro	license.	Updated	MagicFX	flame	and	sparks	fixtures.	Updated	Polish	UI	translations.	Re-tune	popcorn	crackle,	titanium	salute,	titanium	report,	flash	tray,	crackle	flowers.	Fixed	labels	formatting	bug	wherein	e-match	counts	didn't	consider	universes	and	piggyback	slats.	Interpret	cakes	without	flower	defining	terms	as	comets	instead
of	shells.	Added	position/size	default	selectors	to	script	window.	Fix	bug	causing	rendered	videos	to	have	incorrect	aspect	ratio,	causing	view	to	be	'squeezed'	one	way	or	the	other.	Added	support	for	Showven	Sparkular,	Sparkular	Cyclone,	uFlamer,	and	Circle	Flamer;	and	Spark	Fabrica	Moving	Head	Flamer;	and	generic	DMX	relay	and	dimmer
flamers.	Erased	background	behind	playhead	time	to	make	text	more	clear	to	read.	Added	ShowDirector	CSV	exporter.	Removed	the	new	rack	annotations	from	the	default	rack	layout	report	templates,	but	existing	rack	layout	report	templates	saved	in	shows	will	need	to	be	modified	to	remove	the	new	fields.	Fixed	crashing	bug	when	user	attempts	to
filter	to	empty	string	/	null	value.)Improved	fast-path	speed	of	rangify	consolidator.2018.06.11-3104b51f-finale3d-win32-installer	(RELEASE)	Fix	caliber	issue	with	finale	inventory	sync.	Fixed	crash	bug	in	'Add	racks'	that	occurred	when	a	rack	instance	referred	to	a	partNumber	that	didn't	exist.	Added	rack	palette	UI	and	clickable	rack	buttons	in	rack
layout	window	--	note:	racks	are	still	not	easy	to	use.	Added	'Firing	system	export	offset'	to	'Show	>	Show	settings...'	dialog,	providing	a	simple	UI	to	specify	an	arbitrary	time	offset	added	to	all	rows	in	exported	firing	system	scripts.	Improved	contrast	of	music	waveforms	on	timeline	and	made	them	prettier.	Added	'DMX	>	Detect	and	fix	PAN	angle
problems	with	Move-To	effects...'	to	fix	Move-To	animations	that	have	inconsistent	PAN	angles.	Make	vdl	parser	output	new	'star	phases'	structure	for	transition	stars.finale3d-installer-2020.07.20-34035c30e	(RELEASE)	Implement	handling	of	'star	phases'	from	the	effect	editor.	Add	'wide'	and	'narrow'	adjectives	to	fountains	Fixed	a	crash	bug	when
loading	some	SketchUp	models.	Improved	Explo	exporter,	writing	Track	field	to	Gruppe	column,	and	Hazard	field	to	Efg.	Added	auto-correction	for	accents	of	German	words.	Added	two	new	fields/columns	to	parts:	color	and	subtype.	Improved	'underline'	playhead	indicator	in	script	table	to	stay	put	when	mouse	is	hovering	over	other	events	or	flags
on	timeline.	Fixed	title	and	page	number	formatting.	Improved	Portuguese	effect	name	translations.	Added	first	progress	on	Portuguese	UI	localization.	Changed	capitalization	of	the	term	'Effect	window'	throughout	the	product,	which	requires	a	minor	update	from	the	translators.	Rename	login	checkbox	to	'Sync	with	network'.	Display	blank	if	the
contents	are	undefined.	Added	'Alternate'	column	in	script	table	for	firing	systems	that	support	triggering	alternate	effects	manually	during	or	after	a	pyromusical;	implemented	Cobra's	Alternate	1	and	Alternate	2	options.	Fix	issues	causing	stars/trail	arms	to	disappear	or	flicker	in	and	out.2018.05.24-f5ac2227-finale3d-win32-installer	(RELEASE)	Fix
a	bug	causing	a	"http	code	said	error"	message	when	logging	in.	Improved	addressing	algorithm	to	use	fan-racks	automatically	if	the	user	selects	'pin-constrained-to-single-rack'.	Remove	spaces	and	special	characters	from	blueprint	names	for	reports	and	labels,	thinking	ahead	to	'book'	blueprints.2018.07.18-367738db-finale3d-win32-installer
(RELEASE)	Implement	progressive	3D	graphics	initialization.	Fixed	bad	crashing	bug	in	labels	introduced	in	the	last	release.	EFFECT	EDITOR:	The	effect	editor	is	still	considered	'alpha'	software.	Added	Pyrotronix	module	type	options	with	20	simultaneous	channel	limit	option.	Made	effect	chooser	include	all	open	parts	files,	not	just	the	active	parts
window.	Fix	issue	with	'sync	to	network'	not	working	when	running	Finale	in	offline	mode.	NOT	and	hoveredOver	vs.	Clear	rack/tube	addresses	as	part	of	'Add	racks	for	show'.	Fixed	the	Label	Planet	labels	dimensions.	Better	detection	of	underpowered	GPUs.	Fix	memory	leak	in	progressive	rendering.	Darkened	partNumber/name	column	in	tables	to
make	white	text	more	readable.	Make	cue	flags	have	higher	hover	priority	than	the	song	bar.	Fixed	bug	wherein	specified	part	number	in	'Create	new	effect'	dialog	was	ignored.	Added	cursor	image	change	when	hovering	over	fill	handle	in	corner	of	table	cell.	Tune	willows.	Fixed	DMX	bugs	in	PyroSure	exporter.	Changed	the	'Fancy	count	colors'
formatting	option	used	for	formatting	addresses	on	labels	to	print	the	module	and	pin	using	two	colors,	black	and	red,	as	in	Finale	Business	labels.	Added	back	the	EasyDancing	fixture	type.	Changed	default	fill-down	initial	address	to	value	of	top	selected	row	if	non-empty,	not	that	+	1.	Inclusion	breaks	like	'red	peony	w/	blue'	no	longer	have	stars
'stack	up'	on	each	other.	Improved	error	message	presented	when	user	tries	to	edit	racks	without	valid	license.	Fix	bug	causing	effects	to	'blink	out	of	existence'	too	early.	Changed	DMX	slave	fixture	positions	to	be	rendered	as	diamonds	instead	of	squares	so	you	can	easily	tell	what	is	a	slave	versus	what	is	a	master.	Narrowed	the	error	checking
regarding	unconfigured	DMX	universe/channel	base	positions	to	those	positions	that	have	effects	in	them.	Resurrected	the	'Script	>	Flights'	submenu	and	functions,	for	the	Pro	version.	Made	right-click	menu	'Add	DMX	effects'	detect	if	you	need	to	download	a	supplier	catalog	and	tell	you	if	so.	Added	a	warning	dialog	to	detect	and	warn	if	the	active
collection	has	conflicting	keybowrd	shortcuts	for	effect	macros.	Changed	rack	layout	UI	to	be	like	Google	Maps.	Added	turquoise	and	cyan	and	magenta	to	VDL.	For	importing	HBS	files,	fixed	angle	rounding	tolerance	as	required	to	reverse	engineer	some	Finale	Business	cakes.	Improved	performance	of	'Set	properties'	dialog.	Implemented	all	the
'Insert	multiple'	functions	and	added	options	for	inserting	based	on	quota,	or	entered	quantity,	or	fraction	of	quota,	from	all	effects	or	just	selected	effects.	Changed	formatting	of	the	type	variations	of	sort	terms	in	menus.	Made	the	'Script	>	Angles	>	Rotate	cakes	180'	function	add	or	subtract	the	text	'180'	to	the	notes	field	if	the	notes	field	does	not
already	contain	text	other	than	the	word	'180'.	Reduced	hot	region	for	resizing	columns	on	left	of	edge	to	make	narrow	columns	easier	to	select.	Added	'Deadman'	button	option	for	deadman	trigger	in	exported	Cobra	script.	There	may	be	small	differences	in	the	looks	of	effects	between	older	releases	and	this	one.	Added	export	FPS	options	for	Show
Director	CSV	format,	30fps,	29.97,	25,	25.	Improvements	to	position	movement	rulers.	Made	soundtrack	reset	correctly	for	looping	start/end	markers	with	new	looping	feature.	sfx	is	like	flame	except	has	variable	duration.	Changed	the	table	window	filter/selector	UI	to	make	multiselect	easy	and	to	create	radio	buttons	automatically	for	chosen	filter
options.	Add	error	message	if	user	attempts	to	do	'Change	DMX	Fixture	Type	and	convert	effects'	if	multiple	fixture	types	are	selected	or	if	unspecific	fixture	type	selected.	Add	effects	to	the	master	position	and	they	will	appear	mirrored	on	all	of	the	corresponding	slaves.	Fixed	bug	where	sometimes	sounds	got	skipped	during	playback.	Finale
Inventory	sync:	use	correct	distance/length	values	when	the	Finale	Inventory	distance	unit-of-measure	is	not	meters.	Improved	design	of	the	'Create	new	effect'	dialog.	Added	ability	to	make	'Notes'	column	a	filter/selector	in	the	table	windows.	Add	DMX	channel	range	column	to	positions	window,	read-only,	based	on	fixture	type.	Fixed	bug	in	top	level
menu	item	'Add	DMX	effect	to	fixture'.	Updated	Hungarian,	Ukrainian	and	Russian	translations.finale3d-installer-2019.11.21-96449742a	(RELEASE)	Disable	effect	editor.	Fix	some	rendering	crash	issues.2019.06.26-61faee31-finale3d-win32-installer	(RELEASE)	Improved	Russian,	Ukrainian,	and	Hungarian	localizations.	Previously	that	was	difficult	to
do.	(Added	explanation	dialog	when	clicking	green	plus	button	for	position	groups	on	left	side	of	screen.	Fixed	obscure	crash	bug	wherein	bad	user	input	for	a	time	value,	like	000000000000000000000000000000000000:0,	could	cause	a	crash.	Auto-focus	the	continue	button	on	do-not-show-again	continue/cancel	dialogs	so	you	can	just	press	enter	to
dismiss	it.	Prevent	windows	from	getting	buried	underneath	other	apps	by	hoisting	all	3D	windows	to	the	front	whenever	the	user	clicks	any	3D	window	to	the	front.	Fixed	effect	bar	bug	wherein	filtering	while	scrollbar	was	scrolled	to	the	right	would	skip	over	effects.	Positions	functions	that	enter	an	interactive	mode	for	dragging	a	coordinate	axis	or
angle	will	clear	the	locked	flag;	and	other	positions	functions	will	pop	up	a	dialog	asking	if	you	want	to	clear	the	locked	flag,	and	will	have	no	effect	if	you	say	no.	Added	Ruble	currency	symbol	option	in	user	settings.	Dragging	playhead	on	timeline	will	snap	to	cues,	with	an	option	to	turn	this	behavior	off.	Added	'Show	chains	as	one	row'	option	in
script	gear	menu.	Fixed	'Add	racks	for	show'	for	circle	racks	that	have	straight-down	tube;	previously	it	wouldn't	add	or	fill	racks	that	had	a	straight-down	tube.	Added	flame	system	specific	safety	channel	effects.	Filter	out	sales	orders	that	aren't	editable.	Recognize	'single	shot'	and	'roman	candle'	in	effect	name	import	and	sim	creation	from
description.	Fixed	minor	bug	with	'edit	effect'	menu	item	on	timeline	context	menu.2018.03.21-3eec7d03-finale3d-win32-installer	(RELEASE)	Highlight	script	table	row	when	cursor	hovering	over	corresponding	event	on	timeline	or	in	3D	view.	Made	RMB	click	in	design	view	in	nav	mode	reset	design	mode	to	pointer;	also	made	clicking	on	effect	in
effect	bar	reset	design	mode	to	pointer.	Improve	DMX	safety	channel	effects.	Pasting	shells	onto	empty	cue	now	removes	empty	cue.	Added	fancy	'fix'	for	Pyrodigital	FC-3	limitation	that	it	can't	fire	zipper	fire	at	beginning	of	macro;	fix	is	that	software	automatically	adds	a	'dummy	cue'	in	front	of	zipper	1/10th	second	in	situations	requiring	it.	Fixed
bug	in	import	show	wherein	chain	durations	specified	in	milliseconds	were	misread.	Added	'insert'	icon	to	top	right	of	design	view.	Minor	French	effect	name	translation	improvements.	Fixed	invalidation	but	wherein	changing	blueprint	didn't	invalidate	the	no-longer	matching	blueprint	selector.	Added	'Cue	Count'	to	the	list	of	possible	sort	terms	for
sorting	rows	in	reports.	Fix	an	email	case	sensitivity	bug	in	license	assignments.	Tune	'long',	'big',	and	'dense'	adjectives	to	have	larger	effect	sizes.	Added	'DMX	>	Edit	DMX	effect'	dialog	for	editing	existing	DMX	effects.	Switch	to	SketchUp	SDK	2018.	Added	new	VDL	term	DLY	to	specify	the	delay	before	simulation/launch,	which	inserts	an	explicit
delay	before	the	simulation	of	the	cake,	candle,	or	individual	effect	begins.finale3d-installer-2020.02.26-a3d600ae1	(RELEASE)	Fix	render_use_slow_gdi_paint	setting	to	work	for	effect	preview	animations.	Fix	effect	icon	rendering	so	that	chrysanthemums	look	better.	Fixed	a	minor	but	with	the	'Add/edit	rails'	link	on	the	rack	layout	view	pertaining	to
when	the	user	clears	the	field,	which	previously	would	disable	a	helpful	warning	message	for	addressing	without	a	starting	point.	Added	subtitles	to	the	part	type	buttons	on	effect	palette	window.	Fix	bug	causing	effects	with	the	word	'fire'	in	them	to	have	bright	purple	colors.	Translate	'Gold	Tipped'	to	'Gold	Tip'.	Changed	'Import	show'	menus	to	add
explicit	menu	items	for	each	type	of	script	file	that	can	be	imported.	Started	Chinese	simplified	UI	translation.	Fixed	bug	causing	a	crash	with	some	sequencing/sorting	commands.finale3d-installer-2020.07.27-5668e477a	(BETA	VERSION)	Add	mortar	flare	to	effects.	Made	script	always	highlight	the	next	firing	row	after	playhead	unless	overridden	by
cursor	hovering	over	cue	flag	or	event.	Changed	default	option	to	timeline	movements	snap	to	ms	instead	of	hundredths.	Removed	the	old	'Effect	chooser'	dialog	as	it	is	now	replaced	by	the	new	functionality	of	the	effect	window,	connected	to	the	'C'	key.	Changed	timeline	graduation	text	formatting	and	cue	flag	poles	to	make	text	more	clear	to	read.
Added	the	little	dot	in	the	lower	right	corner	of	selected	table	cells	like	in	Excel,	a	'FILL	HANDLE',	to	extend	the	cell	values	in	a	pattern	or	incrementing	sequence.	Made	the	Add	Racks	dialog	provide	explanations	for	disabled	rows,	e.g.,	effects	fill	into	existing	racks,	or	effects	fill	into	other	rack	choices,	or	row	is	ignored;	these	explanatins	are
intended	to	make	the	dialog	more	understandable,	particularlly	in	complex	situations	with	single-shot	racks	that	accommodate	multiple	size	tubes.finale3d-installer-2021.08.09-02e8bd688	(BETA	VERSION)	Updated	Anonymouse	5	Head	Flamer	DMX	Patches	to	enable	rotating	the	flame	effects	in	the	user	interface.	Made	the	right	click	on	position
'Configure	as	DMX	fixture'	command	automatically	switch	to	the	effects	window	to	collection	of	effects	that	are	compatible	with	the	just	defined	fixture.	Vertical	indicator	on	timeline	when	hovering	over	effect	in	group	that	doesn't	have	a	cue	flag	on	account	of	not	being	the	primary	effect	in	the	group.	For	importing	HBS,	reverse	engineer	old-style
HBO31,	32,	34,	35,	36,	and	37.	Enabled	moving	unracked	pin	on	rails	by	drag	and	drop	in	the	rack	layout	view;	previously	it	was	possible	to	move	racked	pins,	but	not	unracked	pins,	other	than	connecting	them	to	tubes.finale3d-installer-2020.07.17-238e643d2	(RELEASE)	Add	'Star	Phases'	concept	to	effect	structure.	Added	'Break	apart	cake'
function.	Made	the	new	First	Angle*	column	hidden	in	all	standard/default	blueprints,	but	regrettably	the	new	column	will	appear	in	users'	customized	blueprints	and	blueprints	saved	with	existing	shows,	and	users	need	to	manually	remove	it	by	editing	the	report	blueprint	or	copying	a	fresh	new	report	blueprint	that	is	up-to-date	with	this	change
from	a	new	show	over	the	corresonding	blueprint	in	an	existing	show.	Make	'comet	to	report'	have	a	report	sound.	Fixed	bring-to-front	behavior	of	'Windows	>	Racks	window'	menu	item.	Added	adjustable	padding	on	printed	reports.	Added	context	menu	items	for	clicking	on	ground	for	'Aim	positions	at	this	point'	and	'Aim	positions	at	this	point	in
parallel'	to	make	it	easy	to	angle	positions	toward	anything.	Made	text	color	of	rack	angles	black	instead	of	gray,	to	make	it	more	visible.	Added	a	demo	mode	notification	in	the	upper	right	corner	if	you	are	operating	in	demo	mode.	Fix	'flicker'	render	bug.2018.10.10-a3b5fc52-finale3d-win32-installer	(RELEASE)	Tune	wave	and	palm.	Improve	long
hang	when	building	scene	for	'25	shot	Popcorn	crackle	cake'	(it's	still	a	bit	slow).	Added	'Racks	>	Rack	counts'	menu	item	to	rack	summary	page.	Added	'Rack'	subtype	for	racks	as	a	VDL	term.	In	rack	layout	window,	hovering	the	cursor	over	a	rack	tube	highlights	the	event	in	the	script	associated	with	that	tube.	Fixed	bug	causing	smoke	trails	to	pop
out	of	existence	instead	of	fading	away.	Added	xray	mode	on	timeline	that	draws	effect	names	in	the	timeline	instead	of	light	bars.	Improved	hide/unhide	column	menu	by	showing	both	the	hidden	and	unhidden	columns.	Fix	bug	causing	0.0	duration	for	some	effects	that	have	trails	with	no	tips	(e.g.	flying	fish).2019.08.21-495b5838-finale3d-win32-
installer	(RELEASE)	Highlighted	'Edit	racks'	button	when	editing	pins	in	rack	layout	so	user	doesn't	get	stuck	without	knowing	how	to	exit	the	mode.	Changed	'Show	information'	dialog	to	say	'Default'	firing	system/module	type	to	avoid	confusion.	Fixed	ematch	count	on	addressing	summary	dialog,	previously	had	a	bug	with	chains.	Fix	icon	renderer
handling	of	shots	which	have	zero	duration	before	their	break	(mines).2017.11.05-a3ebd5ab-finale3d-win32-installer	(RELEASE)	Added	'timerain'	as	a	synonym	for	'time	rain'.	For	importing	HBS	files,	reverse	engineered	HBO31	falling	leaves	and	ti	salutes.	Added	device	count	to	effect	name	of	chains	and	groups	on	timeline	such	as	[5]	Red	Chrys
Chain	so	you	can	tell	the	difference	between	a	chain	and	a	single	item	easily	now	that	chains	are	one	row	on	the	timeline.	Fixed	bug	that	close	box	in	table	window	filter	field	would	also	clear	quantity	selector.	Fixed	crash	bug	importing	cakes	with	more	than	1000	shots.	Added	capability	of	understanding	Dutch	effect	names,	translating	Dutch	to	VDL.
Added	'Import	show'	capability	for	Cobra	Show	Creator	CSV	files,	including	all	four	types	of	scripts	--	step	script	by	events,	step	script	by	tracks,	separate	scripts	for	tracks,	and	standard	script.	Allow	price	editing	from	3d	client	->	finale	inventory.	0	was	already	an	invalid	value	that	the	system	would	never	assign	but	it	was	previously	possible	to	enter
the	number	0	for	a	reference	manually.	Fixed	crash	bug	that	occurred	when	addressing	a	show	with	events	that	are	not	on	a	valid	position.	Changed	cake	and	candle	duration	to	be	'first	launch	to	last	break'	Made	explicit	prefire	specification	of	a	cake	or	candle	carry	through	to	specify	the	prefire	of	the	first	effect	in	the	cake	or	candle.	Made	'C'
hotkey	invoke	effects	window	with	search	field	focused	and	search	text	highlighted	and	arrow	keys	hot	from	within	the	search	field	to	select	rows,	and	control-enter	hot	to	insert,	and	control-shift-enter	hot	to	replace-with-effect.	Improve	text	of	on	rack	rows	in	'Add	racks'	dialog.	Slightly	improved	row	layout	for	'Combine	as	cake'.2019.10.01-
2899e9d3-finale3d-win32-installer	(RELEASE)	Fix	bug	causing	all	ground	strobes	to	light	up	in	sync.	Added	DXM	fixtures	including	Explo	GX2	and	GX3,	Sigma	Services	FireFly,	Auvi	Spark,	generic	5	head	7CH	flamer	fixture	and	multiple	Magic	FX	fixtures	along	with	related	effects.finale3d-installer-2021.06.07-42b3ea54f	(BETA	VERSION)	Added
support	for	Sigma	Services	FireFly	flame	systems.	Added	'description'	column	to	script	table	and	to	sort	options	for	addressing.	Added	support	for	Pyromac	V2	script	format	export,	and	for	the	DMX-BOX.	Added	capability	to	control	Explo	X2	Wave	Flamer	by	DMX.	This	change	results	in	fewer	module	types	to	choose	from	for	a	number	of	firing
systems.	Added	1sec	and	5sec	snap-to	on	timeline	when	user	moves	cursor	vertically	while	dragging	playhead	or	items	horizontally.	Update	Sketchup	SDK,	so	that	we	can	now	load	Sketchup	2019	files.2019.09.11-40a6f1a7-finale3d-win32-installer	(RELEASE)	Changed	Pyromac	max	DMX	duration	to	59.99.	Fix	duration	calculation	for	popcorn	crackle
and	several	related	effects.	FIxed	bug	saving	files	with	pathnames	that	contain	dot	characters.	If	user	has	slave	AND	master	position	selected	and	user	adds	an	effect	to	the	master	with	right-click	menu,	deselect	the	slaves	so	the	effect	is	only	added	to	the	master.	Show	an	error	message	box	when	audio	initialization	fails.	Improved	'Replace	rack...'
and	'Replace	effect'	functions	when	a	cell	in	a	row	is	selected	rather	than	the	entire	row.	Added	support	for	Korean	character	set.	Added	Pyrodigy	exporter.	Added	context	sensitive	cursor	icon/images	for	rolling	over	hot	spots,	buttons,	column	resize	zones,	etc.	Added	new	fireTEK	script	format,	V4,	with	12	columns.	Added	report	configuration	option
to	center	text	alignment	in	chosen	fields.	Fixed	bug	in	reports	printed	to	XLS	and	CSV	file	formats	wherein	table	format	was	wrong.	Made	'Combine	as	cake'	function	preserve	all	timing	gaps.	Added	'My	Parts'	cloud-stored	parts	file.2018.01.12-0fc1b311-finale3d-win32-installer	(RELEASE)	Added	'Show	>	Set	timeline	snap-to	resolution'	for	working	in
SMPTE	or	other	frame	rates.	Make	these	items	disabled,	and	include	explanatory	annotation,	'Mismatching	Rack	Type'.	Revamped	the	'Make	into	fan'	dialog,	adding	the	capability	to	make	fans	sorting	by	effect	time,	center	to	outside	or	outside	to	center,	and	adding	a	help	message	box	on	the	dialog	that	explains	what	all	the	options	do.	This	has	been



fixed,	the	water	will	be	rendered	now.	Prevent	windows	from	getting	buried	underneath	other	apps	by	hoisting	all	3D	windows	to	the	front	whenever	the	user	clicks	any	3D	window	to	the	front.finale3d-installer-2021.12.10-72c4a7af1	(BETA	VERSION)	Changed	the	'Padding'	field	in	label	customizations	to	'Vertical	padding'	and	added	'Horizontal
padding'	field,	to	decouple	the	two	types	of	padding.	Reduced	height	of	playhead	to	make	it	easier	to	select	cue	flags	behind	it.	Change	icon	rendering	camera	setup.	Fixed	'Combine	as	cake'	bug	of	finding	non-optimal	cake	row	pattern	when	last	row	is	different.	Support	replacing	items	within	chains	in	addition	to	full	chains	as	units.	Added	options	to
the	'Add	background	image...'	function	for	importing	images	with	alpha	transparency	for	creating	scenes	in	which	some	fireworks	are	in	front	of	the	image	and	others	are	in	back	of	the	image.	Fixed	a	bug	with	Spray	The	Fire	fixture	configuration.	Added	right-click	context	menu	on	positions	to	configure	them	as	DMX	fixtures,	'Configure	as	DMX
fixture...'	Added	context	menu	item	on	positions	to	filter	effects	window	to	compatible	effects	for	the	fixture	type	that	the	position	represents.	Digitally	sign	the	installer	and	exe	files	to	try	to	avoid	the	'scary'	dialogs	on	install.	Several	improvements	to	startup	time	and	the	time	it	takes	to	sync	with	network.2018.05.27-aa276207-finale3d-win32-
installer	(RELEASE)	Changed	the	way	that	the	Finale	Inventory	per-location	inventories	are	managed	(now	inventory	loading	is	much	faster).	Added	'Select	positions	by	name...'	for	positions	and	position	groups.)Fixed	bug	with	position	group	names	containing	spaces.	Minor	optimizatin	to	fireTEK	DMX	exporter,	removing	duration	field	when	channel
value	is	zero.	Added	main	DMX	menu	with	all	DMX	functions.	Updated	the	Pyrotronix	PTX2	exporter	for	DMX	support	for	triggering	pre-defined	presets	on	the	controller	--	please	see	new	Pyrotronix	PTX	documentation	in	the	firing	systems	section	on	the	finale	software	documentation	page.	Added	CONTAINSSUBSTRING	function	to	conditional
formatting	expression	language.	Added	'Racks	>	Add	racks	for	selected	events...'	Added	'Drag	selection	box'	link	to	rack	layout	view,	because	people	didn't	know	that	holding	shift	and	dragging	on	background	would	drag	a	selection	rect	in	rack	layout	view.	Fixed	import	effects	file	bug	wherein	duration	units	guess	would	be	wrong	and	the	'ignore
duration	in	file'	option	would	ignore	the	size	instead.	Added	File	>	Admin	>	Regenerate	effect	icons.	Changed	name	of	'Script'	report	to	'Wiring	Script'	and	added	a	new	report	'Spotter	Script'	that	is	sorted	by	effect	time	and	that	begins	with	'Cue	Count'	as	the	first	column	and	that	has	columns	arranged	in	a	different	order.	Added	generic	5	head	7CH
flamer	fixture.	Added	submenus	for	reports	and	labels	in	the	'File'	menu.	Fixed	startup	crash	caused	by	quitting	app	while	main	window	is	minimized.	Adjust	tuning	on	crossette	shells.2018.08.29-1532d2dd-finale3d-win32-installer	(RELEASE)	Add	new	motion	simulation	for	spinners.	Made	addressng	functions	select	the	events	that	were	missing
racks,	if	there	were	any.	Made	it	possible	to	re-address	a	position	even	if	it	has	no	events,	no	pre-assigned	rails,	and	no	start	module,	in	which	case	the	first	unused	rail	address	is	the	default	starting	point.	Updated	Russian	UI	translation.	Changed	default	window	layout	to	#2.	Improvements	to	polyp	and	some	other	shells.	Added	'Effects	above	design'
and	'Script	above	design'	standard	window	arrangements	as	shift-8	and	shift-9.	Option	in	File	>	User	settings,	to	support	swapping	monitor	1	and	2	in	multiple	monitor	configurations.2019.01.11-f71f13bb-finale3d-win32-installer	(RELEASE)	Added	'File	>	Export	>	Export	Show	Director	csv'	function	to	export	in	Show	Director	format.	Added
product_summary_per_position	report	and	chain_building	report.	Support	Cobra	lockout	field.	Make	ground	flares	less	bright.	Added	automatic	screen	resolution	re-scaling	to	correct	timeline	height	on	some	systems.	Fixed	formatting	bugs	in	Pyromac	script	exports.	For	printed	reports,	disabled	the	automatic	quantity	in	parentheses	prepended	to	the
description	names,	since	reports	typically	have	a	separate	column	for	device	quantity	if	desired.	Fix	bug	when	rendering	movie	where	songs	played	at	the	wrong	start	times.	Fixed	usage	count	bug	wherein	effects	in	Finale	Inventory	with	chainNumberOfDevices=0	didn't	get	counted.	Fix	layout	bug	causing	the	'button	bar'	to	not	appear	at	the	bottom
of	the	sync	dialog.finale3d-installer-2020.04.15-bf0231e77	(RELEASE)	Use	'purple	comet'	placeholder	for	customized	effects	that	can't	be	loaded.	Make	rotate	function	rotate	around	center	of	viewing	area,	rather	than	what	cursor	points	at.	Added	description	field	to	the	'Create	rack'	dialog	so	you	can	give	the	rack	a	name.	Improved	spreadsheet
formatting	for	effect	name	language	translations.)Added	Unicode	upper/lower	case	conversions	for	Russian	alphabet.2018.07.02-4ce65b56-finale3d-win32-installer	(RELEASE)	Added	'Angle	Graphics'	column	to	script	table,	to	show	all	angles	represented	by	that	row	as	ASCII	art.	Fix	bug	causing	'input	lag'	on	some	Finale	operations.2018.03.03-
52dc3e29-finale3d-win32-installer	(RELEASE)	Added	'Insert	effect'	to	effect	menu.	Spanish	effect	language	improvements.	Fixed	render	issue	causing	shell	breaks	to	look	'square'.	Disabled	the	'DMX	effect	in	pyro	position'	warning	dialogs	if	the	default	firing	system	in	'Show	>	Set	show	information...'	is	RJEquipamentos	or	the	other	two	firing	systems
with	non-DMX	flame	support,	Explo	and	Galaxis.	Fixed	FireTek	exporter	for	pyro	from	DMX-capable	modules.	Changed	the	'X'	hotkey	to	be	selection	box.	We	now	cache	the	Finale	Inventory	effects	catalogs,	just	like	the	My	Effects	catalog,	so	that	they	are	available	if	you	run	in	offline	mode.2018.05.02-1fbae3ad-finale3d-win32-installer	(RELEASE)
Added	import	options	for	duration	time	units.	Changed	the	user	interface	paradigm	for	DMX.	Added	a	rack	column	to	the	other	two	single_shot_setup_by_module	reports.2019.10.16-a6245ffe-finale3d-win32-installer	(RELEASE)	Fix	some	GL	compatibility	issues	on	Intel	integrated	graphics.	Fixed	formatting	of	'Edit	addressing	blueprint'	dialog.	Made
the	timeline	bar	ends	that	are	draggable	be	higher	priority	for	clicking	on	than	the	middle	of	a	timeline	bar,	so	the	endcaps	can	be	clicked	and	dragged	even	if	timeline	bars	are	overlapping.	Fixed	bug	causing	multi-stage	mines	(eg	'red	to	blue	mine')	always	having	a	trail	on	the	final	stage.	Added	black	border	around	any	single	yellow	cell	to	indicate
hit	has	keyboard	focus.	Fixed	Fire	Pioneer	addressing	number	of	pins,	changing	from	0-32	to	0-31.	Moved	effect	bar	effect	name	text	to	bottom	of	timeline	instead	of	overwriting	effect	bar.	Made	import	show	ignore	the	value	0	in	the	duration	column	if	guessing	duration	units,	because	0	usually	means	the	user	hasn't	set	it,	rather	than	the	effect
actually	has	a	zero	duration.	Scaled	down	size	of	effect	palette	on	short	height	windows	so	it	isn't	offensively	large.	Update	Hungarian	translation.	Fixed	the	'Remaining	available'	column	in	the	effects	window	and	the	table	layouts	from	the	gear	menu	that	filter	to	available	>	0,	etc.	Simplified	menu	command	options	for	inserting	and	replacing	effects
based	on	the	new	effect	window	capabilities.	Make	dahlia	stars	larger.	Tune	gold	trails	down	a	bit.	Fixed	bugs	in	design	view	wherein	cursor	image	didn't	update	after	hovering	over	timeline	or	was	incorrect	in	effect	bar.	Set	default	framerate	target	for	edit	mode	to	10.02019.03.05-be87b4ed-finale3d-win32-installer	(RELEASE)	Tune	mines.	Added
embedded	part	numbers	in	the	Cobra	v6.0	script	export	format	for	the	Cobra	reverse	logistics	feature	for	accounting	for	unshot	shells.	Added	optional	maxInitialDmxSetupDelayMs	per-show	setting	to	give	advanced	users	the	ability	to	shorten	the	DMX	setup	delay	on	the	first	events	of	triggered	tracks.	Fixed	crash-on-startup	bug	introduced	in	last
release	pertaining	to	new	handling	of	Finale	Inventory	per-location	quantities.	Fixed	bug	where	dragging	sliders	in	the	effect	editor	was	very	slow	and	choppy.finale3d-installer-2022.05.06-7eb8143cc	(BETA	VERSION)	Added	support	for	the	ADJ	Inno	Pocket	Spot	Pearl	Moving	Head	Spotlight	fixture.	Improve	support	for	user	typing	in	addresses
manually	into	the	script,	then	locking	the	addresses,	and	then	doing	'Addressing	>	Address	show...'	to	address	around	them,	avoiding	conflicts.	(e.g.	"Red	&	Green	Peony	Cake").	Add	reset	activations	link	to	About	dialog.	Removed	the	basic/advanced	menu	configuration	options	for	racks;	now	there's	only	one	menu	configuration,	and	it	is	simpler	than
before.finale3d-installer-2020.09.01-c2e4986ea	(RELEASE)	Updated	Brazilian	Portuguese	UI	translation.	In	the	list	of	DMX	effects	that	can	be	added	to	a	fixture	from	the	right-click	menu,	keep	the	list	sorted	by	part	number	except	promote	important	effects	like	safety	channels	to	the	top	of	the	list.	Fixed	minor	bug	with	the	leading	zeros	formatting	of
pins	in	full	address	fields	of	labels.	Fixed	bug	in	randomize	feature	wherein	for	small	numbers	of	positions	the	algorithm's	removal	of	runs	would	result	in	a	less	desirable	sequence	than	the	true	randomization	that	it	was	trying	to	improve	upon.	Added	a	hotkey	for	the	setting	to	display	items	on	timelines	as	blips	instead	of	bars,	so	you	can	toggle	that
setting	easily.	Changed	name	of	'Product	list	with	details'	report	to	'Effect	collection	product	report'	to	clarify	it	applies	to	the	effect	window.	Improved	ESC	key	behavior	for	text	editing	in	tables	so	single	ESC	cancels	text	entry	instead	of	two	ESC	presses.	Fix	bug	in	'Create	high-res	image'	functionality.	Fixed	crash	bug	with	new	'Zoom	to	selected'
button	when	used	with	timeline	rounding	to	100ths	of	a	second.	Added	Moka	H-E01	Genius	Flame	Machine	and	Moke	H-E01	Triple	Way	Flame	Machine,	with	effects	in	the	Assorted	DMX	catalog.	Further	improved	'Chain	Specifications'	standard	report	by	combining	rows	of	same-effects	in	a	multi-effect	chain,	so	a	20-shell	chain	that	consists	of	10	red
peonies	followed	by	10	blue	peonies	would	only	take	two	rows	in	the	report,	not	twenty.	Fix	bug:	previously,	we	did	not	render	water	when	the	terrain	brightness	was	set	to	0.	Redesigned	the	standard	'Cue	Sheet'	report	to	make	it	much	better	suited	for	manual,	pin	board	shows.	Made	shift-clicking	items	in	selector	menus	work	in	real	time	to
add/remove	terms	to	the	filter	criteria	quickly	without	re-opening	the	menu	every	time.	Added	support	for	Piroshow	to	fire	pins	multiple	times	at	different	times,	'multi-hit	pins'.	Added	Pyromate	digital	firing	system	support,	including	'File	>	Download	to	controller'.	It	fixes	a	couple	of	vdl	bugs,	but	the	real	focus	is	a	foundation	for	making	vdl
improvements	in	the	future.	Changed	default	position	names	from	Pos-01,	Pos-02,	etc.,	to	P-01,	P-02,	...	Added	'Pin	Board'	firing	system	option	in	addressing	menu,	with	pre-defined	options	for	popular	pin	board	configurations	including	32,36,45,48,50,100,400	pins.	Change	song	volume	default	to	100%2018.02.23-02a74da6-finale3d-win32-installer
(RELEASE)	Made	effect	chooser	wide	and	added	columns	for	color,	price,	etc.	Updated	German	UI	translation.	Fixed	localization	to	other	languages	in	dialog	selector	menu	items.	Support	parts	importer	importing	the	'tubes',	'rack	type'	and	'dmx	patch'	fields.	Effect	Editor:	Put	an	Input/Output	box	at	the	top	of	the	frame	again,	and	remove	the	effect
fields	that	corresponded	to	columns	in	the	effects	table.	Added	error	checking	and	error	messages	for	exporting	DMX	events	that	do	not	have	DMX	patches.	Fixed	effect	parsing	bugs	with	asterisks	and	the	syntax	of	N*M	shots	in	the	effect	name.	Made	scrollwheel	over	scrollbars	on	timeline	and	tables	zoom	instead	of	move	the	thumb.	Fix	missing
translation	entry	for	'Apply	changes'	button.	It	is	still	not	saving	the	downloaded	image	yet.2019.03.21-da4255a9-finale3d-win32-installer	(RELEASE)	Fix	some	GPU	memory	leaks	with	the	previous	attempt	at	this	release.	In	rack	layout	view,	hide	rack	size	below	racks	unless	racks	are	selected,	to	remove	clutter;	right	click	rack	and	set	annotation	if
you	want	an	alternative.	Ignore	redundant	VDL	row	delay	and	duration	specifications	on	parallel-firing	rows.	Fixed	saved	state	of	the	'ignore'	checkbox	in	the	Add	Racks	dialog.	Adjusted	text	position	of	the	angles	above	racks	to	make	them	more	visible.	Updated	Polish	and	Norwegian	UI	translations.	Made	'Edit	effect'	command	preserve	prefire,
duration,	and	height	values	from	the	columns,	and	extract	from	VDL	so	not	redundantly	recorded.	Fixed	problem	of	pop-up	menus	extending	off	edges	of	monitors	in	multiple	monitor	configurations.	Changed	Mongoose	exporter	field	delimiter	to	comma,	and	apply	Excel-style	double	quote	escaping,	and	allow	double	quote	in	descriptions.	Added
quantities	to	all	selector	menu	items,	e.g.,	click	the	'Size'	selector	on	the	script	to	see	how	many	shells	of	each	size	you	are	using.	reformatting,	remove	BreadCrumbTrail.scs	Update	to	Ukrainian	and	Russian	UI	translations.	Added	three	new	rack	reports:	counts_per_angle_per_rack,	single_shot_setup_by_rack_with_pan_tilt,
single_shot_setup_by_rack_with_pitch_roll.	Made	it	possible	to	group	a	single	event,	which	is	useful	if	you	want	the	event's	timeline	bar	to	cascade	vertically	on	the	timeline	as	groups	do	instead	of	being	at	a	fixed	Y	coordinate	based	on	the	fixture,	for	DMX	effects.	Miscellaneous	effect	editor	improvements.finale3d-installer-2020.02.21-07756e046
(RELEASE)	Updated	Polish	UI	translation.	Added	Russian	alphabet	and	WIP	on	Russian	effect	name	translations.	Change	the	way	sounds	for	effects	are	handled.	Fix	issue	with	reports	and	salutes	not	working	in	certain	effects.2018.07.17-3b42ce12-finale3d-win32-installer	(RELEASE)	Added	Russian	and	German	compound	effect	terms.	Changed
cursor	image	to	back-of-hand	when	dragging	timeline	background.2018.12.14-7ac4ba77-finale3d-win32-installer	(RELEASE)	Re-add	shadows	underneath	positions	so	that	it	is	easier	to	see	where	the	positions	are.	Improved	DMX	exporter	for	moving	head	gobo	light	fixtures	by	making	gobo	setup	time	initiate	exactly	one	second	before	effect	begins
instead	of	much	longer,	which	didn't	matter	but	was	confusing	if	you	were	trying	to	understand	the	exported	script.	Fix	bug	causing	sounds	in	movies	to	not	be	at	the	correct	time	if	the	movie	render	start	time	was	not	0:00.finale3d-installer-2020.05.05-7d992442c	(RELEASE)	Fix	a	sync	error	causing	sync	to	fail	with	certain	languages/character	sets.
Fix	bug	where	crossette	mines	were	not	breaking	into	crossettes.	Make	small/big	adjectives	apply	to	mines.	Fixed	minor	bug	wherein	the	'update	effects	in	show'	dialog	would	appear	after	you	change	a	rack	definition,	and	would	incorrectly	fill	in	the	rack	tube	size	as	3inch	if	it	was	'any_size'.	Added	'Initialize	fixture'	and	'Reset	fixture'	effects	for
fixtures	that	need	them,	and	warning	messages	if	you	need	them	and	don't	have	them.finale3d-installer-2021.04.15-f5234ddc0	(BETA	VERSION)	Made	the	position	rulers	only	appear	when	positions	are	unlocked.	Added	'VendorNumber'	field	to	FireOne	exporter,	drawing	from	the	'Manufacturer'	column	in	Finale	3D.	Added	'File	>	Tools	>	Verify	PDM
file...'	so	you	can	verify	and	get	a	summary	for	PDM	file	before	downloading.	Added	a	checkbox	'Shift	interiors	away	from	zero-margin	edges'	to	label	customizations	to	enable	the	user	to	turn	this	feature	off.	Effect	Editor:	Fix	negative	numbers	inside	of	customized	effects.	For	importing	HBS	files,	improved	trail	color	reverse	engineering	for	HBO48
and	reverse	engineered	color	changing	mines	and	comets.finale3d-installer-2020.01.18-fac7412dd	(RELEASE)	Add	some	missing	strings	to	the	translation	template.	Fixed	a	bug	with	fits-any-size	mortar	racks,	which	aren't	very	common	but	which	had	the	problem	of	not	getting	addresses	in	some	circumstances.	This	change	removes	the	angle	channel
DMX	events	from	the	macros	in	exported	script	in	order	to	make	the	first	DMX	channel	events	from	the	macros	occur	at	the	effect	time	itself	as	opposed	to	in	advance	of	the	effect	time	for	purpose	of	setting	the	angle;	from	now	on	if	you	want	a	default	angle	for	macros,	please	insert	a	'With	Default	Angle'	effect	and	adjust	its	duration	to	cover	the
period	of	operation.	Added	Tilt	and	Reverse	Tilt	and	type	variations	of	them	as	addressing	sort	terms.	Enhanced	Galaxis	exporter	to	add	a	'Start	show'	row	at	time	zero	if	the	scripted	events	do	not	begin	at	time	zero.	Fixed	bug	in	Effect	Chooser	window	wherein	clicking	on	item	didn't	work	if	per-show-parts	window	active.	Improved	the	styling	of	the
effect	icon/buttons	on	the	effect	window.	Support	drag	and	drop	from	effect	palette	to	timeline.	Added	support	for	the	tiltable	rows	type	of	rack	in	the	new	addressing	function,	'Re-arrange	tubes	in	adjustable	angle	racks	to	avoid	collisions.'	Fixed	minor	UI	bug	wherein	'Effects	>	Update	per-show	effects'	would	always	show	effects	with	DMX	Patches
to	needing	an	update	even	if	they	were	already	up	to	date.	Fix	minor	bug	wherein	racks	dialog	could	show	'Apple	Banana'	as	a	rack	option	for	one	of	the	rows	if	the	user	had	changed	the	definition	of	the	rack.	Fix	some	crash	bugs	due	to	non-ascii	pathnames.	Fixed	bug	with	Mongoose	and	Cobra	exporters	for	DMX	effects	with	Type	=	'other_effect',
which	had	caused	durations	to	be	blank.	Improved	tube	and	row	layout	in	VDL	output	from	combine-as-cake,	making	cakes	more	uniformly	rectangular	in	physical	construction	when	possible	by	converting	wide-row	fans	and	Vs	and	TRIs	into	equivalent	combinations	of	smaller	rows,	BLT,	BRT,	ARL,	ARL,	etc.,	when	a	suitable	equivalent	representation
exists.finale3d-installer-2019.12.16-81a3387ec	(RELEASE)	Disable	effect	editor	invocation	from	the	3d	view	right-click	popup.	Fixed	minor	bug	in	Hobbyist	mode	that	the	'Add	racks'	functions	unhelpfully	switched	to	the	disabled	rack	layout	view.	Fixed	Galaxis	time	format	bug	for	delta	times	of	60	seconds	or	more.2019.07.08-8dcd0795-finale3d-
win32-installer	(RELEASE)	Reduce	renderer	memory	usage,	which	should	help	with	some	crashes.	Added	a	new	addressing	sort	term	'Matches	Any	Rack'	to	enable	you	to	put	items	that	do	not	have	racks,	like	cakes	or	non-slice	cakes,	at	the	end	of	the	modules.	Minor	improvements	to	the	layout	of	the	addressing	dialog	checkboxes.finale3d-installer-
2021.09.08-32d54467a	(BETA	VERSION)	Enhanced	copying	rows	in	the	positions	window	to	include	any	referenced	models	in	the	copy	buffer,	as	copying	does	if	you	copy	from	the	design	view	window,	making	it	easier	to	copy/paste	positions	with	attached	models	from	one	show	to	another.	Added	semi-auto	firing	mode	to	Piroshow	exporter	for	scripts
that	contain	valid	Track	values.	Made	shift-click-drag	in	the	position	ribbon	in	2D	Lock	mode	drag	a	selection	rect	that	applies	exclusively	to	position	nametags	in	the	ribbon.	Reactivate	products	in	Finale	Inventory	if	they	are	being	added/modded	from	Finale	3D.	Fixed	importing	HBS	HBO31	colors.	Fix	crash	that	occured	when	importing	inventories
with	missing	fields.2018.01.22-be53ef4a-finale3d-win32-installer	(RELEASE)	Made	fill-down	addressing	function	work	with	filtering.)Improved	some	menu	item	text.	For	importing	HBS,	reverse	engineer	HBO48	pistil	and	ring	petals.	Alphabetized	all	options	for	addressing	constraints	and	sorts	and	labels/reports	customization	fields.	Made
'Edit/Create	effect/rack/chain/cake	VDL'	functions	preserve	existing	Type	field	if	updating	existing	effect	so	as	not	to	overwrite	single_shot	type	unintentionally,	with	comet	or	mine,	for	example.	Fixed	fan	angle	width	for	importing	HBS	with	HBO43.	Fix	login	bug	causing	some	users	to	'get	stuck	in	trial	mode'.	For	G2	export,	include	all	fixtures	and
modules	pre-assigned	to	positions	in	equipment	list,	event	those	without	events.	Improved	detailed	explanation	for	why	effects	don't	match	single-shot	racks	unless	their	type	is	single_shot.	Update	Ukrainian	and	Russian	translations.	Fixed	bug	in	cue	order	in	Fire	Control	G2	exporter.	Update	German	UI	translation.	Fix	a	crash	in	the	vdl	parser's
handling	of	fountains.	Added	simulations	for	explo	wave	and	step	flame	macros.	Changed	name	of	menu	item	and	added	XLSX	format	option	to	'File	>	Export	>	Export	effects...'	which	exports	the	effects	table.	Added	filters	to	all	script	reports	and	labels	to	exclude	DMX	effects.	Added	absolute	value	function	ABS	to	conditional	formattiong	expression
language	to	facilitate	comparing	numbers	with	precision	error	tolerance.	Added	'Export	>	Export	camera	coordinates...'	as	a	Pro	feature	that	exports	a	CSV	file.	Improved	various	standard	reports	to	take	advance	of	the	indenting.	Make	trajectory	markers	line	up	to	simulation	breaks.2017.10.16-5760e5ab-finale3d-win32-installer	(RELEASE)	Fill-down
addresses,	and	other	addressing	functions,	select	all	addressed	rows	at	completion	of	the	operation.	Fixed	minor	addressing	UI	bug	for	rack	assignments	for	ground	type	items	when	'Treat	all	missing	racks	as	errors'	is	unchecked.	Fixed	bug	in	formatting	of	angles	in	labels,	wherein	'up'	was	printed	as	0	degrees	even	if	chosen	angle	convention	was	up
=	90.	Updated	Pyrodigital	'fix'	for	manual	fire	macros	based	on	further	information	from	Pyrodigital.	Made	the	'Add	position'	function	automatically	unlock	positions,	to	save	you	a	mouse	click.	Changed	layout	of	design	window,	removing	white	margins	and	using	smaller,	orange	scrollbars.	Added	checks	to	make	it	impossible	to	have	multipleshows
open	with	the	same	name,	to	eliminate	the	risk	of	losing	data	by	exiting	and	saving	changes.	If	user	has	slave	AND	master	position	selected	and	user	adds	an	effect	to	the	master	with	right-click	menu,	deselect	the	slaves	so	the	effect	is	only	added	to	the	master.finale3d-installer-2021.03.12-c183ef9b4	(BETA	VERSION)	Speed	and	reliability
improvements	for	Finale	Inventory	sync.	These	kinds	of	fountains	are	still	broken	and	don't	show	anything	in	the	simulation.	Relocated	the	drag	and	drop	hot	spot	for	cursor	image.	Added	400	roman	candles	to	generic	effects.	Improved	standard	chain	specifications	report	to	print	single	rows	for	same-effect	chains	and	multiple	rows	for	multi-effect
chains,	so	a	single	report	contains	all	necessary	chain	information	but	without	unnecessary	rows.	Implement	'see	prices'	permission.	Improved	help	text	on	ghost	icon	for	hidden	columns.	Added	ability	to	hide	the	line	number	column.	Added	error	checking	and	a	warning	dialog	when	playing	a	show	for	DMX	fixtures	missing	universe,	channel	base
fields,	or	having	conflicts,	or	slave	fixtures	not	referring	to	a	master,	or	slave	fixtrues	having	effects.	Added	helpful	do-not-show-again	instructions	dialogs	to	rack	layout	view	for	dragging	effects	from	effect	basket.	Added	universe	and	section	to	Show	Director	CSV	format	in	CUSTOM1	and	CUSTOM2.	Pre-assigned	rails	are	always	shown	in	the	rack
layout	view	even	before	addressing	and	if	events	are	not	addressed	to	them.	Fixed	addressing	crash	bug	occuring	with	events	having	no	position,	including	empty	events.	Implement	heart	and	smiley	breaks.	Fixed	Explo	X2	Wave	Flamer	sims	for	programss	#63-66,	which	were	incorrect.finale3d-installer-2021.04.02-dd597a632	(BETA	VERSION)
Updated	German	UI	translation.	Support	saving/loading	fountains	to	Finale	Inventory.	Added	'Align	at	latest	event	time'	and	'Align	at	latest	effect	time'.	Made	minor	fix	to	timeline	'zoom	to	selected'	function	when	a	single	placeholder	cue	is	selected	at	the	time	of	pressing	the	button.finale3d-installer-2020.03.10-0e072f682	(RELEASE)	Updated
Brazilian	Portuguese	UI	translation.	Added	'Degrees'	keyword	to	VDL	to	specify	the	fan	angle	of	a	cake.	Added	clickable	padlock	button	in	lower	right	for	locking/unlocking	positions.	Added	support	for	Pyromaster	firing	system.	Added	more	helpful	error	message	if	user	tries	to	address	before	having	assigned	any	DMX	universe	or	channel	bases	to	the
fixtures.	Fix	bug	where	aerial	breaks	were	not	making	sound.	Extend	VDL	language	to	include	an	'exact	simulation	syntax	row	description'	for	cakes	that	is	able	to	represent	arbitrary	timing	and	angles	of	shot	to	a	resolution	of	1ms	and	1	degree,	and	make	cake-combiner	function	fall	back	to	using	this	exact	simulation	syntax	automatically	when	the
standard	syntax	doesn't	work	well.	Added	'File	>	User	settings	>	Show	rulers	in	feet	instead	of	meters'.	Fixed	'Chain	Gap'	column	in	the	script	and	the	'Chain	Specifications	Report'	to	calculate	the	correct	chain	delays	for	chains	with	devices	that	have	different	prefires.finale3d-installer-2021.06.25-2fc9ce5e7	(BETA	VERSION)	Updated	Polish	UI
translation.	Handle	Chinese	(Traditional,	Taiwan)	system	locale.	Made	VDL	parser	accept	cake	descriptions	with	row	firing	patterns	without	requiring	tube	labels	if	single	effect	cake,	as	in:	25	shot	gold	comet	z-shape	cake	5	rows	row	5	(3.0/fnt)	Fixed	chain	import	problem	for	chains	very	near	start	of	show.	NOTE(Improved	layout	of	top	section	above
table	windows.)	Adjust	VDL	tuning	to	remove	some	super-wide	variances.	Fixed	the	backward	compatibility	annoyance	of	new	versions	adding	new	columns	to	existing	show	reports	and	table	layouts	in	the	visible	state	instead	of	in	the	hidden	state.	Added	Pyrosure	exporter.2019.06.19-c14c6bc0-finale3d-win32-installer	(RELEASE)	Improved	Russian
and	Ukrainian	localizations.	Added	'Default	Filename'	to	Cobra	export	options	so	user	can	write	cobra.csv,	since	99%	of	the	time	that's	the	filename	the	user	wants	rather	than	the	name	of	the	FIN	show;	ignore	default	in	multi-universe	or	multi-firing	system	shows.	Strengthened	error	checking	on	module/pin	address	parsing.	Fix	issue	causing	movie
render	task	to	stutter	for	the	first	second	of	rendering.	When	selecting	a	cue	from	the	script	window,	the	timeline	bar	now	gets	brought	into	view	on	the	timeline	with	a	margin	cushion	from	the	edge,	to	make	it	easier	to	see.	Added	capability	for	reports	to	show	ranges	of	modules	and	pins	in	a	single	row.	Added	a	warning	message	if	user	tries	to
address	show,	position,	or	range	of	events	that	are	all	locked,	since	it	is	confusing	if	nothing	happens.	Show	the	position-line	rulers	even	from	side-view,	not	just	from	top-view.	Fixed	minor	printing	problem	in	which	very	tiny	mortar	circles	would	be	invisible.2018.08.27-8520eccc-finale3d-win32-installer	(RELEASE)	Fix	bug	causing
serpent/whirl/bee/spinner/etc	mines	to	'go	crazy'.	Added	reasonable	ATF	category	values	for	Generic	effects.	Fixed	PTX	exporter	bug	relating	to	delays	between	simultaneous	events.	Added	25	new	sort	terms	for	addressing,	such	as	CAKES	FIRST,	SIZE	OF	NON-CAKE,	CUSTOM	NUMERIC	FIELD	OF	MORTAR	ITEM,	which	enable	the	user	to	create
conditional	sorting	expressions	that	sort	different	types	of	effects	differently,	such	as	sorting	mortar	items	by	size	while	ignoring	size	for	cakes.	Added	coco,	cannister,	and	center	to	effect	name	interpreter.	Improved	Pyromate	SmartShow	script	importer,	making	it	automically	infer	module	type	based	on	module	number.	Add	'low	smoke'	and	'no
smoke'	as	translations	of	'clean	smoke'	and	'smokeless'.2019.10.24-e71ae128-finale3d-win32-installer	(RELEASE)	Update	Russian	and	Ukrainian	UI	translations.	Fix	login	bug	happening	for	some	users	with	extra	machine	licenses.	Updated	French	translation.	Added	checkbox	'Racks	>	Racks	settings	>	Rack	layout	shows	missing	racks	as	errors',	to
give	user	control	over	whether	pins	on	the	modules	show	up	in	red	if	there	are	no	racks	added	for	effects	of	that	size/type.finale3d-installer-2020.07.10-0a7dd9d49	(RELEASE)	Fix	bug	causing	'action'	sounds	like	whistles	to	go	missing.	Added	Pirotex	exporter,	including	1ms	resolution	and	32/64/128/256	pin	modules.2018.08.05-8c8cead4-finale3d-
win32-installer	(RELEASE)	Implement	new	rendering	method	to	improve	performance	and	stability.	Fixed	'Swimming'	and	'Fish'	terms	in	VDL	by	adding	translations	to	'Scattering'	and	'Flying	fish'	which	are	the	corresponding	VDL	terms.	Added	'Change	rail	address	of	effects	in	rack...'	to	rack	context	menu	in	rack	layout	window.	Fixed	crashing	bug
that	was	triggered	by	opening	a	large	FIR	file,	and	possibly	other	circumstances.	Theory	is	that	100ms	is	enough	protection,	and	feels	better.	Fixed	DMX	channel	labels	in	exported	scripts	for	user-created	fixture	definitions.	Added	a	new	kind	of	label	called	'Rack	Labels'	for	the	purpose	of	helping	the	crew	identify	where	racks	go	when	setting	up	the
show.	Fix	trails	on	gold	and	silver	mines.	That	was	almost	the	case	already	but	they	would	still	be	drawn	when	dragging	a	selection	box	even	when	positions	were	locked,	which	is	now	fixed.	Fix	several	crash	bugs	that	caused	Finale3D	to	crash	when	the	GPU	was	not	supported.2018.08.15-d068dc94-finale3d-win32-installer	(RELEASE)	Added	first
pass	of	Italian	effect	name	translation.	Added	red	square	warnings	on	rack	layout	screen	for	incompatible	rack	type,	effect	type,	angle,	or	size.	Added	selectors	to	effect	chooser	for	size,	color,	etc.	Added	right-click	context	menu	for	row	number	column	in	rack	layout	table.	Added	'relampagos'	effect	to	VDL,	including	sim.	Added	DMX	fixture
implementations	for	Moka	H-E04	Flame	Machine,	Rockville	BestBAR60,	Rockville	24	Light	Bar,	Anonymous	Fog	Jet	7CH,	OPPSK	Light	Bar,	Karma	Par	Light.	Fixed	bug	in	VDL	cake	parsing	occurring	with	very	long	effect	descriptions,	e.g.,	12	different	effects	in	the	cake.2018.04.05-1855337b-finale3d-win32-installer	(RELEASE)	Added	prefire	range
limit	for	PD	export.	Added	capability	to	export	voice	cues	tracks	with	opt	ions	for	channel	selection,	music/voice	cues	mixing	volumes,	lead	time	of	utterance	before	shots,	and	various	vocalization	options	including	human	voice,	and	buzzers,	and	beeps,	and	combinations.	Added	addressing	sort	criteria	ANGLES	LAST	and	PAIRS	LAST.	Added	support
for	Maltese	translation.	Fixed	chain	device	durations.	Made	the	'Used'	quantity	column	keep	track	of	used	racks,	not	just	effects.	Fixed	addressing	sorting	when	sorted	first	by	something	other	than	position.	Made	clicking	on	fixtures	in	design	view	automatically	switch	to	collection	of	compatible	effects	in	effects	window,	if	there	are	any.	Added
'Positions	>	Detach	positions	from	models'	which	allows	you	to	move	or	remove	the	model	without	affecting	positions	that	were	attached	to	it.	Fixed	bug	in	the	'Create/edit	effect	VDL'	dialog	and	VDL	importing	that	could	cause	the	wrong	heights	and	part	types	for	effects	inside	cakes	that	multiple	effect	types.finale3d-installer-2020.01.03-960ea3417
(RELEASE)	Tune	mines.	Added	automatic	time	adjustments	to	Piroshow	exporter	to	guarantee	that	pins	firing	on	the	same	module	are	separated	by	at	least	10ms.finale3d-installer-2020.01.23-2386d6e47	(RELEASE)	For	importing	HBS	files,	improved	trail	color	reverse	engineering	for	HBO48.	Fixed	default	duration	of	fan	cakes.	Fix	bug	in	simulation
heights	for	multi-layer	mines	(e.g.	'red	mine	w/	blue	above').	Fixed	'Add	racks'	to	take	into	account	sleeves.	Fixed	control-C	to	copy	from	selected,	yellow,	cell,	without	having	to	click	into	it.2018.01.05-9f0ec820-finale3d-win32-installer	(RELEASE)	Enabled	creating	selector	drop	downs	for	duration	and	prefire	in	the	tables.	Chagned	sort	of	fireTEK
columns	and	improved	DMX	efficiency	using	duration	field.	Added	highlight	colors	for	effect	bars	in	timeline	for	selected	vs.	Skip	show	import	configuration	dialog	if	importing	HBS	file.	Added	functionality	to	create	an	account	at	the	login	dialog	if	no	account	exists.	Slightly	improved	format	of	chain	specifications	report.	Fixed	gear	menu	'Reset	table
layout'	which	didn't	work	in	the	racks	window.	Fixed	'Subtract	used	quantities	from	available...'	for	chains	counted	as	one	unit.	Support	effect	phrases	like	'red	peony	crackle	flowers'	and	'craker	cris	roja'	without	requiring	a	'to'	transition	for	the	star's	terminal	condition	such	as	the	crackle	flowers	or	report.	Fixed	bug	in	'Add	racks'	UI	pertaining	to
fits-any-size	racks	in	the	dialog	consuming	effects	for	other	rows	in	the	dialog	even	when	disabled.	Added	the	keyword	HTM	to	VDL	to	specify	the	heights	of	cake	components	independently	so	the	heights	of	effects	in	a	cake	no	longer	need	to	be	the	same.	Improve	startup	time.	Added	rack_list_by_rack_type	report.	Expanded	interior	margins	of	label
templates	5195,	5260,	5267,	A4_L4737,	and	A4_L7158	to	reduce	printing	alignment	sensitivity.	Table	selectors	are	now	resized	to	avoid	sticking	out	the	top	of	the	search	bar	in	some	screen	resolutions.	Fixed	simulation	of	cakes	that	have	calibers	in	their	row	descriptions.	Added	Maltese	UI	translation.	Added	Moka	P-18	Washer	Light	with	effects	in
the	Assorted	DMX	catalog.	Added	DMX	channel	descriptions	and	position	names	to	Cobra	script	exports.	Added	'With	Default	Angle'	effects	in	the	effect	libraries	for	Showven	Circle	Flamer,	part	number	SHV1191,	and	Spark	Fabrica	Moving	Head	Flamer,	part	number	SPF1191,	and	changed	the	DMX	patches	to	remove	the	automatic	default	angles
for	the	macro/program	effects.	Fix	a	crash	bug	affecting	large	shows.	Added	'Disable	price	indicator	in	design	view'	option	for	demonstrating	to	clients	or	staff	who	should	not	see	prices.	Updated	Hungarian,	Polish,	and	Brazilian	Portuguese	translations.	Added	support	for	Showven	Sparkular,	Sparkular	Cyclone,	uFlamer,	and	Circle	Flamer;	and	Spark
Fabrica	Moving	Head	Flamer;	and	generic	DMX	relay	and	dimmer	flamers.finale3d-installer-2021.03.19-3854febfd	(BETA	VERSION)	Fix	Brazilian	Portuguese	language	detection.	Added	'File	>	Easy	racks	settings'	to	specify	user	preference	for	rack	lengths	by	size.	Added	automatic	inference	that	a	VDL	effect	is	a	cake	if	it	specifies	number	of	shots
and	is	not	a	candle	or	chain.	Fixed	report	formatting	to	XLS	and	CSV.	Added	Pyroneo	exporter.	Changed	labels	fancy	angle	based	colors	to	be	red	=	right,	green	=	left,	to	make	them	more	noticeably	different.	Hide	effect	palette	when	using	effect	editor.	Improved	descriptions	of	Wave	Flamer	effects,	using	convention	that	A>>B	means	all	steps	from
A	to	B,	whereas	A>B	means	A	first,	then	B.	Made	export	offset	field	in	'Show	>	Show	information...'	dialog	accept	blank	as	the	same	as	zero.finale3d-installer-2020.03.03-2348a4248	(RELEASE)	Fix	bug	causing	DLY	to	not	affect	simulation	sounds.	Made	it	possible	to	use	a	shared	Start	Module	among	multiple	positions	in	different	addressing	groups,
see	finale3d.com/documentation/start-module/	Fixed	bug	wherein	Pre-Assigned	Rails	in	different	universes	or	in	different	firing	systems	in	the	same	show	could	conflict.	Documented	all	the	new	hotkeys	--	see	Documentation	>	Software	documentation	>	Keyboard	shortcuts,	or	search	for	shortcuts	in	the	upper	right	of	the	home	page.	Auto-right-justify
right	hand	fields	on	labels	if	Auto-trim	angle	numbers	from	multi-angle	labels	since	the	numbers	don't	fit	anyway	and	just	look	ugly	when	clipped.	Tune	mines.	Single	click	on	cue	flag	will	move	playhead	to	cue;	different	from	clicking	on	event.	Fixed	bug	in	'Edit	VDL	dialog'	recently	introduced	when	the	effect	macro	dialog	was	added.	Re-tuned	comets
to	be	more	correctly	scaled	against	the	default	shell	heights.	Added	'Addressing	>	Clear	addresses	of	selected	events'	function.	Improved	timeline	event	bar	and	tooltip	text	to	indicate	a	bar	represents	a	group	or	chain	as	opposed	to	an	individual	effect.finale3d-installer-2020.03.24-9a260674c	(RELEASE)	Fix	bug	causing	network	sync	to	get	stuck	if
you	do	not	have	any	supplier	catalogs	enabled.	Added	two	new	pre-wired	pin	options	for	racks	that	are	pre-wired	for	two	modules,	half	and	half.	Make	clicking	and	right	clicking	rail	icons	in	rack	layout	view	when	not	in	'edit	pins'	mode	select	all	the	events	addressed	to	the	rail	and	scroll	the	script	window	to	bring	the	first	event	associated	with	the
rail	into	view.	Fixed	a	crash	that	could	occur	on	shutdown.	Support	multi-hit	pins	in	the	FireOne	exporter,	for	flames	and	special	effects.	Made	the	'Re-address'	function/link	in	the	rack	layout	view	respect	the	'Beginning	with	module	number'	field	of	the	dialog.	Made	the	'Fix	position	names	(invisible	effects)...'	function	select	any	events	in	the	script
that	remain	for	the	user	to	fix	manually.	Improved	the	text	vertical	alignment	in	the	selectors	at	top	of	table	windows.	Move	video/image	rendering	menu	items	under	their	own	File	submenu	(rather	than	being	grouped	with	Export).	Support	exporting	parts	in	ASCII	even	if	contains	non-ASCII	chars,	making	subtitution	for	them.	Made	'Combine	as
cake'	allow	any	rectangular	layout	footprint	of	tubes,	any	proportions,	if	has	at	least	5	tubes	per	row.	Fixed	parts	importer	for	'Bengal'	and	'Silver	Tip'.	Added	a	new	address	column	that	combines	the	rail	and	pin	data	into	a	single	column.	Changed	FireControl	addresser	to	use	3-digit	rail	addresses.	Incorporated	Spanish	effect	terms	from	Conlapi
conference	round	table	meeting	on	effect	terminology.	Made	'Update	per-show	effects'	NOT	update	the	numDevices	property	in	circumstances	that	the	per-show	effects	would	have	the	more	current	value;	making	the	option	to	display	the	'Used'	count	as	full	chains	work	more	reliably.2018.05.17-1b041087-finale3d-win32-installer	(RELEASE)	Fixed
pin	number	export	bug	in	PyroSoftware	exporter	and	changed	name	from	PyroSoft	to	PyroSoftware.	Added	'Show	>	Set	cue	flag	color	mapping'	to	enable	mapping	the	cue	flag	colors	to	track,	position,	section,	size,	etc.	Fixed	bug	wherein	Pre-Assigned	Rails	in	different	universes	or	in	different	firing	systems	in	the	same	show	could	conflict.	Fix	physics
precision	bug	causing	smoke	puffs	to	sometimes	jump	to	Origin	Man.	Now	blank	will	translate	to	1.	Import	1	shot	candles	as	having	type	=	single_shot.	Fixed	end-of-file	checksum	problem	that	affected	a	small	number	(0.4%)	of	exported	Pyrodigital	PDM	files.finale3d-installer-2021.11.05-3b8199f95	(BETA	VERSION)	Made	cake	combiner	function
automatically	replace	plus	signs	with	ampersands	in	the	effect	descriptions	being	combined	since	extraneous	plus	signs	mess	up	cake	syntax.	Fix	mine	break	pattern	so	that	it	spreads	in	both	X	and	Z	instead	of	just	X.	Fix	bug	that	caused	position	shadows	to	disappear.	Made	addressing	functions	show	dialog	to	help	users	with	missing	racks,	if	there
were	any	such	issues.	Allow	zero	prefire	for	shells	and	cake,	using	default	lift	time	as	a	special	case	instead	of	inferring	that	lift	time	is	prefire	time.	Made	it	possible	to	use	a	shared	Start	Module	among	multiple	positions	in	different	addressing	groups,	see	finale3d.com/documentation/start-module/finale3d-installer-2021.01.11-efa35cbb3
(RELEASE)CLICK	HERE	FOR	RELEASE	HIGHLIGHTS	VIDEO.	Added	algorithmic	support	for	single-shot	racks	whose	tubes	are	pre-wired	to	sequential	pin	addresses,	but	UI	to	to	make	use	of	this	feature	is	not	yet	implemented.	They	are	automatically	flushed	when	you	save	your	show	file.	Update	Polish	UI	translation.	Added	ability	to	add	custom
selectors	to	all	table	windows	from	the	menu	icons	on	column	headers.	Made	import	show	work	better	for	old	Finale	HBS	files,	not	it	imports	cake	simulations	from	the	HBS	file	instead	of	replacing	the	cake	with	a	placeholder	cake.	Fixed	'clicky'	sound	bug	for	when	cursor	hovers	over	position	nametags,	particularly	evident	on	some	computers	with
new	2D	lock	mode.	Added	user-defined	'while-playing	hotkeys'	for	effect	macros	that	are	active	while	the	show	simulation	is	playing.	Fix	a	bug	in	importing	blob	effects	with	invalid/missing	emit	curves	not	getting	assigned	the	default	emit	curve.finale3d-installer-2022.05.11-c777a7853	(BETA	VERSION)	Made	effect	macro	names	not	automatically
include	the	position	names	if	the	user	has	not	checked	the	'Apply	to	recorded	positions'	checkbox.	Fix	bug	with	syncing	from	Finale	3D	to	Finale	Inventory	for	the	first	time	specifying	incorrect	distance	unit	of	measure.	Implemented	'Break	flash	world	lighting'	render	setting.2019.01.03-7b112caa-finale3d-win32-installer	(RELEASE)	Added	position
group	buttons	on	left	side	of	3d	view.	Fixed	the	Parente	Firemaster	exporter	for	supporting	overlapping	sequences.	Improved	menu	names	for	custom	collection/layout	hot	keys	in	effects	menu.	Made	cake	importing	and	the	'create	cake	by	combining	selected	effects'	function	use	the	new	'exact	simulation	syntax	VDL'	for	the	cake	VDL	in	order	to	get
an	exact	simulation	whenever	the	standard	cake	VDL	syntax	is	not	able	to	express	the	desired	shot	angles	and	timing.	Fixed	Explo	X2	Wave	Flamer	sims	for	programss	#63-66,	which	were	incorrect.finale3d-installer-2021.04.04-28fdd26ff	(BETA	VERSION)	Add	a	pre-export	check	to	see	if	show	is	missing	safety	channel	effects	for	DMX	fixtures	that
need	than,	and	display	instructional	dialog	if	so.	Fixed	blueprint	menu	checkmark	after	saving	blueprint.	Make	icon	generation	use	the	same	logic	for	default	duration	that	insertion	in	the	show	does.	Support	Cobra	multi-hit	pins.	Added	'Waterfall	lance'	and	'Ground	Waterfall'	for	upside-down	mounted	fountain-like	devices,	to	distinguish	them	from	the
'Waterfall'	aerial	shell.	Fixed	minor	UI	bug	wherein	'Effects	>	Update	per-show	effects'	would	always	show	effects	with	DMX	Patches	to	needing	an	update	even	if	they	were	already	up	to	date.	Fixed	annoying	bug	in	the	gear	menu	'Select/edit/save	table	layout	from	report'	functions	that	reformatted	the	window	unnecessarily.	Made	position	group
buttons	and	camera	preset	buttons	stack	into	multiple	columns	if	there	are	many	of	them.	Changed	Fire	Control	G2	exporter	to	limit	duration	of	events	in	tracks	to	duration	of	track.	Fix	issue	causing	stars	to	'blink	off'	rather	than	having	an	intensity	curve.2018.11.20-04c2560c-finale3d-win32-installer	(RELEASE)	Added	RJ	Equipamentos	exporter.
Changed	the	range	of	fixture	IDs	reserved	for	user-defined	fixtures	to	100-199.	Fixed	bug	introduced	by	effect	macros	that	the	'i'	key	for	inserting	had	stopped	working	while	the	show	was	playing.	Added	'Clear	pins'	button	to	the	rack	layout	view	to	clear	the	pin	addresses	for	the	position	being	viewed.	Fix	bug	causing	multiple	map	labels	to	appear
after	downloading	google	maps.finale3d-installer-2019.12.06-1895435ab	(RELEASE)	Implement	user-specified	image	backdrops.	Import	parts	now	automatically	populates	the	color	and	subtype	fields	from	the	VDL	if	not	explicitly	in	the	input	data.	Changed	caliber	field	format	in	PyroSoft	exporter.	Update	Spanish	translation	file.	Made	inserting	chain
effects	with	hand-edited	VDL	a	litle	more	reliable,	handling	VDL	syntax	that	has	not	had	the	duration	stripped	out,	as	in	'10s	Chain	of	5	Salutes'.	Moved	assorted	DMX	fixture	effects	into	a	new	supplier	catalog	called	'Assorted	DMX',	moving	them	out	of	Generic	Effects.finale3d-installer-2021.05.18-b76e5da39	(BETA	VERSION)	Reduced/simplified
effects	in	Explo,	G-Flame,	EasyDancing,	Uking,	and	Tomshine	effect	libraries.	Added	DMX	support	for	Mongoose	and	updated	exported	script	format.	Added	hover	highlight	for	stretch	bracket	on	right	end	of	timeline	bars.	Fix	bug	where	expired	promo	licenses	were	showing	status=Active	on	the	licenses	page.	Make	scroll	wheel	action	zoom	into
center	of	screen	while	show	is	playing.	Added	incremental	search	to	script	and	effects	window.	Improved	clicking/dragging	hysteresis	for	effects	in	timeline,	making	it	possible	to	make	minor	adjustments	by	sliding	the	item	on	the	timeline	without	feeling	like	you	have	to	break	it	free	of	its	initial	position.	Fixed	file	load/save	bug	pertaining	to	shows
with	the	frame-based	time	formats	in	'Show	>	effect	time	format',	previously	save	didn't	work	with	that	setting	on.	Added	'Insert	empty	cue'	to	LITE	version.	Fix	window	sizing	for	network	sync	dialog	and	other	html	dialogs.	Added	new	function	'Racks	>	Re-load	selected	effects	from	script	into	racks...'	which	assigns	or	re-assigns	racks/tubes	to	the
selected	effects	in	the	script.finale3d-installer-2021.09.22-2d853f96e	(BETA	VERSION)	Fixed	bug	with	wildcard	custom	fields	in	addressing.	Added	blips	to	the	timeline	bars.	Removed	the	Images	menu	since	mostly	redundant.	Change	'playback'	and	'edit'	mode	dark/light	values	to	be	tunable	exposure	settings.	Fixed	rack	layout	view	bug	pertaining	to
filtering	to	position	names	that	contained	spaces.	Fixed	problem	that	remainingQuota	column	and	filters	didn't	work	in	the	per-show-effects	collection	in	the	effect	window.	Added	'Reset	ground	image'	menu	item.	Added	DMX	support	for	Showven	uFlamer	Vulcano	5-head	fixture.	Added	'Effects	>	Import	effects	list...'	with	options	to	import	into	My
Parts,	Per-show	parts,	and	parts	files.	Improve	comet	shells.	Removed	menu	box	buttons	on	table	headers.	Clicking	on	rack	tube	in	'Edit	pins'	mode	in	rack	layout	view	now	selects	and	scrolls	to	bring	into	view	only	the	event	for	that	tube,	not	all	events	associated	with	that	rail/pin,	which	can	be	more	than	one	for	chains	and	items	e-matched	together.
Improve	simulation	for	fountains	and	gerbs.
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